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Copyrights

© Cypress Semiconductor Corporation, 2014. The information contained herein is subject to change without notice. Cypress
Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress
product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted nor
intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an express
written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-
support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The
inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use
and in doing so indemnifies Cypress against all charges.

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-
ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-
fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-
RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-
tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all
charges.

Use may be limited by and subject to the applicable Cypress software license agreement.

PSoC and CapSense are registered trademarks and PSoC Components, PSoC Creator, and SmartSense are trademarks of
Cypress Semiconductor Corporation. All other products and company names mentioned in this document may be the trade-
marks of their respective holders.

Purchase of 12C components from Cypress or one of its sublicensed Associated Companies conveys a license under the Phil-
ips I2C Patent Rights to use these components in an I12C system, provided that the system conforms to the 12C Standard
Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP Semicon-
ductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family of
products is one of the most secure families of its kind on the market today, regardless of how they are used. There may be
methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge, would
be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the security of
their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Regulatory Compliance

The CY8CKIT-040 PSoC® 4000 Pioneer Kit is intended for use as a development platform for
hardware or software in a laboratory environment. The board is an open system design, which does
not include a shielded enclosure. For this reason, the board may cause interference to other
electrical or electronic devices in close proximity. In a domestic environment, this product may cause
radio interference. In such cases, the user may be required to take adequate preventive measures.
Also, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-040 as shipped from the factory has been verified to meet with requirements of CE as

a Class A product.

C€

A
Az

The CY8CKIT-040 contains electrostatic discharge (ESD) sensitive
devices. Electrostatic charges readily accumulate on the human body
and any equipment, and can discharge without detection. Permanent
damage may occur to devices subjected to high-energy discharges.
Proper ESD precautions are recommended to avoid performance
degradation or loss of functionality. Store unused CY8CKIT-040
boards in the protective shipping package.

End-of-Life/Product Recycling

The end of life for this kit is five years from the date of manufacture
mentioned on the back of the box. Contact your nearest recycler to
discard the kit.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 5
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal
surface) on the board when handling parts.

Handling Boards

CY8CKIT-040 boards are sensitive to ESD. Hold the board only by its edges. After removing the
board from its box, place it on a grounded, static free surface. Use a conductive foam pad if
available. Do not slide the board over any surface.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 6



1. Introduction

=¥ CYPRESS

PERFORM

Thank you for your interest in the PSoC® 4000 Pioneer Kit. The kit is designed as an easy-to-use
and inexpensive development kit, highlighting the unique flexibility of the PSoC 4000 architecture.
Designed for flexibility, this kit offers footprint compatibility with several third-party Arduino™ shields.
In addition, the board features an RGB LED, integrated USB programmer/debugger, a program/
debug header, USB-UART/I2C bridges, a proximity header, and an Arduino-compatible CapSense®

Trackpad shield. This kit supports either 5 V or 3.3 V as power supply voltages.

The PSoC 4000 Pioneer Kit is based on the PSoC 4000 device family, delivering a programmable
platform for a wide range of embedded applications. The PSoC 4000 is the smallest member of the
PSoC 4 platform with support for CapSense, Timer Counter Pulse Width Modulator (TCPWM), 12c
master or slave, and up to 20 GPIOs. PSoC 4000 is a cost-optimized, entry-level PSoC 4 device
targeted as socket replacements for obsolete and/or proprietary 8-bit and 16-bit MCUs. PSoC 4000
with its ARM Cortex-MO core provides 32 programmable peripherals including CapSense.

1.1 Kit Contents

The PSoC 4000 Pioneer Kit contains the following (see Figure 1-1):
PSoC 4000 Pioneer Kit board

Trackpad shield board with a color palette sticker

Quick start guide

USB Standard A to Mini-B cable

6 jumper wires

Note: Trackpad and Touchpad denote the same in the context of this document and can be used

interchangeably.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. **



=
CYPRESS Introduction

PERFORM

Figure 1-1. Kit Contents
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Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office
for help: www.cypress.com/go/support.
Download the latest version of the kit setup file from www.cypress.com/CY8CKIT-040.
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PSoC Creator

PSoC Creator™ is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces
revolutionary hardware and software codesign, powered by a library of preverified and
precharacterized PSoC Components™.

With PSoC Creator, you can:

m Drag and drop PSoC components to build a schematic of your custom design

m Automatically place and route components and configure GPIOs

m Develop and debug firmware using the included component APls

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains
and production programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator.

Getting Started

This guide helps acquaint you with the PSoC 4000 Pioneer Kit.
m The Software Installation chapter on page 13 describes the installation of the kit software.

m The Kit Operation chapter on page 16 explains how to program the PSoC 4 with a programmer
and debugger, either the onboard PSoC 5LP or the external MiniProg3 (CY8CKIT-002).

The Hardware chapter on page 27 details the hardware operation.

The Example Projects chapter on page 45 describes the example projects that are provided with
the kit.

m The Advanced Topics chapter on page 95 deals with topics such as building projects for

PSoC 5LP, using onboard F-RAM, USB-UART functionality, and USB-I2C functionality of
PSoC 5LP.

m The Appendix on page 136 provides schematics, pin assignments, information on the use of
zero-ohm resistors, troubleshooting details, and the bill of materials (BOM).

Additional Learning Resources

PSoC 4 Datasheets

PSoC 4 datasheets list the features and electrical specifications of all PSoC 4 device families.

Learning PSoC Creator
Visit the PSoC Creator home page to download the latest version of PSoC Creator.

Launch PSoC Creator and navigate to the following items:

m Quick Start Guide: Choose Help > Documentation > Quick Start Guide (see Figure 1-2). This
guide gives you the basics for developing PSoC Creator projects.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 9
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Figure 1-2. Quick Start Guide
I; Help | I
=43 Iopics
Document Manager
System Reference * Imain.c
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. CapSense Proximity Design
PSoC Creator Training S -
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I Documentation d Quick Start Guide |
—
Register L4 Release Notes
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m Simple Component Example Projects: Choose File > Example projects (see Figure 1-3).
These example projects demonstrate how to configure and use PSoC Creator Components.

Figure 1-3. Example Projects

Find Example Project [ReR =
Fiter Options -
) Documentation | Sample Code & 4P
() CapSense Proximity DesgnEPooC Creatoral hchtectus:  (BSaC4 D -
= - - . 5 Device Famiy: ; E
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B s1 | & )
Keyword: [ =
Open 12 | Features
s Project Name: o SatEIN s Seagrant Lnedr S0
Example Project... + CYSCHIT-042 ses Inear siges on soart
[Bootioadable_PSoC4_Example - o Sh i e A A TGREIED)
Add » | Bootloader_PSoC4 Eg ole
= Ca DP“ Jesg General Description
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Adki o Exiating Workapace: J[ Cimete New Wordsapace H Cancel l

m Starter Designs: Choose File > New > Project > PSoC 4 Starter Designs (see Figure 1-4).
These starter designs demonstrate the unique features of PSoC 4.

Each starter design contains a PDF document that explains the features of the project and its

configuration.

Note: The example projects and starter designs are designed for CY8CKIT-040 PSoC 4000 Pio-
neer Kit. However, these projects can be converted to use with other PSoC 4000 hardware setup
by following the “Schematic and Pin Mapping” section in the help document provided with the

example project.
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Figure 1-4. Starter Designs
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Name: Design01
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m System Reference Guide: Choose Help > System Reference > System Reference Guide
(see Figure 1-5). This guide lists and describes the system functions provided by PSoC Creator.

Figure 1-5. System Reference Guide

Help |
&3 Topics
Encument Manager
B System Reference k | System Reference Guide I
| Update Manager Open Web Page

E

m Component Datasheets: Right-click a Component and select Open Datasheet (see Figure 1-6).
Visit the following page for a list of all PSoC 4 Component datasheets:

o PSoC 4 Component Datasheets

Figure 1-6. Component Datasheet

& V2.
2] _1“ Open Datasheet...
|

- T e e PTO e

el

o] Open Component Web Page
il %A Dramartiac

14.3 Application Notes

Application notes assist you in understanding specific features of the device and designing your
PSoC application.

Visit the following page for a complete list of PSoC 4 application notes: PSoC 4 Application Notes

A few application notes that can help you get started with developing PSoC 4 applications are:
m AN79953 - Getting Started with PSoC® 4
m AN54460 - PSoC® 3, PSoC 4, and PSoC 5LP Interrupts
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Design Guide

Visit the following page to download the PSoC 4 CapSense Design Guide, which shows how to
design capacitive touch-sensing applications with the PSoC 4 family of devices.

m PSoC 4 CapSense Design Guide

Technical Reference Manuals (TRM)

The TRMs provide detailed descriptions of the internal architecture of the PSoC 4 device.
m PSoC 4 Technical Reference Manuals

Technical Support

If you have any questions, you can create a support request at the Cypress Technical Support page.

If you are in the United States, you can talk to our technical support team by calling our toll-free
number: +1-800-541-4736. Select option 2 at the prompt. If you are outside United States, you can
talk to our technical support team by calling: +1 (408) 943-2600 Ext. 2.

You can also use the following support resources if you need quick assistance.
m Self-help
m Local Sales Office Locations

Documentation Conventions

Table 1-1. Document Conventions for Guides

Convention Usage

Displays file locations, user-entered text, and source code:

C i N .
curier Hew C:\ ...cd\icc\

Displays file names and reference documentation:

ltalics Read about the sourcefile.hex file in the PSoC Creator User Guide.

Displays keyboard commands in procedures:

[Bracketed, Bold] [Enter] or [Ctrl] [C]

Represents menu paths:

File > Open File > Open > New Project

Displays commands, menu paths, and icon hames in procedures:

Bold Click the File icon and then click Open.

Displays an equation:

Times New Roman 240 —4

Text in gray boxes Describes cautions or a unique functionality of the product.

CYB8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 12
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This section describes the installation of the CY8CKIT-040 PSoC 4000 Pioneer Kit software and the
prerequisites.

21 Before You Begin

All Cypress software installations require administrator privileges. However, this is not the case for
installed software. Before you install the kit software, close any other Cypress software that is cur-
rently running.

2.2 Install Software

Follow these steps to install the CY8CKIT-040 PSoC 4000 Pioneer Kit software:
1. Download the CY8CKIT-040 software.
The CY8CKIT-040 software is available in three different formats for download (see Figure 2-1):

Figure 2-1. Kit Software Download Options

(a)
(b)
(c)

Related Files

File Title Language
] cysckim-040Kit Setup (Kit Design Files, Creator, Programmer, English
Documentation, Examplas)

[ cysckmoao kit Only (Kit Design Files, Documentation, Examples English
[£]

CY8CKIT-040CD ISO (Creator CD) English

CY8CKIT-040 Kit Setup: This installation package contains the files related to the kit. How-
ever, it does not include the Windows Installer or Microsoft .NET framework packages. If
these packages are not on your computer, the installer directs you to download and install
them from the Internet.

. CY8CKIT-040 Kit Only: This executable file installs only the kit contents, which include kit

code examples, hardware files, and user documents. This package can be used if all the soft-
ware prerequisites listed in step 5 are installed on your PC.

CY8CKIT-040 CD ISO: This file is a complete package, stored in a CD-ROM image format
that you can use to create a CD or extract using ISO extraction programs, such as WinZip or
WInRAR. The file can also be mounted like a virtual CD using virtual drive programs such as
Virtual CloneDrive and MagiclSO. This file includes all the required software, utilities, drivers,
hardware files, and user documents.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 13
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2. If you have downloaded the ISO file, mount it in a virtual drive. Extract the ISO contents if you do
not have a virtual drive to mount. Double-click cyautorun.exe in the root directory of the extracted
content or mounted ISO if 'Autorun from CD/DVD' is not enabledd in the PC. The installation win-
dow shown in Figure 2-2 will appear automatically. Note: If you are using the ‘Kit Setup’ or ‘Kit
Only’ file, then go to step 6 for installation.

3. Click Install CY8CKIT-040 to start the kit installation, as shown in Figure 2-2.
Figure 2-2. Kit Installer Startup Screen

= CYBCKIT-040 PSoC 4000 Pioneer Kit E]|§|E]

F—

= J CYPRESS
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CYB8CKIT-040 PSoC 4000 Pioneer Kit

Open the Kit User Guide

Install CYSCKIT-040

@ 2014 Cypress Semiconductor Corporation. Al rights reserved

4. Select the folder in which you want to install the CY8CKIT-040 kit-related files. Choose the direc-
tory and click Next.
5. When you click Next, the CY8CKIT-040 ISO installer automatically installs the required software,
if it is not present on your computer.
Following is the required software:
a. PSoC Creator 3.0 SP1 or later: Download the latest version from
Wwww.cypress.com/psoccreator.
b. PSoC Programmer 3.20.1 or later: Download the latest version from
WWW.Cypress.com/programmer.

6. Choose the Typical/Custom/Complete installation type in the Product Installation Overview win-
dow, as shown in Figure 2-3. Click Next after you select the installation type.
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Figure 2-3. Product Installation Overview Window

& Cylnstaller for CYBCKIT-040 PSoC 4000 Pioneer Kit [

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation
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Installs the most common features of
CYBCKIT-040 PSoC 4000 Pioneer Kit.
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7. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.

8. Enter your contact information or select the check box Continue Without Contact Information.
Click Finish to complete the CY8CKIT-040 kit installation.

9. After the installation is complete, the kit contents are available at the following location:
<Install Directory>\CY8CKIT-040 PSoC 4000 Pioneer Kit\<version>

Default location:

Windows 7 (64-bit):

C:\Program Files (x86)\Cypress\CY8CKIT-040 PSoC 4000 Pioneer Kit\<version>
Windows 7 (32-bit):

C:\Program Files\Cypress\CY8CKIT-040 PSoC 4000 Pioneer Kit\<version>

Note: For Windows 7/8/8.1 users, the installed files and the folder are read only. To change the
property, right-click the folder and choose Properties > Attributes; disable the Read-only check
box. Click Apply and OK to close the window.

2.3 Install Hardware

There is no additional hardware installation required for this kit.

24 Uninstall Software

You can uninstall the CY8CKIT-040 PSoC 4000 Pioneer Kit software using one of the following
methods:

m Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Man-
ager. Select the Uninstall button that corresponds to the kit software.

m Go to Start > Control Panel > Programs and Features (or Add/Remove Programs for Win-
dows XP). Select the Uninstall/Change button that corresponds to the kit software.
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Kit Overview

The PSoC 4000 Pioneer Kit can be used to develop applications using the PSoC 4000 family of
devices. The kit includes two boards — an Arduino-compatible baseboard and a CapSense-based
Trackpad shield board. Figure 3-1 is an image of the PSoC 4000 Pioneer Kit baseboard and shield
board with a markup of the onboard components.

Figure 3-1. CY8CKIT-040 Kit Details

Arduino Arduino
Compatible 1/O Compatible 1/O
Status LED (LED2) Header (J3) Header (J4)

nST ATUS LED 1

LED Power
Jumper (J14) System Power Supply
RGB LED Jumper (19)
(LED3) Proximity Header (J5)
PSoC 4 Power Supply
USB Connector Jumper (J13)
(J10) PSoC 5LP (68QFN)
Programmer and Debugger
Power LED
(LED1)
‘ = PSoC 4000 (24 QFN)
; R i S
), WA aTEHR33 SHO S \:‘\».‘E‘MRB ° 3k RAM- 5_5:
/o He:?ecr (SJI'SI; { cory RS2 = Cypress F-RAM 256 Kb
PSoC4

Reset Button

PSoC 4 External Arduino Ardl.fino
Program and Debug Compatible 1/0 Compatible 1/0
Header (J6) Header (J1) Header (J2)
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3.2 Kit USB Connection

The PSoC 4000 Pioneer Kit connects to the PC over a USB interface (see Figure 3-2). The kit
enumerates as a composite device and three separate devices appear under the Device Manager
in the Windows operating system. See Table 3-1, Figure 3-3, and Figure 3-4.

Figure 3-2. Kit USB Connection

us | o [Q
PsoC 4 PROG IR
R20

Table 3-1. PSoC 4000 Pioneer Kit in Device Manager After Enumeration

Port Description
USB Input Device USB-I2C bridge
KitProg Programmer and debugger
KitProg USB-UART USB-UART bridge appears as a COM# port

Figure 3-3. KitProg Driver Installation

) Driver Software Installation M

Installing device driver software

USB Composite Device « Ready to use

KitBridge ) Searching Windows Update...
KitProg Programmer ) Searching Windows Update...
KitProg USBUART {_) Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update
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Figure 3-4. KitProg Driver Installation Complete
) Driver Software Installation ﬂ

Your device is ready to use

USB Composite Device v Ready to use
USB Input Device v Ready to use
KitProg (3.4.1.20) « Ready to use
KitProg USB-UART (COM16) « Ready to use

3.3 Programming and Debugging PSoC 4000

The kit allows programming and debugging of the PSoC 4 device in two modes:
m Using the Onboard PSoC 5LP Programmer and Debugger
m Using the CY8CKIT-002 MiniProg3 Programmer and Debugger

3.3.1 Using the Onboard PSoC 5LP Programmer and Debugger

The default programming interface for the kit is a USB-based, onboard programming interface.
Before trying to program the device, PSoC Creator and PSoC Programmer must be installed. See
Install Software on page 13 for information on installing the kit software.

1. To program the device, plug the USB cable into the programming USB connector J10, as shown
in Figure 3-5. The kit will enumerate as a composite device. See Kit USB Connection on page 18
for details.

Figure 3-5. Connect USB Cable to J10

i©)
)
PROXIMITY
©©

PSoC5LP
Programmer
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2. The onboard PSoC 5LP uses serial wire debug (SWD) to program the PSoC 4 device. See
Figure 3-6.

Note: Figure 3-6 is provided only for reference, all connections are hardwired on the board itself.

Figure 3-6. SWD Programming of PSoC 4000 Using PSoC 5LP

VDD
1
P12[3] |-SWOCLK 3| papqy
— D+
Mini P15[6] SWDIO
. P12[2] | >

USB LD P PSoC 5LP [2] P3[0] PSoC 4000

P12[4)—2€t 3l yRES

~

3. The kit's onboard programmer will enumerate on the PC and in the software tools as KitProg.
Open an example project in PSoC Creator (such as Project: Blinking LED on page 50) and
initiate the build by choosing Build > Build Project or pressing [Shift] [F6]. See Figure 3-7.

Figure 3-7. Build Project in PSoC Creator

Debug Tools Window Help
||ﬁ| Build CYSCKIT_040_Blinking_LED  Shift+F6
| Llean CYSCKIT_U40_Ehnking_LEL
) |-E| Clean and Build CYSCKIT_040_Blinking_LED

s TrE

Bl
40 L
5 Generate Application L

E

2] Generate Project Datasheet

4. After the project is built without errors and warnings, choose Debug > Program or press
[Ctrl] [F5] to program the device. See Figure 3-8.

Figure 3-8. Program Device From PSoC Creator

Debug | Tools Window Help

Windows r
3 Program Ctrl+F5 |
ﬁ Select Debug Target...

Debu I |
| 5& 9

; ;‘?’& Debug without Programming Alt+F5

! _-]L Attach to Running Target...

1)@ Toggle Breakpoint F9

Mew Breakpoint »
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The onboard programmer supports only the RESET programming mode. When using the onboard
programmer, the board can either be powered by the USB (VBUS) or by an external source such as
an Arduino shield (see Power Supply System on page 34). If the board is already powered from
another source, plugging in the USB programmer does not damage the board.

3.3.2 Using the CY8CKIT-002 MiniProg3 Programmer and Debugger

The PSoC 4 on the kit can also be programmed using a MiniProg3 (CY8CKIT-002). To use
MiniProg3 for programming, use the J6 connector on the board, as shown in Figure 3-9. With
MiniProg3, programming is similar to the onboard programmer; however, it enumerates as
MiniProg3 instead of KitProg.

The board can also be powered from the MiniProg3. To do so, choose Tool > Options in PSoC
Creator. In the Options window, expand Program/Debug > Port Configuration; click MiniProg3
and select the settings shown in Figure 3-10. Choose Debug > Program to program and power the
board.

Note The CY8CKIT-002 MiniProg3 is not part of the PSoC 4000 Pioneer Kit contents. It can be
purchased from the Cypress Online Store.

Figure 3-9. PSoC 4 Programming/Debug Using MiniProg3

TAT D .1
e e,

/ mszg LEEE,
y ' GN Ow;(—s_;tlj

O.id!ul : ‘ T

s
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Figure 3-10. MiniProg3 Configuration in PSoC Creator

Options M

@ Project Management Aclive Prolocol:
() Text Editor
[#- Design Entry . [16MHz
) Language Support Clock Speed. i i h
&) Program/Debug Power Acquire Mode
General 50V @ Reset
Fonts and Colors
Device Recognition @33V Power Cycle
=] ni Confiquration
25V
(ErEE
2L D 18V 5 pin
TrueTouchBridge -
DVKProg1 A= @ 10 pin
KitProg
(- Environment

| Rostreotouts | o ][ mw J[ coma |

Note: Ensure that both MiniProg3 (with or without power) on header J6 and KitProg are not
connected to the onboard PSoC 4 at the same time. This will result in failed device acquisition from
both.
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3.4 USB-IC Bridge

The PSoC 5LP also functions as a USB-I2C bridge. The PSoC 4 communicates with the PSoC 5LP
using an 1°C interface and the PSoC 5LP transfers the data over the USB to the USB-I?C software
utility on the PC, called the Bridge Control Panel (BCP).

The BCP is available as part of the PSoC Programmer installation. This software can be used to
send and receive USB-I°C data from the PSoC 5LP. When the USB Mini-B cable is connected to
header J10 on the PSoC 4000 Pioneer Kit, the KitProg USB-I?C is available under Connected 12C/
SPI/RX8 Ports in the BCP, as shown in Figure 3-11.

Figure 3-11. Bridge Control Panel

¥ Bridge Control Panel lﬂ%
File Editor Chart Execute Tools Help
sRE SR SEEEE

Edtor [Chant | Table | Fie |

Select Port in the PortList, then try to connect

Select Connect/
KitProg Disconnect Button
= @ @ Y| [coM43
e Syntax:OK | NCECSRREE - Voltage: -
[ E [  Not Connected

To use the USB-I2C functionality, select the KitProg USB-I?C in the BCP (Figure 3-11). On
successful connection, the Connected and Powered status boxes turn green (Figure 3-12).
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Figure 3-12. KitProg USB-IC Connected in Bridge Control Panel

¥ Bridge Control Panel E@Iﬁ
File Editor Chart Execute Tools Help
FEE IR E EEE

Edtor |Chart [ Table [ Fie |

Select Port in the PortList, then try to connect
Opening Port

Successfully Connected to KitProg/191607A0032C2400
KitProg Version 2.07

Connected 12C/SPI/RX8 Ports:

) e 0 [ — ] T, I
= = Repeat count: 01 |comas
[=] [M] Scan period, ms: 0l L

USB-I2C is implemented using the USB and I1°C components of PSoC 5LP. The SCL (P12_0) and
SDA (P12_1) lines from the PSoC 5LP are connected to the SCL (P1_2) and SDA (P1_3) lines of
the PSoC 4 I2C. The USB-I2C bridge currently supports I12C speed of 50 kHz, 100 kHz, 400 kHz, and
1 MHz.

See Using PSoC 5LP as a USB-12C Bridge on page 95 for building a project that uses the USB-I12C
bridge functionality.

USB-UART Bridge

The onboard PSoC 5LP can also act as a USB-UART bridge to transfer and receive data from the
PSoC 4 device to the PC via the COM terminal software. When the USB Mini-B cable is connected
to J10 of the PSoC 4000 Pioneer Kit, a device named KitProg USB-UART is available under Ports
(COM & LPT) in the Device Manager. For more information about the USB-UART functionality, see
Using PSoC 5LP as a USB-UART Bridge on page 108.

To use the USB-UART functionality in the COM terminal software, select the corresponding COM
port as the communication port for transferring data to and from the COM terminal software.

The UART lines from PSoC 5LP are brought to the P12[6] (J8_9) and P12[7] (J8_10) pins of header
J8. This interface can be used to send or receive data from any design/device that has a UART by
connecting the pins on header J8 to the RX and TX pins available on the connecting device.
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Note: The PSoC 4000 family that is featured in the kit board does not support a full-duplex UART; it
can support only a software-based UART transmit on any pin. On the board, P3[0] of the PSoC 4000
device is hardwired to the UART bridge's RX line through zero-ohm resistor R57.

Table 3-2 lists the specifications supported by the USB-UART bridge.

Table 3-2. Specifications Supported by USB-UART Bridge

Parameter Supported Values
Baud rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200
Data bits 8
Parity None
Stop bits 1
Flow control None
File transfer protocols Xmodem, 1K Xmodem, Ymodem, Kermit, and Zmodem (only speeds greater
supported than 2400 baud).

Updating the Onboard Programmer Firmware

The firmware of the onboard programmer and debugger (KitProg), PSoC 5LP, can be updated from
PSoC Programmer. When a new firmware is available or when the KitProg firmware is corrupt (see
Error in Firmware/Status Indication in Status LED on page 145), PSoC Programmer displays a
warning indicating that new firmware is available.

Open PSoC Programmer from Start > All Programs > Cypress > PSoC Programmer<version>.
When PSoC Programmer opens, a WARNING! window pops up saying that the programmer is
currently out of date, as shown in Figure 3-13.

Figure 3-13. Firmware Update Warning

P WARNING! e

This programmer is currently out of date.

To update the firmware please navigate to the
Utilities Tab and press the Update Firmware
button

|| Do notshow this message again

Click OK to close the window. On closing the warning window, the Actions and Results window
displays Please navigate to the Utilities tab and click the Upgrade Firmware button, as shown
in Figure 3-14.
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Figure 3-14. Upgrade Firmware Message in PSoC Programmer

Kit Operation

r
B PSoC Programmer
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Connected at 4:20:19 PM KitProg/040DODA0032C2400

Select Port in the Portlist, then try to connect

KitProg version Expecting 2.07, but found 1.00.

Disconnected at 4:19:16
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m

For Help, press F1 ! [ eereeee

Click the Utilities tab and click the Upgrade Firmware button. On successful upgrade, the Actions
and Results window displays the firmware update message with the KitProg version, as shown in

Figure 3-15.
Figure 3-15. Firmware Updated in PSoC Programmer

§ PSoC Programmer

e

File View Options Help

-y BRDLDB

[ Port Selection 4p | Programmer | Utilities | y1AG |

@ KitProg/1F 1303470222240(
Upgrade Fimware Click to upgrade connected device's fimware

Click to erase user specfic flash block

Device Family
CY8C4lox v

Device
CY8C4014LQI-422 v

Actions Results

I KitProg Version 2.07
Firmware Update Finished
at 4:49:14 PM

KitProg firmware Version

Succeeded
Verifying...

Upgrading. .. KitProg Firmware Update message

Initializing...
Firmware Upgrade Started
at 4:48:57 PM

m

For Help, press F1
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Board Details

The PSoC 4000 Pioneer Kit consists of the following blocks:
m CY8CKIT-040 baseboard (see Figure 4-1) -

a

a o o o o o o o Qg

a

PSoC 4 (4000 family)

PSoC 5LP

Power supply system

Coin cell battery holder (BT1)
Programming interfaces (J6, J7, and J10)
Arduino compatible headers (J1, J2, J3, J4, and J12)
PSoC 5LP GPIO header (J8)

Proximity header (J5)

Pioneer board LEDs

Push button (Reset button)

Cypress ferroelectric RAM (F-RAM)

m CYB8CKIT-040 CapSense Trackpad shield board (see Figure 4-2)
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Figure 4-1. CY8CKIT-040 - Baseboard Details
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Figure 4-2. CY8CKIT-040 CapSense Trackpad Shield Board Details
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Figure 4-3. PSoC 4000 Pioneer Kit Pin Mapping
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Block Diagram

This section provides the block-level description of the PSoC 4000 Pioneer Kit, as illustrated in
Figure 4-4.

Figure 4-4. Block Diagram
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PSoC 4 is a new generation of programmable system-on-chip devices from Cypress for embedded
applications. The PSoC 4000 family is the smallest member of the PSoC 4 platform with CapSense,
TCPWM, I2C master or slave, and up to 20 GPIOs support. PSoC 4000 is a cost-optimized, entry-
level PSoC4 device targeted as socket replacements for obsolete and/or proprietary 8-bit and 16-bit
MCUs. PSoC 4000 with its ARM Cortex-M0 core brings 32 CapSense and programmable
peripherals.

The kit features an onboard PSoC 5LP, which communicates through the USB to program and
debug the PSoC 4 using SWD. The PSoC 5LP also functions as a USB-I°C bridge and USB-UART
bridge. It can also be used to develop PSoC 5LP based applications (see Developing Applications
for PSoC 5LP on page 119).

The kit includes an RGB LED, a status LED, and a power LED. The RGB LED is connected to the
PSoC 4, and the status LED is connected to the PSoC 5LP. This kit also includes a Reset button that
connects to the PSoC 4 XRES, a CapSense proximity header, and a 6x5 elements Trackpad board
that is Arduino shield-compatible and can be used to develop touch-based applications. The PSoC 4
pins are brought out onto headers J1 to J4 on the kit to support Arduino shields. The PSoC 5LP pins
are brought out onto header J8 to enable using the onboard PSoC 5LP to develop custom
applications.

The PSoC 4000 Pioneer Kit can be powered from the USB Mini-B, the Arduino compatible header,
an external power supply, or an optional coin cell battery. The input voltage is regulated by a low
drop out (LDO) regulator to 3.3 V. You can select between VBUS (5V) and 3.3V by suitably
plugging the jumper onto the voltage selection header J9. VDD can also be supplied by a coin cell
battery placed in the BT1 coin cell holder. The voltage supplied by the coin cell is directly connected
to the VDD line through a diode, D11. Take care to ensure that VDD does not exceed the device's
VDD specification (1.8 V to 5.5 V).
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4.3 Kit Component Details

4.3.1 CY8CKIT-040 Baseboard Components

4.3.1.1 PSoC 4

This kit uses the PSoC 4000 family device. PSoC 4 is the architecture of programmable embedded
system controllers with an ARM Cortex-MO CPU. PSoC 4 delivers a programmable platform for
embedded applications. The CY8C40 family is the smallest member of the PSoC 4 family of devices
and is upward compatible with larger members of PSoC 4.

For more information, refer to the PSoC 4 web page and the PSoC 4000 family datasheet.

Features

32-bit MCU Subsystem

o 16-MHz ARM Cortex-M0 CPU

o Up to 16 KB of flash with Read Accelerator

o Up to 2 KB of SRAM

Programmable Analog

o Two current DACs (IDACs) for general-purpose or capacitive sensing applications
o One low-power comparator with internal reference

Low Power 1.71-V to 5.5-V Operation

o Deep Sleep mode with wake-up on interrupt and 12C address detect

Capacitive Sensing

o Cypress Capacitive Sigma-Delta (CSD) provides best-in-class signal-to-noise ratio (SNR) and
water tolerance

o Cypress-supplied software component makes capacitive sensing design easy
o Automatic hardware tuning (SmartSense™)
Serial Communication

o Multimaster 12C block with the ability to do address matching during Deep Sleep and generate
a wake-up on match

Timing and Pulse-Width Modulation

a  One 16-bit Timer/Counter/Pulse-Width Modulator (TCPWM) block

o Center-aligned, Edge, and Pseudo-Random modes

o Comparator-based triggering of Kill signals for motor drive and other high-reliability digital
logic applications

Up to 20 Programmable GPIO Pins

o 24-pin QFN, 16-pin SOIC, 16-pin QFN, and 8-pin SOIC packages

a GPIO pins on Ports 0, 1, and 2 can be CapSense or have other functions

o Drive modes, strengths, and slew rates are programmable

PSoC Creator Design Environment

o Integrated Development Environment (IDE) provides schematic design entry and build (with
analog and digital automatic routing)

o Applications Programming Interface (API) component for all fixed-function and programmable
peripherals

Industry-Standard Tool Compatibility
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o After schematic entry, development can be done with ARM-based industry-standard develop-
ment tools

4.3.1.2  PSoC 5LP

An onboard PSoC 5LP (CY8C5868LTI-LP039) is used to program and debug PSoC 4. The PSoC
5LP connects to the USB port of the PC through a USB Mini-B connector and to the SWD interface
of the PSoC 4 device.

PSoC 5LP is a true system-level solution providing MCU, memory, analog, and digital peripheral
functions in a single chip. The CY8C58LPxx family offers a modern method of signal acquisition,
signal processing, and control with high accuracy, high bandwidth, and high flexibility. Analog
capability spans the range from thermocouples (near DC voltages) to ultrasonic signals. For more
information, refer to the PSoC 5LP web page.
Features
m 32-bit ARM Cortex-M3 CPU core

o DC to 67-MHz operation

o Flash program memory up to 256 KB, 100,000 write cycles, 20-year retention, and multiple
security features

Up to 32-KB flash error correcting code (ECC) or configuration storage
Up to 64-KB SRAM

2-KB electrically erasable programmable read-only memory (EEPROM) memory, 1M cycles,
and 20 years' retention

o 24-channel direct memory access (DMA) with multilayer AHB bus access
Programmable chained descriptors and priorities
High-bandwidth 32-bit transfer support

m Low voltage, ultralow power
Wide operating voltage range: 0.5V t0 5.5V
High-efficiency boost regulator from 0.5-V input to 1.8-V to 5.0-V output
3.1mAat6 MHz (2.7 Vto 5.5V)
Low-power modes including:
2-pA sleep mode with real-time clock (RTC) and low-voltage detect (LVD) interrupt
300-nA hibernate mode with RAM retention
m Versatile /O system
28 to 72 1/0Os (62 GPIOs, 8 SIOs, 2 USBIOs)
Any GPIO to any digital or analog peripheral routability
LCD direct drive from any GPIO, up to 46x16 segments
CapSense support on any GPIO
1.2-V to 5.5-V I/O interface voltages, up to four domains
Maskable, independent IRQ on any pin or port
Schmitt-trigger transistor-transistor logic (TTL) inputs
All GPIOs configurable as open drain high/low, pull-up/pull-down, High-Z, or strong output
Configurable GPIO pin state at power-on reset (POR)

g 25-mA sink on SIO
m Digital peripherals

o 20 to 24 programmabile logic device (PLD)-based universal digital blocks (UDBs)

[ |

g o o o o a o a oo
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Hardware

Full CAN 2.0b 16 RX, 8 TX buffers
Full-Speed (FS) USB 2.0 12 Mbps using internal oscillator
Four 16-bit configurable timers, counters, and PWM blocks

67-MHz, 24-bit fixed point digital filter block (DFB) to implement finite impulse response (FIR)
and infinite impulse response (lIR) filters

Library of standard peripherals
8-, 16-, 24-, and 32-bit timers, counters, and PWMs

Serial peripheral interface (SPI), universal asynchronous transmitter receiver (UART), and 1°C
Many others available in Component catalog available in PSoC Creator IDE

Library of advanced peripherals

Cyclic redundancy check (CRC)

Pseudo random sequence (PRS) generator

Local interconnect network (LIN) bus 2.0

Quadrature decoder

m Analog peripherals (1.71 V <VDDA <5.5V)

a
a

o o o o o

a

1.024 V £0.1 percent internal voltage reference across —40 °C to +85 °C

Configurable delta-sigma ADC with 8- to 20-bit resolution

Sample rates up to 192 ksps

Programmable gain stage: x0.25 to x16

12-bit mode, 192 ksps, 66-dB signal-to-noise and distortion ratio (SINAD), +1-bit INL/DNL
16-bit mode, 48 ksps, 84-dB SINAD, +2-bit INL, £1-bit DNL

Up to two SAR ADCs, each 12-bit at 1 Msps

Four 8-bit 8 Msps current IDACs or 1 Msps voltage VDACs

Four comparators with 95 ns response time

Four uncommitted opamps with 25 mA drive capability

Four configurable multifunction analog blocks; example configurations are programmable
gain amplifier (PGA), transimpedance amplifier (TIA), mixer, and sample and hold

CapSense support

m Programming, debug, and trace

o o o o o a

a

JTAG (4-wire), SWD (2-wire), single-wire viewer (SWV), and TRACEPORT interfaces
Cortex-M3 flash patch and breakpoint (FPB) block

Cortex-M3 Embedded Trace Macrocell™ (ETM™!) that generates an instruction trace stream
Cortex-M3 data watchpoint and trace (DWT) that generates data trace information
Cortex-M3 Instrumentation Trace Macrocell (ITM) that can be used for printf-style debugging

DWT, ETM, and ITM blocks that communicate with off-chip debug and trace systems via the
SWV or TRACEPORT

Bootloader programming supportable through 12C, SPI, UART, USB, and other interfaces

m Precision, programmable clocking

[ T N |

3- to 62-MHz internal oscillator over full temperature and voltage range
4- to 25-MHz crystal oscillator for crystal PPM accuracy

Internal PLL clock generation up to 67 MHz

32.768-kHz watch crystal oscillator

Low-power internal oscillator at 1, 33, and 100 kHz
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For more information, see the CY8C58LPxxx family datasheet.

Power Supply System

The power supply system on this board is versatile, allowing the input supply to come from the
following sources:

5-V power from onboard USB programming header J10

5-V to 12-V power from Arduino shield using J1_01 (VIN on J1) header

VTARG - power from the onboard SWD programming using J6 or J7

VIN - J11 (not populated by default)

m Coin cell battery - BT1 (not populated by default)

The PSoC 4 and PSoC 5LP are powered with either a 3.3 V or 5 V source. The selection between
3.3V and 5V is made through the J9 jumper. The board can supply 3.3 V and 5V to the I/0O headers
and receive 3.3 V from the I/O headers (J9 should select 3.3 V for this). The board can also be
powered with an external power supply through the VIN (J11) header; the allowed voltage range for
the VIN is 5V to 12 V. The LDO regulator regulates the VIN down to 3.3 V. Figure 4-5 shows the
power supply block diagram and circuitry. In addition, there is a coin cell battery holder (BT1), which
can power the VDD line directly. The allowed voltage range supported through the coin cell battery is
between 1.8 V and 5.5 V (VDD specification of PSoC 4000 family). The BT1 holder is not populated
on the board by default. BU2032SM-BT-GTR (from Keystone Electronics) can be used for BT1. This
part supports CR2032 type coin cell batteries. Refer to the Bill of Materials on page 146 for details on
other parts that can be used for BT1.

Note: The 5-V domain is directly powered by the USB (VBUS). For this reason, this domain is
unregulated.

Figure 4-5. Power Supply Block Diagram and Schematic with Protection Circuits

I/O Header
5V Vin 3.3V¢
MOSFET based Coincell
Protection Ckt Battery Holder
5V
3 — e —»
-
PTC
PSoC5LP

ESD P4A 10pin P5LP IO
Protection Debug Header
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Input Voltage Range VIN is 5-12V
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Protection Circuit
The power supply rail has reverse-voltage, overvoltage, short circuits, and excess current protection
features, as seen in Figure 4-5.

m The Schottky diode (D1) ensures power cannot be supplied to the 5-V domain of the board from
the I/O header.

m The series protection diode (D2) ensures VIN (power supply from the 1/O header) does not back
power the USB.

The Schottky diode (D3) ensures 3.3 V from I/O header does not back power the LDO.

The series protection diode (D4) ensures that the reverse voltage cannot be supplied from the
VIN to the regulator input.

m A PTC resettable fuse is connected to protect the computer's USB ports from shorts and over
current.

m The MOSFET-based protection circuit provides overvoltage and reverse-voltage protection to the
3.3-V rail. The PMOS Q1 protects the board components from a reverse-voltage condition. The
PMOS Q2 protects the PSoC from an overvoltage condition. The PMOS Q2 will turn off when a
voltage greater than 4.2 V is applied, protecting the PSoC 4.

m The output voltage of the LDO is adjusted such that it takes into account the voltage drop across
the Schottky diode and provides 3.3 V.

m Populating R46 with a zero-ohm resistor will bypass the VIN protection circuitry.

Procedure to Measure PSoC 4 Current Consumption

The following three methods are supported for measuring current consumption of the PSoC 4
device.

m  When the board is powered through the USB port (J10), remove jumper J13 and connect an
ammeter, as shown in Figure 4-6.
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Figure 4-6. PSoC 4 Current Measurement When Powered From USB Port

m When using a separate power supply for the PSoC 4 with USB powering (regulator output on the
USB supply must be within 0.5 V of the separate power supply), remove jumper J13. Connect the
positive terminal of voltage supply to the positive terminal of the ammeter and the negative termi-
nal of the ammeter to the lower pin (P4.VDD) of J13. Figure 4-7 shows the required connections.

Figure 4-7. PSoC 4 Current Measurement When Powered Separately
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Note: The RGB tricolor LED is powerd from PSoC 4 VDD only. Remove jumper J14 to measure
power consumed by PSoC 4 alone.

4.3.1.4 Programming Interface

The kit allows programming and debugging of the PSoC 4 in two modes:
m Using the Onboard PSoC 5LP Programmer and Debugger on page 19
m Using the CY8CKIT-002 MiniProg3 Programmer and Debugger on page 21

4.3.1.5 Arduino Compatible Headers (J1, J2, J3, J4, and J12)

This kit has five Arduino compatible headers: J1, J2, J3, J4, and J12. You can develop applications
based on the Arduino shield's hardware. An Arduino shield compatible Trackpad board is also
supplied with the Kkit.
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Figure 4-8. Arduino Header

Note: The graphic LCD shield in Figure 4-8 is shown for reference only and not part of the kit.
m The J1 header contains I/O pins for reset and power supply line.

m The J2 header is an analog port. Because of limited analog support in PSoC 4000 family, it con-
tains general-purpose digital I/O pins only.

m The J3 header is primarily a digital port. It contains I/0 pins for PWM, 12C and general-purpose
digital.
The J4 header is also a digital port.

The J12 header is an Arduino ICSP compatible header for the SPI interface. This header is not
populated. Refer to the "No Load Components" section of Bill of Materialsfor the header part
number.

Note: The PSoC 4000 family does not support SPI in hardware, but SPI master can be implemented
on any pin using firmware bit banging.
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Figure 4-9. Arduino Compatible Headers
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(J1-J4) Arduino Compatible Headers

Functionality of Unpopulated Header J12

Hardware

Arduino
Compatible ICSP
1/0 Header (J12)

- Unpopulated

The J12 header is a 2x3 header that supports Arduino shields. This header is used on a small
subset of shields and is unpopulated on the PSoC 4000 Pioneer Kit.

Note: The J12 header functions only in 5 V mode. For proper shield functionality, ensure the power

jumper (J9) is connected in 5 V mode.
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4.3.1.6  PSoC 5LP GPIO Header (J8)

A limited set of PSoC 5LP pins are brought to this header. Refer to Developing Applications for
PSoC 5LP on page 119 for details on how to develop custom applications. See Pin Assignment
Table on page 141 for pin details.

Figure 4-10. PSoC 5LP GPIO Header (J8)
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PSoC ELP GPIO Extension Header

4.3.1.7 CapSense Circuit

The baseboard contains a header (J5) for CapSense proximity wire connection (see Figure 4-12). A
2.2-nF capacitor (C1) is present on CMOD pin, P0O[4], for CapSense operation. An optional resistor
R1 can be loaded to convert the current output from IDAC to a voltage output in non-CapSense
applications.

The board optionally supports CapSense designs that require waterproofing. Any pin that supports
CapSense in the device can be configured as a shield signal to enable waterproof operation.
However, if a shield tank capacitor is required in the design, Capacitor C5 (CTANK) on the board
needs to be populated with the desired tank capacitor value and R30 connecting the Blue LED to
PO 2 needs to be removed. Refer to the CapSense Design Guide for further details related to
CapSense.

Note: The kit does not demonstrate the waterproof feature using the Trackpad shield board that
ships with the kit because of limited I/O availability after Trackpad and RGB LED implementation.
However, a custom shield board can be designed to use the feature.

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 39


http://www.cypress.com/?rid=78578

-2
T PHESH

PERFORM

Figure 4-11. Baseboard CapSense Circuitry
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Figure 4-12. Proximity Header (J5)

4.3.1.8 Board LEDs

J5
P2 0

1x1 RECP
Proximity Header

Proximity Header (J5)

Hardware

The PSoC 4000 Pioneer Kit board has three LEDs. A green LED (LED2) indicates the status of the
programmer. See Error in Firmware/Status Indication in Status LED on page 145 for a detailed list of
LED indications. An amber LED (LED1) indicates the status of power supplied to the board. The kit
also has a general-purpose tricolor (RGB) LED (LED3) for user applications that connect to specific
PSoC 4 pins. Jumper J14 is provided to enable/disable power to the RGB LED (LED3). The RGB
LED is powered from PSoC 4 VDD, so jumper J14 needs to be removed to measure PSoC 4 power

accurately without leakage and LED power.

Figure 4-13 shows the indication of all these LEDs on the board. Figure 4-14 and Figure 4-15 detail

the LED schematic.

CYB8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. **

40



Hardware

Figure 4-13. Board LEDs
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4.3.1.9 Push Buttons

Hardware

The kit contains only a Reset push button, as shown in Figure 4-16. The Reset button is connected
to the XRES pin of PSoC 4 and is used to reset the onboard PSoC 4 device. The push button

connects to ground on activation (active low).
Figure 4-16. Reset Push Button

hz ©

@) va0&(
PSoC 4 Reset Button . @

SWi1

XRES 1 :/ 2
EVQ-PE105K
RESET

4.3.1.10 Cypress Ferroelectric RAM (F-RAM)

iy
PSoC 4 PROGHN’ I
R2
\

The baseboard contains an F-RAM device (FM24W256); see Figure 4-17, which can be accessed
through I12C lines by either of the PSoC devices — PSoC 5 LP or PSoC 4 — or by both. The F-RAM is
256 Kb (32 KB) in size with the 12C speed up to 1 Mbps. The I2C slave address of the F-RAM device
is 7-bit wide, and the LSB three bits are configurable through physical pins and are hardwired to 000
on the board. By default, the address of the F-RAM device used on the board is 0x50. This can be
modified by changing the R19/R18, R17/R16, and R15/R14 pairs. Refer to Use of Zero-ohm
Resistors and No Load on page 144 for details on how to change the F-RAM address using these
resistors. The Using FM24W256 F-RAM on page 103 provides an example implementation showing
how to use this F-RAM device with PSoC 4 and share it between Bridge Control Panel over the

PSoC 5LP USB-I2C bridge.
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Figure 4-17. Cypress F-RAM
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4.3.2

CY8CKIT-040 CapSense Trackpad Shield Board

Hardware

The kit also includes an Arduino-compatible CapSense Trackpad shield board. The Trackpad in the
kit is a 6x5 elements capacitive sensing array. Figure 4-18 shows the pin mapping of the Trackpad.

The modulation capacitor (Cmod) used for CapSense is connected to pin P0[4], and an optional
bleeder resistor (R1) can be connected across the Cmod. The Trackpad shield is Arduino-
compatible and can also be used with the PSoC 4 Pioneer Kit (CY8CKIT-042). The sticker on the
Trackpad shield can be redesigned according to user requirement and can be pasted on top of the
Trackpad to implement any custom, application-specific Ul. The Trackpad/Touchpad Sticker Details
on page 149 provides the sticker template.

Refer to the CapSense Design Guide for further details related to CapSense.
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Figure 4-18. CapSense Trackpad Shield Board
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51 Overview

The example projects described in this chapter introduce the functionality of the PSoC 4000 device
and the onboard components. To access the examples, download and install the CD ISO image or
setup files from the kit web page as explained in Install Software on page 13. The example projects
are available at <Install Directory>\CY8CKIT-040 PSoC 4000 Pioneer Kit\<ver-
sion>\Firmware\ after installation.

51.1 Programming the Example Projects

This section is provided as a reference for programming any example project into PSoC 4 on the
board. The description of example projects shipped with the kit is from Project: Blinking LED on
page 50. Follow these steps to open and program an example project:

1. Launch PSoC Creator from the Windows Start menu (Start > All Programs > Cypress > PSoC
Creator<version> > PSoC Creator<version>).

2. Open the example project by clicking <Project_name>.cywrk below Examples and Kits > Kits
> CY8CKIT-040, as shown in Figure 5-1. CY8CKIT_040_Blinking_LED.cywrk is used as refer-
ence here.

Figure 5-1. Open Code Example from PSoC Creator
"
PSoC® Creator™

Getting Started
PSoC Creator Start Page
Quick Start Guide
Intro to PSoC
Intro to PSoC Creator
PSoC Creator Training
Design Tutorials
Getting Started With PSoC 3
Getting Started With PSoC 4
Gelting Started With PSoC 5LP

Find Example Project. |

= Kas 7"
o CYSUKIT-040
TeLKIT 040 Binkang LED cywrk
03] CY8CKIT_040_CapSense_12C cywrk
6] CYBCKIT_040_Color_Palatte cywrk
i) CYSCKIT_040_Procdmity_UART .cywr

| s2anog

] spayseIeq I SJuBLOd WDy

[sypsay

Product Information
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3. Build the code example by choosing Build > Build CY8CKIT_040_Blinking_LED.cywrk to gen-
erate the hex file, as shown in Figure 5-2.

Figure 5-2. Build Project from PSoC Creator

| Build | Debug Tools Window Help

—
N
] ]

=3

j' Generate Application

Build CYSCKIT_040_Blinking_LED Shift+F6
Clean CYBCKIT_040_Blinking_LED
Clean and Build CYSCKIT_040_Blinking_LED

¥]
g

ol |

Generate Project Datasheet

][I PR B e

4. To program, connect the board to a computer using the USB cable connected to port J10, as
described in Kit USB Connection on page 18. The board is detected as KitProg.

5. Choose Debug > Program from PSoC Creator, as shown in Figure 5-3.

Figure 5-3. Program Device from PSoC Creator

| Debug | Tools Window Help

L Windows
la Program Ctrl+F5
| 3% Select Debug Target...
& Debug F5
LI ﬂ Debug without Programming Alt+F5
. _—j& Attach to Running Target... :
ol Toggle Breakpoint Fa
Mew Breakpoint >
2 e

—

6. If the device is not yet acquired, PSoC Creator will open the Select Debug Target window.
Select KitProg/<ID> and click the Port Acquire button, as shown in Figure 5-4.
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Figure 5-4. Acquire Device from PSoC Creator

r A\
Select Debug Target M
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VOLTAGE_ADC = 5034
FREQUENCY = 2000000
PROTOCOL = SWD
KitProg Version 2.07
Show all targels v) | PotSeting || PotAcqure

7. After the device is acquired, itis listed in a tree structure below the KitProg (see Figure 5-5). Click
the Connect button.

Figure 5-5. Connect Device from PSoC Creator

F I |
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PSoC 4000 (ARM CMO)
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Revision: PRODUCTION
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[Sl'lowdtagets -

Coree |

8. Click OK to exit the window and start programming, as shown in Figure 5-6.
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Figure 5-6. Program Device from PSoC Creator
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Notes:
m The Debug port is disabled by default in one of the example projects (Project: CapSense Proxim-

ity and UART on page 52) because it uses the P3[0] (SWDIO) pin for software TX output. If
debug is required, then change the Debug Select setting in the cydwr file to SWD, as shown in
Figure 5-8. and disable software TX in the project by commenting out the TX_ENABLE macro
present in the main.h file. The example project, Project: Color Palette on page 77, includes a soft-
ware TX, but the TX port is disabled by default. To enable the TX port, change the Debug Select
setting in the cydwr file to GPIO and uncomment the TX_ENABLE macro in the main.h file. If TX
is required along with SWD debug, then follow these steps:

a. Route TX pin to any other available pin by modifying TX_PORT/TX_PIN macro available in
main.h file of the projects.

b. Remove resistor R57 (Figure 5-7) on the board.
c. Route the TX pin selected in step 1 to pin J8_ 9 (P12[6]/RX line of PSoC 5LP available in J8).

Reset the device after plugging in the USB cable for the first time (if kit drivers are installing, then
after driver installation) when using SmartSense Auto-tuning in the project. This is because
SmartSense tunes the sensors during power-on and the presence of hand or power fluctuations
during the USB plugging will affect the tuning algorithm; it can render stuck or insensitive touch
sSensors.

By default, when the example projects are opened for the first time, an inline error can pop up in
the main.c or main.h file against the '#include <project.h>'line. This error is temporary and
will go off when the project is built. The project.h file is generated only when the project is built,
hence the error is shown before building the project.
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Figure 5-7. R57 Location on the Board
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Figure 5-8. Debug Port Pin Functionality Selection
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5.2 Project: Blinking LED

5.2.1 Project Overview

The CY8CKIT_040_Blinking_LED.cyprj example uses a PWM block to blink the red LED of the RGB
LED, as shown in Figure 5-9. The PWM output is connected to pin P3_2 (red) of the RGB LED. The
PWM block is configured as a digital clock signal generator with a frequency of 1 Hz. The blinking
rate can be varied by changing the period and compare value of the PWM.

Figure 5-9. PSoC Creator Schematic Design of Blinking LED Project

LED Blinking Design
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This is a blinking LED project. PWM component drives the pin connected to the LED on the CYBCKIT-040 to blink the-LED at-every one second.

5.2.2 Project Description
5.2.2.1 PSoC Creator Component Configuration

PWM (TCPWM mode)
The TCPWM Component is configured as a PWM with the parameters shown in Figure 5-10.
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Figure 5-10. TCPWM Component Parameters
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Firmware Details

Figure 5-11 shows the flow chart of code implemented in main.c.

Figure 5-11. Blinking LED Project Flow Chart
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Hardware Connections

No specific hardware connections are required for this project because all connections are hard-
wired on the board. Open CY8CKIT_040_Blinking_LED.cydwr under the Source vertical tab in the
Workspace Explorer and select the suitable pin, as shown in Figure 5-12.

Table 5-1. Pin Connection

Pin Name Port Name
PWM P3_2 (Red)

Figure 5-12. Pin Selection for Blinking LED Project

=
Alias  Name Port Pin Le
Pin_RedLED | P3[2] TCPWMO:P v Izs |v| i

Verify Output

Build and program the code example onto the device. Observe the frequency and duty cycle of the
blinking LED. Change the period and compare value in the PWM Component, as shown in
Figure 5-10. Rebuild and reprogram the device to change the blinking rate.

Project: CapSense Proximity and UART

Project Overview

The project CY8CKIT_040_Proximity UART.cyprj implements a capacitive proximity sensor control-
ling the brightness of a LED. The project configures the sensor as a CapSense proximity widget with
SmartSense Auto-tuning. Firmware Details on page 56 presents the firmware flow and explains the
firmware blocks in detail.
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Figure 5-13. PSoC Creator Schematic Design of PWM Project
CapSense Proximity with UART TX Design

Input - CapSense Proximity QOutput - LED Dimming PRSm
PWR
PRSmM Vdd
PWM
CapSense
]
PROX CapSense CSD| u
ccle a
. -
line pe— MPLLFQ -
Auto (SmantSense) line_n =]
Clock_PWMAR- — {»clock
6 MHz i
Configured as: mtarupti£l
1. One Proximity Sensor with SmartSense Auto tuning
and 0.1 pF sansitivity Configured as:
1. PRSm with Period of 500 Hz/32768 Counts
2. Line autput inveried to control the Brightness of an
Active Low LED
Debug - Software TX Watchdog ISR for periodic ISR
TX GlobalSignal WDT
SW Tx UART Global Signal
Tx

WoT-—— [=]WDT_ISR

Configured as: The timer is configured in firmware, this component is
1. 115200 bps Software TX for sending the Sensor data just to route the WDT interrupt to an ISR companent.
like Rawcount, Baseline & Signal.
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5.3.2 Project Description
5.3.2.1 PSoC Creator Component Configuration

CapSense

The CapSense Component is configured in SmartSense Auto-tuning mode with one proximity sen-
sor for the design with the parameters shown in Table 5-2.

Table 5-2. CapSense Component Parameters

Parameter Tab Present Value Rationale
Tuning method Auto Autgmatlcally adjust sensitivity for different system
(SmartSense) environments.
Threshold mode Automatic To enable run-time threshold calculation for 5:1
General SNR

Filter out noise or unwanted spikes in raw count.

Raw data noise filter First Order IIR 1/4 | This setting can be tweaked based on require-
ment.

Add a proximity sensor by clicking Proximity Sen-
sors and then clicking Add Proximity Sensor.
The only parameter that is available to modify in
this tab is debounce. This can be set or adjusted
based on system requirements.

ProximitySensor0 Widgets Config

Analog switch drive Reduce EMI emission and enhance EMC immu-
PRS-12b .
source nity.
Sensor auto-reset Disabled Not rqulred in the design. Add if required by the
application.
Low baseline reset 5 System dependent number. Configure according
to user needs.
Inactive sensor con- | Advanced Make the proximity loop not pick up any charge
. Ground
nection when not scanned
Shield Disabled Not used in the design.
Guard sensor Disabled Not used in the design.
Precharge by Vref Vref is enough for precharglqg, as there is only
Cmod precharge one sensor. Cmod voltage will not drop too low for
buffer
a fast GPIO precharge.
Obtain the maximum possible sensitivity using
SmartSense. The parameter controls the scan
Sensitivity Scan Order 1 time, so for-a Iowe.r number sensitivity setting, the
scan rate will be higher. This parameter can be
adjusted depending on the response rate and
proximity range needed.
Enable Tuner helper | Tuner helper Unchecked No tuner used.

PRSm (TCPWM Mode)

The TCPWM Component is used to control the LED brightness. The CapSense proximity sensor's
signal output is used to deduce the LED brightness. Figure 5-14 shows the parameters for the
TCPWM Component. The TCPWM block is configured as a PWM in Pseudo Random Sequence
modulator (PRSm) mode with a resolution of 15 bits (fixed by the TCPWM block architecture). This
15-bit resolution of the PRSm along with a 16-MHz input clock generates a period of 500 Hz (PRS
repeat period). The output line is inverted to drive the Active Low LED. A period of 32767 is set in the
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Component to generate the proper period macro for the 15-bit PRSm. Though the output of PRSm
has a variable frequency with a maximum frequency of 8 MHz (16 MHZ/2), the repeat rate of PRSm

is considered to be the period in this context.

Note: The Compare value should be a minimum of '1"; '0" will leave the LED on.

Figure 5-14. TCPWM Component Configuration - ‘PWM’ Tab

.
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TX (Software TX UART)

The software transmit TX is used to send out proximity sensor related data for debugging. The con-
figuration for the component is shown in Figure 5-15. The TX pin is selected in firmware through
TX_PORT/TX_PIN macros defined in the main.h file. The SW TX data can be sent to the PC using
either an RS232 connector (with a voltage level translator in between) or through the USB-UART
bridge available in the CY8CKIT-040 PSoC 5 LP UART bridge, or the CY3240 bridge configured as

a UART bridge as documented in AN2397.
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Figure 5-15. Software UART TX Component Parameters

Configure 'SW_Tx_UART’ R
Mame: TX
Basic | Built-in 4k
Parameter Value
BaudRate 115200

PinAssignmentMethod | Dynamic

Parameter Information

Pin_LED (Digital Output Pin)

The digital output pin is used to drive the PWM output to the LED. It is a standard strong drive output
pin.

Clock_PWM (Cy_Clock)

Clock_PWM provides the clock that drives the PWM block. The clock is configured to be the maxi-
mum possible or allowed (16 MHz), so that the repeat rate of the PRSm is as high as possible for
reduced LED flickers.

GlobalSignal_WDT (Global Signal Reference with ISR)

Component used to route the WDT ISR to an ISR component. This ISR is then configured in firm-
ware for generating periodic wakeup signal using WDT during Sleep_Scan mode.

Firmware Details

Firmware Structure

The firmware is written in a modular format, with different aspects of the functionality provided as
separate functions for easy understanding. The header provides a list of handy macros for configur-
ing the project's key aspects according to user requirements. The comments in the header file pro-
vide the details on the macro.

Table 5-3. Source Files and Header Files in the CapSense Proximity Project

File Names Purpose
main.c This file contains all the function definitions used in the firmware.
. This file contains all the macros used in the firmware. The details of the macros and their
main.h .
usage can be found in the comments above each macro.

Firmware Flow Chart

Figure 5-16 shows the flow chart of code implemented in main.c.
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Figure 5-16. CapSense Proximity and UART Project Flow Chart
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The firmware does the following:

m The CapSense/input initialization part tunes the CapSense system parameters using
SmartSense.

The output initialization part configures the PWM and the software UART TX output.
The infinite loop code is divided into two phases: input process and output process.

o The input process phase scans the proximity sensor and processes the sensor signal, such
as applying filter, calculating baseline, and signal.

0 The output process phase is also split into two phases: the data calculation and data output
subphases.

i. The data calculation subphase compares the proximity signal with a minimum and maximum
threshold defined for an approaching hand. The LED brightness is then calculated based on the
sensor's signal value relative to the thresholds. The minimum threshold generates the lowest
LED brightness, and the maximum threshold generates the highest LED brightness.

ii. The data output subphase updates the PWM compare value with the calculated brightness.
The system data such as sensor raw data, baseline, signal, and calculated LED brightness are
sent over the UART TX line.

The device monitors the activity on the proximity sensor, and if there is no activity, that is, if the hand
is out of range of the proximity, then the device enters a sleep-scan mode. The time for which the
device checks for a no activity on the sensor before entering sleep-scan mode is set to 5 seconds
and is configurable in the project (ENTER_SLEEP_COUNTS macro in main.h). In the sleep-scan
mode, the device wakes up every 100 ms and checks for any activity on the proximity sensor. This
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wakeup rate is configurable by modifying the WATCHDOG_TIMER_COUNT macro in the main.h

file.

Note: There are macros defined in main.h for configuring the project based on user requirements.
The details of each macro are mentioned in comments above its definition.

Useful CapSense Component Functions/Variables

Table 5-4, Table 5-5, and Table 5-6 provide details of some useful component APIs, variables, and
macro definitions. These details are also available in the CapSense component datasheet.

Note: All reference to the API/variable/macro assume the CapSense component instance name as

‘CapSense’.

Table 5-4 provides a quick reference to some key CapSense component variables/arrays.

Table 5-4. CapSense Component Key Variables

Variable/Array Name

Description

Usage

uint16
CapSense_SensorRaw

I

This array contains the raw data for each sensor.
The array size is equal to the total number of sen-
sors (CapSense_TOTAL_SENSOR_COUNT).
The CapSense_SensorRaw [ ] data is updated by
these functions:

» CapSense_ScanSensor()

» CapSense_ScanEnabledWidgets()
*CapSense_InitializeSensorBaseline()

» CapSense_InitializeAllBaselines()

» CapSense_UpdateEnabledBaselines()

The variable can be accessed in
any file by importing it using
‘extern uint16
CapSense_SensorRaw([]; in the
‘.c’ or “.h’ file.

It is recommended not to alter
the arrays manually.

This array holds the baseline data of each sensor.
The historical count value, calculated indepen-
dently for each sensor is called the sensor's base-
line. The array’s size is equal to the total number

The variable can be accessed in
any file by importing it using

CapSense_SensorSign

alf]

uint16 of sensors. The CapSense_SensorBaseline[ ] ‘extern uint16
CapSense_SensorBas |array is updated by these functions: CapSense_SensorBaseline[];’ in
eline(] « CapSense_|nitializeSensorBaseline() the ".c’ or "’ file.

» CapSense_InitializeAllBaselines() Itis recommended not to alter

) the arrays manually.

» CapSense_UpdateSensorBaseling()

» CapSense_UpdateEnabledBaselines().

This array holds the sensor signal count com-

puted by subtracting the previous baseline from

the current raw count of each sensor. Each array

s!ﬁfment corrtlespontljlq?ttr? a siensgr V‘g” ha\t/: the The variable can be accessed in

i .erer;]ce vha rde c;na/ if the va uoer:s above e_” A any file by importing it using

uint8 noise threshold of the sensor. Otherwise, it will be ‘extern uint8

0. The array size is equal to the total number of
sensors. The CapSense_SensorSignal[ ] array is
updated by these functions:

» CapSense_InitializeSensorBaseline()

» CapSense_InitializeAllBaselines()

» CapSense_UpdateSensorBaseling()

» CapSense_UpdateEnabledBaselines().

CapSense_SensorSignal[];’ in
the ‘.c’ or “.h’ file.

It is recommended not to alter
the arrays manually.
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Table 5-5 provides a quick reference to some key CapSense component macro definitions.

Table 5-5. CapSense Component Macros

Macro Format

Sample Description

CapSense_TOTAL_SENS
OR_COUNT

Defines the total number of sensors
within the CapSense component.

CapSense_SENSOR_"WI
DGET_NAME”_<ELE-
MENT+ELEMENT_NUMB
ER>_"WIDGET_TYPE”

» CapSense_SENSOR_TP1_ROWO0__ TP
* CapSense_SENSOR_LS0 _EO__ LS
» CapSense_Sensor_BTN1__ BTN

The constant denotes the sensor
number of a sensor in the CapSense
block.

WIDGET_TYPE:

BTN — buttons

LS — linear sliders

RS - radial sliders

TP — touchpads

PROX — proximity sensors
MB — matrix buttons

GEN - generic sensors
GRD - guard sensors

CapSense "WIDGET_NA
ME”__"WIDGET_TYPE”

» CapSense_TP1__TP
* CapSense_LS0__ LS
» CapSense_BTN1__ BTN

The constant denotes the widget
number of a widget in the CapSense
block.

Table 5-6 provides a quick reference to some key CapSense component APIs and their usage.

Table 5-6. CapSense Component APls

API

Description/Usage

void
CapSense_EnableWidget(uint32
widget)

The API enables the selected widget sensors to be part of the scanning
process.

Proximity widgets are disabled by default in the component; the user
needs to call this API along with the proximity widget number to enable
the same to be included in the scanning process.

void CapSense_Start(void)

The API enables the CapSense block and tunes the sensors if
SmartSense or Auto-calibration is used.

It should be called before using the CapSense block for sensing.

void
CapSense_InitializeAllBaselines(voi
d)

The APl initializes the CapSense_sensorBaseline[] array with values
obtained by scanning all sensors.

It should be called after starting the CapSense block and before starting
the scan for detecting touches.

void
CapSense_InitializeSensorBaseline
(uint32 sensor)

The APl initializes the CapSense_sensorBaseline[sensor] array ele-
ment with values obtained by scanning the selected sensor.

It can be used initialize each baseline individually.

void
CapSense_ScanEnabledWidgets(v
oid)

The API starts scanning a sensor within the enabled widgets. The ISR
continues scanning sensors until all enabled widgets are scanned. Use
of the ISR ensures this function is non-blocking. After each sensor scan
is complete, the ISR copies the measured sensor raw data to the
CapSense_SensorRaw[] array.

This is the preferred scanning method if there are multiple widgets in the
design.
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Table 5-6. CapSense Component APls

API

Description/Usage

void CapSense_ScanWidget(uint32
widget)

The API sets the CapSense block settings for the selected widget and
starts scanning the widget.

It can be used if scanning of only an individual widget is desired.

void CapSense_ScanSensor(uint32
sensor)

The API scans the selected sensor. After scanning is complete, the ISR
copies the measured sensor raw data to the
CapSense_SensorRaw[sensor] array element.

It can be used to perform individual sensor scanning.

uint32 CapSense_IsBusy(void)

The API returns the status of sensor scanning.

After calling any of the scan APIs, this API can be used to check
whether the triggered scan is complete.

Returns
‘1’ if scan is in progress
‘0’ if scan is complete

void
CapSense_UpdateSensorBaseling(
uint32 sensor)

The API filters the CapSense_SensorRaw[sensor] element using the fil-
ter selected in the component. It updates the
CapSense_SensorBaseline[sensor] element using a low-pass filter with
k = 256 on the filtered CapSense_SensorRaw[sensor] value.

This API should be called after completion of the ScanSensor() API,
before checking for any activity on the sensor.

void
CapSense_UpdateEnabledBaseline
s(void)

The API applies selected filter to the CapSense_SensorRaw[] array and
updates the CapSense_SensorBaselinel] array of all the sensors pres-
ent in the enabled widgets.

This API should be called after the completion of the ScanEnabledWid-
gets() API before checking for any activity on any of the sensors.

uint32
CapSense_ChecklsWidgetActive(ui
nt32 widget)

The API compares the selected sensor CapSense_Signal[ ] array value
to its finger threshold. Hysteresis and debounce are applied to deter-
mine if a sensor in the selected widget is active.

This API should be called after the UpdateSensorBaseline() or Upda-
teEnabledBaselines() API to check if any sensor in the widget is active.

Returns
‘1’ if one or more sensors within the widget are active
‘0’ if all sensors within the widget are inactive

uint32
CapSense_ChecklsAnyWidgetActiv
e(void)

The API performs the same task as CapSense_ChecklsWidgetActive()
on all the enabled widgets.

This API should be called after the UpdateEnabledBaselines() API or
after updating the baseline of all enabled sensors/widgets, to check if
any of the sensors is active in all the enabled widgets.

Returns
‘1’ if any widget is active

‘0’ if all the widgets are inactive

Hardware Connections

A wire in the form of a loop is connected to jumper J5 (P2_0), as shown in Figure 5-17. To enable the
UART TX connection to the PSoC 5LP USB-UART bridge, make sure R57 is populated on the board
(by default it is populated on the board). No other hardware connections are required for this project.
All other connections are hardwired on the board.
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Note: The proximity distance depends on the diameter of the wire loop. The larger the diameter, the
greater the distance. Take care while creating the loop because a larger loop tends to pick up more
noise. If the wire shipped with the kit (4 inches in length) is wound to form a loop of 1 to 2 inch diam-
eter, the proximity range will be approximately the same as the loop diameter for a fast approaching
hand. To obtain a higher range, use a longer wire/bigger loop. Also, do not plug the wire loop after
the device is programmed/powered, as the firmware tunes the proximity sensor during reset. Plug-
ging the wire after a reset will be detected as change in capacitance, and the LED will be always on.
Always do a reset after plugging in the wire loop if the device was already programmed.

Figure 5-17. CapSense Proximity Example - Hardware Setup

Proximity Loop

Open CY8CKIT _040_Proximity UART.cydwr in the Workspace Explorer and select the suitable
pins, as shown in Figure 5-18.

Table 5-7. Pin Connections

Pin Name Port Name
Proximity Pin P2_0
CMOD Pin PO _4
LED Pin P3_2 (Red)
UART TX Pin P3_0'

1. Selected in firmware

Figure 5-18. Pin Selection for Proximity Project

v4b X
Alias Name Port
-
ProximitySensor0_0__PROX | \CapSense:Sns\ | Pz[0] v
Pin_LED P3[2] TCPWMO:P | v
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Verify Output

Build and program the code example, and reset the device. Observe the red LED intensity changing
as you move your palm toward the proximity wire loop. The UART TX data can be viewed through
the BCP, as explained in 5.3.3.1 UART Data Viewing.

Figure 5-19. CapSense Proximity Example Output

Red LED turns ON as
the hand approaches
the Proximity loop

UART Data Viewing

One UART packet size is 13 bytes, which includes 8 bytes of data, 2 bytes of header, and 3 bytes of
footer. The 2-byte header precedes the data bytes; in the design it is 0OxOD and OxOA. The 3-byte
footer follows the data bytes and in this design consists of 0x00, OxFF, and OxFF. The data bytes
consists of proximity sensor raw counts (RC), baseline (BL), and signal (SIG) along with the calcu-
lated PWM duty (DUTY). Table 5-8 shows the UART TX data packet structure.

Table 5-8. UART TX Data Packet Structure

Header Data
BYTE 0 BYTE 1 BYTE 2 BYTE 3 BYTE 4 BYTE 5 BYTE 6
0x0D 0x0A RC_MSB RC_LSB BL_MSB BL_LSB SIG_MSB
Data Footer
BYTE 7 BYTE 8 BYTE 9 BYTE 10 BYTE 11 BYTE 12
SIG_LSB DUTY_MSB |DUTY_LSB 0x00 OxFF OxFF

Follow these steps to set up the BCP for viewing the data:

1. Open the BCP software available from All Programs > Cypress > Bridge Control Panel <ver-
sion> > Bridge Control Panel <version>.

2. Route the TX pin of the device to any available RX that can connect to the PC COM port. CY3240
(refer to AN2397), or KitProg in CY8CKIT-040 can be used for this purpose.

Note: In CY8CKIT-040, Pin 3_0 is routed directly to the RX pin of the PSoC 5 LP USB-UART
bridge through a zero-ohm resistor. Pin 3_0 can be used as TX, and is available only by disabling
the debug feature of the chip. If the debug feature is required along with TX, then the zero-ohm
resistor connecting the TX and RX should be removed. Any free GPIO can be used as the TX for
the device and can be routed to the RX pin of PSoC 5 LP externally (see the last step of
Programming the Example Projects on page 45 for details)
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3. In the BCP software, click the COM port to which you have connected the data. In this case, it is
KitProg's COM, as shown in Figure 5-20.

Figure 5-20. KitProg COM Port in Device Manager
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§ Generic USB Hub
.@ Generic USB Hub

A Computer Management B
File Action View Help
=5 2@ 0 BE & 2 &5
A Computer Management (Local|| 4 4= LAPWIN7-MSUR + | Actions
4 {]‘3 System Tools > @ Batteries Device Manager -
> @ Task Scheduler > 0 Bluetooth Radios
» (@] Event Viewer » M Computer More Actions

m

4. Select the COM port and RX8 as the protocol, as shown in Figure 5-21.
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Figure 5-21. Bridge Control Panel - COM Port and Protocol Selection
ﬁ Bridge Control Panel li‘ﬂﬂ‘

File Editor Chart Execute Tools Help
e iR oEEREERE
Edtor |Chart | Table [Fie |

< »

Select Port in the PortList, then try to connect - |
Opening Port

Successfully Connected to COM2
COM2 Serial Port

4 [

Connected 12C/SPI/RX8 Ports: p o,
E—_ - 17 i KitProg/191607A0032C2400 ‘ ower, ocol

@
=

| 1:1 [ syntax:OK [

5. Choose Tools > Protocol Configuration or press [F7] and configure the RX8 protocol parame-
ters, as shown in Figure 5-22.

Figure 5-22. RX8 Protocol Configuration

Protocol Configuration

[sp1_[izc [[RX8(UART)]|

Bit rate (bps): [llS.ZDD ']
Data bits: l8 v]
Partty type: None v
Stop bit: [One v]
Flow control: None

| Ok [Cancel |

6. Choose Chart > Variable Settings and set the variable names and types, as shown in
Figure 5-23. Or click Load and then select the CapSense Proximity UART - Variable.ini file sup-
plied with the project (. . . \Firmware\PSoC 4\Bridge Files\)inthe Open window that
appears. Click OK to exit.
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Figure 5-23.

Bridge Control Panel - Variable Settings

Example Projects

4 Open ¥
Y
k() | IC:\Program Files (86)\Cypress\CYCKIT-040 PSoC 4000 Pioneer Kit\L.0\Firmware\PSOC 4\BndgEFMEl - |[ search
&b Varizble Settings = X
Voo ,E Qrganize New folder (ul]
N Actve VauzhleNaze T Sgn_Scale Offset Color - Ut Favorites 5 MNeme Dete modified Type s
RewCout  int EE 0 Black E B Deskiop 4| CapSense Color Palette (Minimal T) - Variables.ini __ 2/15/2014 553 BM  Configuration seit. 3K8
2 Baselne int 5 0 Blue & Downloads [=2 Capsense Provirity UART - Varizble.ni ] atramma215m  configuration set.. 3KE
3 Signal int . 0 Maroon L Recent Places
4 Duty it . 0 Red 4& SkyDrive
5 O Key5 byts 1 0 BluViolet
s [0 Key6 byte | 1 0 LswnGreen 7l Libraries g
B ey Bite B 1 0 Magenta (5 pocuments
g 0 VarB byte 0 o1 0 Oive - o) Musie
=] Pictures
Pintpacketevery 1 5| @ AdsKis acount SR Rl 9 Podcasts
Sonl 0 | © AusXis atime Min [0 Max (500 B Videos
/% Computer
[ Load. ]I[ Save ]l 0K I[ X Cancel | B
B Lenovo_Recover _
File name: - [ini cini)
I Open H Cancel

Choose File > Open File and select the CapSense Proximity UART - Editor.iic file supplied with

the project fromthe .. . \Firmware\PSoC 4\Bridge Files\ folder (as shown in
Figure 5-24). Alternatively, go to Editor and type or copy the following command:
rx8 [h=0D 0A] @1RawCount @0ORawCount @ 1Baseline @0Baseline @1Signal @0Signal @1Duty @0Duty [t=00 ff ff]

Figure 5-24. Open *.iic File in Bridge Control Panel

% Bridge Control

OR

File  Editor

SR

ﬁ Bridge Control Panel

l File \JEditor Chart Execute Tools
[& OpenI2CBLFile... Ctrl+B &
i (& Openl2CMBEM File.. Ctrl+M
[ & OpenFile. a0

ﬁ; Open Script File...

W r

S

|_ E\Prugram Files (x86)% Cypress\CYSCKIT-040 PSOC 4000 Pioneer Kit\Firmware\PSOC 44Bridge Files vl - | | Search Bridge Files

5
)
]
Y
i
©

Organize *

Bl Desktop

& Downloads
& SkyDrive

= Libraries
3 Documents
J Music
[=| Pictures
? Podcasts

H videos

1% Computer

=] Recent Places

MNew folder

A -
Mame

Date modified

I |\Z CapSense Proximity UART - Editor.iic

Jorarzma 215 em

£ Windows7_0S (1
_:.@3 Lenovo_Recovel

o msur (Whsimbadl T

File name: CapSense Proximity UART - Editor.iic

Type

IIC File 1KB

+ | OC Files (*.iic) &
I Open ‘q Cancel

Click the command line and then click Repeat, as shown in Figure 5-25 to start receiving the

packets (make sure you have powered the device and programmed with the project's firmware,
the TX is connected to the RX line of the COM, and the COM port is selected in the BCP).
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Figure 5-25. Bridge Control Panel - Protocol Execution
(w Bridge Control Panel M}

File Editor Chat Execute Tools Help

FEE 2R E BEEE

Editor | Chart | Table | File

e RX8 packet structur
sHeader = {0x0D 0Ox0A}

sData = {2 Bytes of Raw Count} {2 Bytes of baseline} {2 bytes of Signal} {2 bytes of PWM Duty)}
;Tail = {0x00 OxFF OxFF)}

rx8 [h=0D 0a] @1RauCounﬂ @0RawCount @lBaseline @0Baseline @1Signal @0Signal @1Duty @0Duty [t=00 f£f ff]l

Connected I2C/SPI/RX8 Ports

KitProg/10130DCC1322400 s e
- |com3 4» ] x
0 i SP

@ RX8 (UART)

5 [ommrox | G - g

Example Projects

9. You should start receiving data. Click the Chart tab to view the graph, as shown in Figure 5-26.

Figure 5-26. Bridge Control Panel - Chart for Viewing Debug Data
Signal
% Bridge Control Panel @Eu

File Editor Chart Execute Tools Help
FEE SR OEEEE
Ecitofl | Chart | flble [ Fie |

- 7 Ao
. [\ ==
% :

. \
40
@ Linear
2 © Log10
20 2560 3200 3840

Flags Chart Qualty  Chart Mode l
gf0 gfl gf2 gf3 gf4 gf5 gfé gf7 gf8 gf9 gfA gfB gfC gfD gfE gfF @© High @ Line Plot

@ Nomal © Bar Graph
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LED Intensity (PRSm duty cycle)
% Bridge Control Panel E@u

File Editor Chart Execute Tools Help
FRE HLR | CEEEE

Edtor | Chett | Table [ Fie |

= [¥] Select Al
. 1N B — o

- s B — e
I - —

-7 .
- ]/ \

\ @ Linear
zn \ © Log10
10 e R R R T T T T R T T cnts
0 640 1280 1520 2560 3200 3840
Flags Chart Quality Chart Mode
gf0 gfl gf2 gf3 gf4 gf5 gfé gf7 gf8 gf9 gfA gfB gfC gfD gfE gfF @ High @ Line Plot
@ Nomal © BarGraph

Raw count and Baseline

ﬁ Bridge Control Panel lim

File Editor Chart Execute Tools Help
FEE IR CEERERE
Edor | Chat | Table [ Fie |

. AN
=~ N
| kN

‘\ © Linear
e ] © Log10
~ ~—vv’ e
L = S—— -_ _—_—m e s m--ese e cnts
0 640 1280 1920 2560 3200 3840
Flags Chart Quality Chart Mode
gf0 gfl gf2 gf3 gf4 gf5 gfé gf7 gf8 gf9 gfA gfB gfC gfD gfE gfF © High @ Line Plot
@ Nomal ) Bar Graph
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Project: CapSense Touchpad with I2C Tuner

Project Overview

The project CYSCKIT_40 CapSense_12C.cyprj demonstrates the implementation of a CapSense
Trackpad using SmartSense and an EzI2C-based CapSense Tuner window for viewing the Track-
pad coordinates. The project is a simple implementation using SmartSense (minimal tuning). The
EzI2C block of PSoC 4000 is interfaced through the PSoC 5LP based USB-I°C bridge to the PC
GUI. The project uses the SmartSense feature, which sets all CapSense parameters to the optimum
values automatically. The parameter settings can be monitored in the GUI but cannot be altered. In
the manual tuning method, parameter settings can be changed in the GUI, and the resulting output
can be seen (refer to the CapSense Design Guide and CapSense Component datasheet for more
details on manual tuning).

Note: This project requires the Trackpad shield board to be plugged into the PSoC 4000 Pioneer Kit
baseboard, as shown in Figure 5-27.

Figure 5-27. Kit Setup With Trackpad

—
_ Trackpad Shield
stacked onto the

CY8CKIT-040

TRACKPAD
SHIELD Pl

8
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Figure 5-28. PSoC Creator Schematic Design of CapSense Trackpad Project with I2C Tuner

CapSense 12C Tuner Design

CapSense TrackPad + EZI2C Tuner

CapSense SCB
CapSense CSD| EZI2C
Auto [SmanSenas) Slave

CapSense block Key Configuration:
1. SmartSense Mode
2. Bx5 elements Touchpad/Trackpad

3. Tuner Enabled - Configured with 0x08 address and 100 kbps
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5.4.2.1

Project Description

Example Projects

PSoC Creator Component Configuration

CapSense

The CapSense Component is configured in SmartSense Auto-tuning mode with a 6x5 CapSense
touchpad widget for the design, according to the parameters given in Table 5-9.

Table 5-9. CapSense Component Parameters

Parameter Tab Present Value Rationale
Tuning method Auto(SmartS |Automatically adjust sensitivity for different system environ-
ense) ments.
Threshold mode |General Automatic Enable run-time threshold calculation for 5:1 SNR
Raw data noise First Order |Filter out noise or unwanted spikes in raw count. This setting
filter IIR 1/4 can be tweaked based on requirement.
TouchPadO }Q/}ldgets Con- Add and configure the touchpad as shown in Figure 5-29.
Arlmalog switch PRS-Auto Reduce EMI emission and enhance EMC immunity.
drive source
rSezr;stor auto- Disabled Not required in the design. Add if required by the application.
Low baseline 5 System-dependent number. Configure according to user
reset needs.
Inactive sensor Advanced Ground Make the proximity loop not pick up any charge when not
connection scanned.
Shield Disabled Not used in the design.
Guard sensor Disabled Not used in the design.
Precharge by | Vref is enough for precharging, as there is only one sensor.

Cmod precharge Vref buffer Cmod voltage will not drop too low for a fast GPIO precharge.

Select all the sensors by pressing and holding [CTRL] or
Sensitivity Scan Order 5 [Shift] key and clicking on all the sensors. When selected,

enter a value in the Sensitivity field.
Enable Tuner Enabled/ _, ,
helper Tune helper Checked Name ='SCB
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Figure 5-29. CapSense Touchpad Parameters

Example Projects

-
Configure 'CapSense_CSD_P4"

MName: CapSense

General)/'lmdgeis Config }/Smn Qrder }/ndvanced }/Tune Helper ]/Built—in ]

4 b

Ed Add touchpad | E Remove | Rename |

The Component is configured in the SmartSense mode, so some widget properties are not available.

Buttons

Linear sliders
Radial sliders
Matrix buttons
Touchpads

|| Proximity sensars
| Generics

Al
=l
al
Al
Al

E Column Tuning

Column Finger threshold (FT) 100
Column Moise threshold 20
Column Scan resolution 12 bits
B General
Mumber of sensor rows 5
Mumber of sensor columns &
Row AP Resolution 100
Column AP| Resolution 120
Position Noise Fitter Aweraging
= Row Tuning
Row Finger threshold (FT) 100
Row Moise threshold 20

Row Scan resolution 12 bits

Apply

SCB (EzI2C Mode)

The Serial Communication Block (SCB) configured in EzI2C mode is used for the CapSense Tuner.
The parameters of the component are shown in Figure 5-30.

Figure 5-30. SCB (EZI2C Mode) Component Parameters

-
Configure 'SCB_P4'

R

Oversampling factor: |16
[ Clock from teminal
Clock: stretching
Median fitter

MName: SCB
Conﬁguration/]/ EZI2C ]/Built—in ] 1k
Data rete (kbps): 100 - Actual data rate fcbps): 100

-
¥

Number of addresses:

Sub-address size (bits):

Primary slave address (7-bits):

[7] Enable wakeup from Sleep Mode

x08

@

e
LB

16 -

Datasheet [

OK

] Aoply
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5422 Firmware Details

Figure 5-31 shows the flow chart of code implemented in main.c.

Figure 5-31. CapSense Touchpad With I2C Tuner Project Flow Chart

Initialize CapSense and
Enable Tuner

v

Process CapSense and
Send data over tuner

54.2.3 Hardware Connections

Example Projects

Plug the Trackpad shield board into the Arduino headers of the kit, as shown in Figure 5-27. Other

connections are hardwired on the board.

Open CY8CKIT_040_CapSense_I2C.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-10. Pin Connection’

Pin Name Port Name
CMOD PO_4
Trackpad_XO0 PO 3
Trackpad_X1 PO_7
Trackpad_X2 PO 6
Trackpad_X3 PO_5
Trackpad_X4 PO O
Trackpad_X5 PO_1
Trackpad_YO P1 4
Trackpad_Y1 P1_5
Trackpad_Y2 P16
Trackpad_Y3 P1_0
Trackpad_Y4 P17
12C_SCL P1_2
12C_SDA P1_3

1. Trackpad_XO0 (TouchpadO_Col0_TP) to Trackpad_X5 (Touchpad0_Col5_TP) maps to
COL5 to COLO of the Trackpad so as to make the Trackpad x-axis left aligned.
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Figure 5-32. Pin Selection for CapSense I°C Project

* 9 Fr X

Alias Name ' Port Fin Lock

* v

Touchpad0_Col0_TP | \CapSense:Sns[01% | PO[3] 4 *| ¥
Touchpad0_Col1_TP | \CapSense:Sms[11% |P0[7] 11 *| ¥
Touchpad0_Col2_TP | \CapSense:Sns[21% | POLE] 10 *| ¥
Touchpad0_Col3_TP | \CapSense:Sns[31% |POIS] 2 *| ¥
Touchpad0_Cold__TP | \CapSense:Sns[41% | PO[0] 1 *| ¥
Touchpad0_Col5_TP | \CapSense:Smns[51% | PO[1] 2 *| ¥
Touchpad0_Rowld__TF | \CapSense:Sns[61% | P1[4] 16 *| ¥
Touchpad0_Row1__TF | \CapSense:Sns[71% | P1[5] 17 *| ¥
Touchpad0_Row2__ TP | \CapSense:Sns[81% |P1ll6] TCPWMO:N 18 *| ¥
Touchpad0_Row3__TF | \CapSense:Sns[31% | P1[0] 12 *| ¥
Touchpad)_Rowd__TP | \CapSense:Sns([10]\ | P1[7] EXTCLK 13 *| &
\SCB:sel\ P1[2] SCBO:I2C:SCL 14 *| ¥

\SCB:sda\ P1[3] SCBO:I2C:SDA 1 *| ¥

54.3 Verify Output

Example Projects

Build and program the code example and reset the device. Launch the CapSense Tuner window as

explained in the following steps.

5.4.3.1 Launching Tuner Window

The Tuner window from PSoC Creator must be up and running for the code example to work. To

launch the GUI, follow these steps:

1. Go to the project's TopDesign.cysch file, as shown in Figure 5-33.

Figure 5-33. Top Design File

Workspace Bxplorer (L project)
E%u.a

".ﬁfvnrlcspac:e ‘CYBCKIT_(40_CapSense |20 (1 Projects)

la Header FI|E:S
E}@ Source Files
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2. To launch the Tuner, right-click the CapSense Component in PSoC Creator and click Launch

Tuner, as shown in Figure 5-34.

Figure 5-34. Launch Tuner

g I am—
o &Y Cut Ctrl+X
53 Copy Ctrl+C
|
rati
ol ¥ Delete Del
1/ Track
ured wi Select All Ctrl+A
Zoom b
Shape b
Select »
Configure...
2" Open Datasheet ...
Find Example Project...
Open Component Web Page
| Launch Tuner | | X
Generate Macro

3. The Tuner window opens. Click Configuration to open the configuration window, as shown in

Figure 5-35.
Figure 5-35. Tuner Window

-
[ﬁ‘ PSoC4 CapSense_CSD Tuner 2_0 for 'CapSense’. Tuning method:

Eile View Debug Validation Tools

ligy Start LJ Stop ‘lE] Configuration ™ Revert Parameters
_'."'-.;Iuning | Graphing | Validation |~ Debugging

1£] Reset Widgets Layout

Touchpad0

A I | |

4. Set the I°C communication parameters, as shown in Figure 5-36.

Figure 5-36. 1°C Communication

hl
Tuner Communication Setup @Iﬂ
Ports: Port Configuration
12C address: 8
Sub-address: [Z-E)r[eg -
12C Speed
) 1 MHz
@ 400kHz
@ 100kHz
Port Information @ 50kHz
KitProg Version 2.07 R
ok [ cacd |
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5. Click OK to apply the settings.

Verify Output

Example Projects

1. To start the scanning and communication process, click Start in the Tuner window, as shown in

Figure 5-37.
Figure 5-37. Start Communication
l[i. PSoC4 CapSense_CSD Tuner 2_

File View Debug Validati

E Config

Stop

fif, Start

2. Select a sensor in the Tuning tab. A red outline is displayed on the selected sensor. Different
CapSense parameters are shown on the bottom right. You cannot edit the settings because auto-
tuning is used in this project; auto-tuning automatically sets all the parameters. Touch the

selected sensor and observe the response in the Tuner window.
Figure 5-38. Widget Testing

(ﬂl PSoC4 CapSense_CSD Tuner 2_0 for 'CapSense’. Tuning method: Auto (SmartSense). =R Hl’n1
File  View Debug Validation Tools a| Help
Start |ﬁ Stop | |E=3 Configuration Revert Parameters
‘Tuning’ Tap | Tuning | Graphing | Validation | Debugging Sensor Properties - 3 X
weeerTTgets Layout D LA TOM | ouchpadn_Coln_TF =
VIEWINE SRR, 2759 | Max valus: 255
29 250
4]
200
; Toych position on the
1 trackpad 150
(! Ll
I 2 100 ||
i Fi reshold
3 50
M; resholl
a
4
12 1 2 5 4 5
Sensor parameters (Not|
editable for SmartSense)
Select a Sensor for
viewing parameters
by clicking on it (a red IDAC range IDAC_éx
outline appears
around it)
‘Sensor Properties’ tab ISensUr Pruper..l (Graphing Prop...|Logging Prope. ..
Running Speed: 84 pkts/s Desired packet size: 116 (0x74)

3. In the Graphing tab, the CapSense data — Raw counts, Baseline, and Signal (difference count)

for each sensor are represented as a graph.

4. Select the sensor parameters to observe, as shown in Figure 5-39. The graph of the selected

parameters appears.
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Figure 5-39. Sensor Parameter Graph

Example Projects

[T vsoca capsense oD TunE S e Cpoiee Ly et Ao s,

File View Debug Validation Tools WHdp
1iy Start M Stop Configuration = Revert Parameters
Tuning}” Graphing|| ~ Validation | Debugging | Graphing Properties v ax
v
1,387 i ‘ a
I EXTII Touchoad0
1,386.8 | ‘{ J m H‘ 5i i f D cte
1,386.6 |l HH-H A 1 ! H =¥ Touchpad0_Colp_TP
£ AL L) (] | | \ v
L 13860 JEH 1A d (/i Raw
@ I LA A0 R A 0 {11 1 i Pl
0 1,385.2 ‘ | = —Srrrat
o 138 UL L I | | @[] Touchpad0_Col1_TP
e @]  Touchpad0_Col2_ TP
P 1,385.8 @]  Touchpad0_Col3_TP
W 1,385.6 @] Touchpad0_Cold__TP
[a} @]  Touchpad0_Col5_TP
e @[ Touchpadd_RowD_ TP
1,385.2 @] Touchpad0_Row1_TP
@]  Touchpadd_Row2_TP
@]  Touchpad0_Row3_TP
@]  Touchpad0_Rowd__TP
2
o °
[}
0 50 100 150 200 250 3I;.|D 350 460 450 50 T
Sensor Proper...‘Graphng Prop...|Logging Prope...|
Running Speed: 81 pkts/s Desired packet size: 116 (0x74)

5. Touch a sensor or slider element and see the increase in Raw count and Signal, as shown in
Figure 5-40.
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Figure 5-40. Raw Count Increase

Example Projects

i PSoC4 CapSense_CSD Tuner 2_0 for 'CapSense’. Tuning method: Auto (SmartSense). =NAE X
File  View Debug Validation Tools H]| Help
Start |ﬂ Stop Configuration Revert Parameters
Tuning *” Graphing ] Validation | Debugging Graphing Properties >3 Xx
O
1,600 Touchpad
1,580 Touch Position
o 1,560 Touchpadl_Col0__TP
£ 1,540 gawl_
< aseline
g 1’2;2 Signal
m ' i Touchpad)_Col1_TP
o 1,480 0 Touchpadd_Col2_ TP
g LAeo 4 Touchpadd_Col3_TP
o i Touchpad)_Cold_TP
0 1,420 -] Touchpadd_Col5_TP
1,400 i-7]  Touchpadd_Row0__TP
1,380 7] Touchpadd_Row1_TP
1,360 L i-[C]  Touchpadd_Row2_TP
o] Touchpadd_Row3__ TP
240 e LM AN i-7]  Touchpadd_Rowd__TP
220 A \
200 | |
180 ‘l ‘
_ 160} \
o |
c 140 |
D 120 |
W 100 | |
80 | |
60 ||
40 ‘ T
20 |
o U |
0 50 100 150 200 250 300 350 400 450 50
Sensor Proper... |Graphing Prop. .. |Legging Prope. ..
Running Speed: 53 phts/s Desired packet size: 116 (0:74)

Project: Color Palette

Project Overview

The project CYSCKIT _040_Color_Palette.cyprj demonstrates the capability of PSoC 4000 device to
interface with a capacitive Trackpad and control an RGB LED based on the color selected by touch-
ing the sticker on top of the Trackpad. The sticker will also include a slider area (part of Trackpad),
which will control the color brightness of the RGB LED. The project will demonstrate the proximity
sensing capability of the device using a wire. The LED intensity control is done using software Preci-
sion lllumination Signal Modulator (PrISM). The project details are discussed in Firmware Details on
page 82. Figure 5-41 shows the top design schematic of the project.
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Figure 5-41. PSoC Creator Schematic Design of Color Palette Project
CapSense Color Palette

CapSense TrackPad + Proximity Software Based Precision lllumination Signal Modulation|
CapSense
EEHEHEREED -7 RGB_PRSm_Red

v RGB_PRSm_Green
« [l RGB_PRSm_Blue

Auls (SmarSense)

Software controlled PAISM Output Pins

CapSense Configuration:

1, SmartSense Mode

2, A Bx5 Touchpad widget with 120x100 resclution

3. One Proxmity sensor for wakeup

4, One Gang sensor for alternate wakeup (refer main.h)

Debug Interface WDT Timer ISR
T GlobalSignal_WDT
SW Tx UART Global Signal

WOTHZ]WDT_ISR

Software TX for sending sensor data, co-ordinates, if enabled WatchDog timer interrupt used for sleep/active scan timing
in firmware: purpose

55.2 Project Description
5.5.2.1 PSoC Creator Component Configuration

CapSense:

The CapSense Component is configured in SmartSense Auto-tuning mode with one 6x5 touchpad,
one dedicated proximity sensor, and a dummy/gang proximity sensor for the design with the param-
eters shown in Table 5-11.

Refer to the PSoC 4 CapSense Design Guide or the CapSense component datasheet for details on
various widgets used and parameters.
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Table 5-11. CapSense Component Parameters

Example Projects

Raw data noise
filter

Parameter Tab Present Value Rationale
Tuning method Auto(SmartSense) Autgmatlcally adjust sensitivity for different system
environments.
Threshold mode | General Automatic Enable run-time threshold calculation for 5:1 SNR.

First Order IIR 1/8

Filter out noise/unwanted spikes in raw count. This
setting can be tweaked based on requirement.

TouchPad0

ProximitySensor
0

ProximitySensor
1

Widgets Config

Add and configure the touchpad as shown in
Figure 5-42.

Add and configure a proximity sensor as shown in
Figure 5-42.

Add and configure a proximity sensor (Gang) as
shown in Figure 5-42. Note that this sensor is a
dummy sensor, which is ganged with the row ele-
ments of the touchpad for wakeup.

Analog switch

For reduced EMI emission and enhanced EMC

helper

. PRS-Auto . .
drive source immunity.
Sensor auto . Not required in the design. Can be added if
Disabled : e
reset required by the application.
Low baseline 5 System dependent number. Can be configured as
reset per the user needs.
Inactive sensor | Advanced Make sure the proximity loop does not pick up any
. Ground
connection charge when not scanned.
Shield Disabled Not used in the design.
Guard sensor Disabled Not used in the design.
Crod pre- Precharge by Vref Vref is enough for precharging he.re, as there is
charge buffer only one sensor, Cmod voltage will not drop too
low for a fast GPIO precharge.
Select all the sensors by pressing and holding
4 [CTRL] or [Shift] and clicking on all the touchpad
sensors. When selected, enter the value in the
Sensitivity field.
Sensitivity 1 Click ProximitySensor0 and set sensitivity as ‘1’
Scan Order for maximum range.
Click ProximitySensor1 and set sensitivity as ‘5’
5 for minimum resolution of scan during sleep scan
for reduced power consumption.
Sensor gangin ) Gang the touchpad row elements to
ganging ProximitySensor1 as shown in Figure 5-43.
Enable Tuner Tuner Helper Disabled/unchecked | No tuner used.
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Figure 5-42. CapSense Touchpad Parameters

Configure 'CapSense_CSD_P4°

Mame: CapSense
General)/l.'ﬁdgels Config ]/Smn Qrder }/Advanced }/Tune Helper }/Built—in ] q
Add touchpad | El Remove | Renarme |
The Component is configured in the Smart Sense mode, so some widget properties are not available.
- || Buttons B Column Tuning
_ﬂ' Linear sliders Column Finger threshold (FT) 100
‘_I,f Radial sliders Column Moise threshold 20
‘_I,J' Matrix buttons Column Scan resolution 12 bits
BJ Touchpads B General
p 4] TouchpadD Mumber of sensor rows 5
=-|. || Prowimity sensors Mumber of sensor columns [
& ProximitySensor( Row AP Resolution 100
-] Proximity Sensor Column AP| Resolution 120
‘_I,J' Generics Position Noise Fitter Averaging
E Row Tuning
Row Finger threshold (FT) 100
Row Moise threshold 20
Row Scan resclution 12 bits
<
Configure 'CapSense_C5D_P4" m
Name: CapSense
General/]/t'lﬁdgels Config ]/Smn Order I/Advanced }/Tune Helper }/Built-in ] 4k

Ed Add proximity sensor | Ed Remove | Rename |

The Component is configured in the Smart Sense mode, so some widget properties are not available.

‘_.ul Buttors
J' Linear sliders
- || Radial sliders
._'|JI Matrix buttons
BJ Touchpads
¢ B TouchpadD
B‘_jjl Proimity sensors

s
-] ProsimitySensor
‘_|”| Generics

B General

Number of dedicated sensor elemen 1

B Tuning
Finger threshold (FT)
Moise threshold
Hysteresis
Debounce
Scan resolution

100
20

10

3

12 bits
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Configure 'CapSense CSD_P4' 2 [l

MName: CapSense

General)/“ﬁdgels Config ]/Smn Order I/Advanced }/Tune Helper }/Built-in ] 4k
| Add proximity sensor | El Remove | Rename |
The Component is configured in the Smart Sense mode, so some widget properties are not available.

- || Buttons B General
J' Linear sliders Mumber of dedicated sensor elemen 0
- || Radial sliders B Tuning
- || Matrix buttons Finger threshold (FT) 100
BJ Touchpads Moige threshold 20
- & Touchpadd Hysteresis 10
=-|. || Prowimity sensors Debounce 3
i8] Prosdmity Sensorl) Scan resolution 12 bits
&
J Generics

C= = e

Figure 5-43. Scan Order Tab in CapSense Component Configure Window

)
Configure 'CapSense_CSD_P4' [

Mame: CapSense

General ]/Widgets Conﬁg/VScan Order ]/nduanced ]/Tune Helper ]/Built—in ] q I
4+ Up 4 Down |
Scan Sensar S_epse clock Mndula’_co_r
slot divider clock divider
7 Touchpadl Rowl_ TP 2 2
8 Touchpadll RowZ_ TP 2 2
9 Touchpadl Row3 TP 2 2 —
10 Touchpadl Rowd4 TP 2 2
1 ProximitySensorll_ PROX, Prosdmity Sensorl_0_ PROX w |2 2 e
12 i chpad( 0 chpa i v 2

Touchpadd_Col0_TP =

Touchpadd_Coll_TP .
TouchEadU_CoIZ_TP an time: UNMKNOWMN
Modulatiof ] Touchpad0_CoB_TP AC: Sensiivity:
Touchpadd_Cold_TP
Touchpadd_Col5_TP

Datas| 7] Touchpadd_Row0_TP I oK || ooy | ’ Cancel
Touchpadd_Rowl_ TP
1#] Touchpadd_Row2_TP
Touchpadd_Row3_ TP
Touchpadd_Rowd_TP
ProximitySensord_0__ PROX

Sensor s
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TX (SW TX UART)

The software transmit TX is used to send out sensor data for debugging if enabled in firmware (refer
to main.h in the project). The configuration for the component is shown in Figure 5-44. The SW TX
can be sent over to PC using either an RS-232 connector (with a voltage level translator in between)
or through USB-UART bridge available in CY8CKIT-040 PSoC 5 LP UART Bridge or CY3240 bridge
configured as UART bridge, as documented in AN2397. The TX pin, if enabled, is configured in firm-
ware through TX _PORT and TX_PIN macro available in main.h.

Note: By default, P3[0] is used for TX in firmware and P3[0] is hardwired in CY8CKIT-040 to the
PSoC 5LP USB-UART bridge's RX line. So SWD debug cannot be used if P3[0] is used for TX and
is enabled in firmware. Refer to the last step in Programming the Example Projects on page 45 for
details on how to use SWD debug and TX in the same project.

Figure 5-44. Software UART TX Component Parameters

Configure 'SW_Tx_UART [
Mame: T
Basic [~ Builtin 4 I
FParameter Value
BaudRate 115200

FindssignmentMethod | Dynamic

Parameter Information

Datashest Apph Cancel

b

RGB_PRSm_<Color> (Digital Output Pin)

To drive the software PrISM output to the respective <color> LEDs. It is a standard strong drive firm-
ware controlled output pin.

GlobalSignal_WDT (Global Signal Reference with ISR)

This component is used to route the WDT ISR to an ISR Component. This ISR is then configured in
firmware for generating periodic wakeup signal using WDT during Sleep_Scan mode.

Firmware Details

Firmware Structure

The color palette firmware is written in a modular format with different aspects of the functionality
provided in separate functions, source, and header files. This enables users to understand the firm-
ware structure better and to modify the firmware easily to meet the application requirements. The
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key aspects of the firmware can be modified to meet a different application requirement using vari-
ous macros defined in the main.h file.

Table 5-12. Source Files and Header Files in the Color Palette Project

File Names Purpose

RGB_PRSm.c, |These files contain the implementation of the software PRS modulator, which controls the
RGB_PRSm.h [LED intensity.

main.c This file contains all the function definitions used in the firmware.
This file contains all the macro definitions, imported variables, and exported function decla-
main.h rations. Key aspects of the firmware can be modified by changing the macro values in this
file.

Firmware Flow Chart
Figure 5-45 shows the flow chart of code implemented in main.c.

Figure 5-45. Color Palette Project Flow Chart

Start

\ 4
Enable proximity and
initialize all blocks
(CSD, PriSM, Debug
Interface, and WDT)

A\ 4

While(1) Loop

Switch(MODE)

I
SLEEP_SCAN PROX_SCAN ACTIVE
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Scan all sensors
excluding Prox

Is any sensor
active?

Yes

v

Get Trackpad
position

\ 4

Process co-
ordinates to
obtain color
and brightness
detail

\ 4

Update PrISM duty
based on color and
brightness level

Reset NO_ACT to O 1

Increment NO_ACT
counter

Yes

Mode =
SLEEP_SCAN
and enter sleep
scan

A\ 4

oop )

Start dimming LED

End of loop <
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Firmware Implementation Details
The firmware consists of three different modes: active scanning (ACTIVE_SCAN), sleep scanning
(SLEEP_SCAN), and proximity scanning (PROX_SCAN)
m Active Scanning: Active scanning primarily performs two tasks:

o Scans the touchpad

o Updates the color based on touchpad activity
Scanning the touchpad sensors along with the proximity sensor, if enabled, in turn performs two sub-
tasks:

0 Keeps the device in active scan mode

o Calculates the touch coordinate itself
Any activity on the touchpad or proximity sensor keeps the device in active scanning mode. If all
activity ceases, the firmware will fade off the RGB color displayed and enter sleep scanning mode.
The timeline at which the LED fades from last detected touch/proximity activity is defined by the

macro LED_DIM_THRESHOLD. The LED_DIM_RATE macro defines the rate at which LED dim-
ming is done. Refer to the main.h file for details on various macros used and their usage.

Figure 5-46 and Figure 5-47 show the two different color selection models implemented in the proj-
ect. The two options are selectable using DO_SATURATION macro defined in main.h.

Figure 5-46. Hue and Brightness Control Implementation Model (default model)
Brightness
Selection

Hue Selection

ﬂBn’ghtﬂess of the color increases

Figure 5-47. Hue, Saturation and Value (HSV) Implementation Model

Saturation
Selection

T(_‘olor changes towards white (Saturates)

Hue Selection -i Selected Hue is displayed as is

l‘uh‘:r changes towards Black (Value darkens)

Value
Selection
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Figure 5-48 through Figure 5-51 explain the process of generating the intensity levels for the RGB
LEDs. The color palette and the saturation slider are both part of the Trackpad area. The following
steps summarize the flow.

1. The Trackpad coordinates are obtained as shown in the mapping in Figure 5-48. Figure 5-49
shows various macro definitions used in the firmware (main.h) with respect to the Trackpad/color
palette area.

Figure 5-48. Trackpad Coordinate Selection

(X,Y)=> (0,0)

Y-Pos

(X, Y) = (120,100)

X-Pos
et

Figure 5-49. Macro Definitions Along X-Y Axis

BLUE_LIMIT_LEFT/ GREEN_LIMIT_RIGHT

-
4
]
=
E
=
=]
=)
o]
3

-
Py
|
]
=]
E
2
=]
z
]
o]
3
9

RED_LIMIT_LEFT/ BLUE_LIMIT_RIGHT

GREEN_AREA_CENTER
BLUE_AREA_CENTER
RED_AREA_CENTER

SLIDER_MIN / MAX_BRIGHTNESS position

Y-Pos

GREY_AREA_START SLIDER_MAX / MIN_BRIGHTNESS position

X-Pos
)

2. Intensity levels of the RGB colors, before applying saturation, are calculated as shown in
Figure 5-50. Along the X-Pos, the color palette is divided into six windows. In each window, one
color is at maximum brightness, one is at minimum brightness, and one moves from maximum to
minimum or vice versa. The macros shown in Figure 5-49 mark these window boundaries.
<color>_AREA CENTER marks the center of a <color> window on whose either side the <color>
will be at maximum intensity. <color>_LIMIT_LEFT/<color>_LIMIT_RIGHT macros mark the
edge of each <color>'s area inside which it is at maximum intensity.

Along Y-Pos, each color's intensity moves towards half-intensity level (50 percent) from the inten-
sity level selected along X-Pos (x percent). The color levels are first calculated along the X-Pos
using the window rule and X coordinate. The color thus obtained is then processed with the Y
coordinate.

SLIDER_START
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Figure 5-50. Intensity Calculation Based on X and Y in Color Palette

Colorvariation
along X-Pos

MAX_BRIGHTNESS =) ~——-"f==-==T"=""~ N R ——

MIN_BRIGHTMESS RED QUTPUT
MAX_BRIGHTNESS  |--—- i - - e
MIN_BRIGHTNESS GREEN OUTPUT
Color calculated =
MAX_BRIGHTNESS |-- i -f - o et c == = -
from X-Pos _BRIG
MIN_BRIGHTNESS BLUEOUTPUT

y=p €====== 3 === ———q----4

GREEN QUTPUT
BLUE OUTPUT

RED OUTPUT

Colorvariation
Along Y-Pos

¥_AXIS_BRIGHTMESS ==

W_AXIS_BRIGHTMESS =Tt oo oo

¥_AXIS_BRIGHTMESS |-

3. After the primary color intensities (from the color palette) are derived from step 2, either the
brightness level or the saturation level selected by the slider is applied. The selection between
brightness and saturation is done using DO_SATURATION macro defined in main.h.

a. Disabling/commenting out the DO_SATURATION macro applies brightness control on the
color. Brightness control is a simple scaling of the three color intensities, derived at step 2,
using slider output. Default brightness value at power on is 100% or maximum.

Example Projects

b. Enabling the DO_SATURATION macro applies saturation as explained in Figure 5-51. In sat-
uration control, if the slider output is at half value, the intensities are retained. If it is less than
half value, all the intensities move towards the minimum intensity (black/darker). If it is more

than half value, all the intensities move towards the maximum intensity (white/brighter).
Default saturation value at power ON is 50 percent or HALF_SATURATION value. The

amount by which each color darkens or brightens is proportional to the slider position's rela-

tive difference from its center. See Figure 5-51.
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Figure 5-51. Saturation Calculation Based on Slider Output

e prmmmm—— MAX_SATURATION
aefrmmm HALF_SATURATION

I P MIN_SATURATION

TOMIN_BRIGHTNESS |

HITE/ALLCOLOR | '
TOMAX_BRIGHTNESS

(XY} SELECTED COLOR  |--=-=-jo====nn
BLACK/ALL COLOR

m Sleep-Scan Mode

In the sleep-scan mode, the firmware scans either the proximity sensor or the gang sensor (sen-
sors in touchpad row elements ganged together) or both. This option is configurable during proj-
ect compilation by commenting out the ENABLE_PROXIMITY or ENABLE_GANG macros.
Keeping both will scan both the sensors in sleep, and disabling both will keep the device in active
scanning mode always.

a If a proximity sensor is used in sleep-scan mode and the device detects any proximity activity
on the sensor, the device will enter proximity scanning mode.

o If a gang sensor is used in sleep-scan mode and the device detects activity on the Trackpad
during its scan, the device enters active scanning mode directly.

The rate at which the device scans in the sleep-scan mode is configurable by changing the
macro SLEEP_TIMER_PERIOD defined in main.h.

m Proximity Scanning Mode:

In proximity scanning mode, the device primarily scans the proximity sensor, and the touchpad
sensors are scanned for activity. The previously selected RGB color is turned on with intensity
proportional to the proximity signal strength. The device enters active scanning mode when a
Trackpad element is touched. It stays in proximity scanning mode as long as there is some activ-
ity on the proximity sensor. If the hand moves out of proximity range, the device will return to
sleep-scan mode.

Output Interfaces

m Optional TX Interface

The firmware also features an optional UART TX interface, which can be enabled or disabled
based on need. To enable or disable the TX interface, uncomment or comment TX_ENABLE
macro present in main.h. The firmware also provides an option to select between two types of
packets that are transmitted over the TX line. One packet contains the raw count, baseline, and
signal data of all the sensors in the system in multichart format (refer to AN2397 for details on the
multichart charting tool). Another type of packet sends out just the Trackpad coordinates. To
select between these two types of packets, you can use the MINIMAL_TX macro. If the macro is
commented out, then the first type of packet is transmitted. If the macro is present, then the sec-
ond type of packet is sent.
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Note: To view the MINIMAL_TX data, you can use BCP (as explained in UART Data Viewing on
page 62) with CapSense Color Palette (Minimal TX) - Commands.iic and CapSense Color Pal-
ette (Minimal TX) - Variables.ini files available under . . .\Firmware\PSoC 4\Bridge Files
folder. AN2397's Multichart tool can be used to view the first type of packet because of the packet
size.

Software PrISM for LED Intensity Control

The firmware uses a software implemented 7-bit PRS for controlling the LED intensity through
Precision lllumination Signal Modulation (PrISM). The implementation uses the SysTick timer
available as part of Cortex-M0 CPU subsystem. The SysTick timer generates the interrupt where
the PRS computations are performed to generate the Pseudo Random signal at the output of the
LED pins. The implementation details can be found in RGB_PRSm.h and RGB_PRSm:.c files
available as part of the project. The polynomial used to generate the PRS is fixed to [7,6,5,2]. The
period or repeat rate of the PRS is 127 counts. With SysTick timer generating an ISR at 20 kHz,
this will result in a ~150 Hz output. Because the output is not a fixed pulse-width signal and is, a
high-frequency signal (with a maximum frequency of 10 kHz and average of around 5 kHz), the
signal easily gets filtered out avoiding any flickers usually noticed with PWM signals at this fre-
quency.

Hardware Connections

The example requires the CapSense Trackpad shield connection, as explained in Project:
CapSense Touchpad with 12C Tuner on page 68. The RGB LED and CMOD connections are hard-
wired on the board. Optionally, a proximity loop can be connected, as shown in setup 1 in
Figure 5-52. To use the firmware efficiently, the proximity loop can be formed as a loop around the
Trackpad, as shown in Figure 5-53. With setup 2, the LED turns on to show the previous color as the
hand approaches the Trackpad.

Note: For the proximity loop, the wire shipped with the kit (4 inches in length) can be wound to form
a loop of 1 to 2 inch diameter; the range obtained will be approximately the same as the loop diame-
ter for a fast approaching hand. To obtain a higher range, use a longer wire/bigger loop.
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Figure 5-52. Setup 1

Slider for selecting
Brightness/Saturation
level of the color

RGB LED for displaying the
color selected

TRACKPAD
SHIELD

Color palette for selecting

Proximity Loop for
color

controlling the brightness
of the color on hand
approach

Figure 5-53. Setup 2

Provide some gap between proximity wire
and shield board for improved range
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Brightness

g TRACKPAD o
m{)_’ SHIELD

— SR R WK

Wrap the proximity wire

Use the bumper .
around the color palette Connect wire to

hole for support proximity header(J5)
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Open CY8CKIT_040_Color_Palette.cydwr under the Source vertical tab in the Workspace
Explorer and select the suitable pin.

Table 5-13. Pin Connection’

Pin Name Port Name
Trackpad_XO0 PO _3
Trackpad_X1 PO_7
Trackpad_X2 PO _6
Trackpad_X3 PO_5
Trackpad_X4 PO O
Trackpad_X5 PO_1
Trackpad_YO P1 4
Trackpad_Y1 P15
Trackpad_Y2 P1 6
Trackpad_Y3 P1_0
Trackpad_Y4 P17
CMOD PO_4
Proximity P2_0
Red LED P3 2
Green LED P1_1
Blue LED PO_2
UART TX P3 02

1. Trackpad_XO0 (Touchpad0_Col0_TP) to Trackpad_X5 (Touchpad0_Col5_TP) maps to COL5 to
COLO of the Trackpad so as to make the Trackpad x-axis left aligned.
2. Selected in firmware (refer to main.h)
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Figure 5-54. Pin Selection for Color Palette Project

Alias Name Port Fin
Cmod YCapSense:Cmod PO[4] EXTCLE [+ ] = [+ ]
Touchpadd_Coll__TP “CapSense:Sns[0]% | PO[3] |4 -
Touchpadd Col1__TP “CapSense:Sns[11% | POLT] * |11 -
Touchpadd _ColZ2__ TP “CapSense:Sns[2]% | POLE] * |10 -
Touchpadd Col3__ TP “CapSense:Sns[3]% | PO[S] *|s -
Touchpadd Cold_ TP “CapSense:Sns[4]1% | POLO] |1 -
Touchpadl Col5__ TP “CapSense:Sns[5]% | PO[1] |z -
Touchpadd_Rowl TP “CapSense:Sns[&]% | P1[4] * | 18 -
Touchpadl_Rowl__TP “CapSense:Sns[71% | P1[5] * |17 -
Touchpadl_Row2_ TP wCapSense:5Sn=s[81% | P1[&] TCEWMO:N * |1z -
Touchpadd Rowd TP “CapSense:Sns[3]% | P1[0] * |12 -
Touchpad)_Rowd TP “CapSense:Sns[101% | P1[7] EXTCLE * |13 -
ProximitySenseorl)_0__PROX | \CapSense:Sns[11]1% | P2[0] * | zo hd
RGE_PRSm Blue BO[2] L -
RGE_PRSm Green P1l[1] TCEPWMO:B * |13 -
RGE_PRSm Red DB3[2] TCEWMO:B | z3 -

5.5.3 Verify Output

Build and program the code example onto the device. The default color for the RGB LEDs is blue.
Therefore, when you move over the proximity sensor before touching the Trackpad, the RGB LED
turns blue. Follow these steps to verify the code.

1. Touch the color palette on the Trackpad, as shown in Figure 5-55. The color touched will be dis-
played in the RGB LEDs.

Note: Because the LED is bigger (compared to pixels in displays and paper), the individual color/
LED may be visible at some points. An extra diffuser such as a thin paper can be placed on top of
the RGB LED, to see proper color mixing. In addition, the LEDs can exhibit different maximum
brightness levels depending on the maximum current that can flow through them and the maxi-
mum luminosity they can generate (brightness = current x luminosity-to-current-ratio). For
instance, red can be brighter than blue for a given series resistance, because of higher luminosity
to current ratio and lower voltage drop across them, which results in higher current. For such
cases, the brighter color's intensity can be limited to ensure proper mixing. An example for the
same is also presented in the example project by limiting the intensity of the red LED to ~85 per-
cent.

Note that when the brightness slider is set to minimum/zero brightness, touches on the color area
are not displayed on the LED.
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Figure 5-55. Color Palette Output in Active Scanning Mode

RGB LED Displaying User selecting the
the selected color color
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2. Move through the slider area provided at the right corner of the Trackpad to adjust the brightness
level of the color. Observe the color varying from Off to full brightness from one end to other.

Note: When moving from the color selection area to the slider area, remove your finger from the
Trackpad and place it back on the slider for it to work normally. This is implemented to prevent
accidental touches to the slider area when selecting color near the slider area.

3. Move away from the Trackpad and observe the color shown in the LED gradually ramp down
after 2-3 seconds and go off after approximately 5 seconds.

4. When the LEDs are off, moving your hand towards the proximity loop will slowly ramp up the
brightness of the LED as the hand enters the proximity range, and brightness will be at the maxi-
mum when it is near the Trackpad. The color on the LED will be the previously selected Trackpad
color, as shown in Figure 5-56.

Figure 5-56. Color Palette Output in Proximity Scanning Mode
RGB LED Displaying the
previously selected color
as the hand approaches
Proximity loop

Hand approaching
Proximity loop
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This section describes some of the advanced features available in the kit.

6.1 Using PSoC 5LP as a USB-I2C Bridge

The PSoC 5LP serves as a USB-I°C bridge, which can be used to communicate with the USB-I°C
software running on the PC.

Note: Section Project: CapSense Touchpad with 12C Tuner on page 68 also uses the USB-I2C
bridge available in the kit, but with the CapSense Tuner window.

The following steps describe how to use the USB-I°C bridge to communicate between the BCP and
the PSoC 4.

1. Create a new project targeting the PSoC 4 device in PSoC Creator, as shown in Figure 6-1.

Figure 6-1. Create a New Project in PSoC Creator

r Y
New Project M
| Design i| Other 4b
=] Empty Templates A
J Empty PSoC 3 Design Creates a PSoC 3, 8 bit, design project. X
[ 3 Emoty Psoc ¢ Desion Creates a PSoC 4. 32 bit. design project |
:I Empty PSoC 5LP Design Creates a PSoC 5LP, 32 bit, design project
[=] PSoC 3 Starter Designs
E, ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with no CPU intervention.
E DelSia 16Ch | Shows a 16-channel, 12-bit Delta Sigma ADC in PSoC 3 sequenced in hardware;
el s samples are transferred from ADC to SRAM using DMA - without processor intervention.
5] DelSig_I2CM E‘I:r.-rizéhe 16-bit differential ADC, hardware multiplexed into 8 channels and transported
5, DelSig_12CS 's“rlu;«.iz(t:he 16-bit differential ADC, hardware multiplexed into 8 channels and transported
Name: USB-12C
Location: C:\Users\msur\Documents\PSoC Creator\USB-2C E
[3 Advanced
Workspace: [Md to Cument Workspace ']
Workspace Name: CY8CKIT_040_CapSense_|2C
[ pevice cracaniaLaiez2 -|
Sheet Template: (Empty (11" x 8.5 -
Application Type [Nolrnd VJ

ok J[ concs |

CY8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 95



Advanced Topics

2. Drag and drop an I2C Component to the top design, as shown in Figure 6-2.

Figure 6-2. 12C Component in Component Catalog

Component Catalog (81 components) @

Search for... lﬁ LI.JJ @

Cyprﬁs] Off-Chip 4k
@ Cypress Component Catzlog

B Analog

B8 CapSense

-8 Communications

¢ Serial Communication Block (SCE) [v1.20]
-@ SMBus/PMBus Slave

- Digital
+--#a Display
t-%g Ports and Pins
-8 System

[ B B |

< [T | »

Open datashest
|2C Communication Interface (SCB mode)

12C_1
12C

Slhave

3. To configure the I2C Component, double-click or right-click the I2°C Component and select Con-
figure, as shown in Figure 6-3.

Figure 6-3. Open I°C Configuration Window

o

- & | Cut Ctrl+X
3 Copy Ctrl+C
e
X Delete Del
Select All Ctrl+A
Zoom r
Shape 3
| Configure... |

4. Configure the 1C with the settings and click OK, as shown in Figure 6-4 and Figure 6-5.
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Figure 6-4. I°C ‘Configuration’ Tab
[ confiqure 'scB_pa [ER)

MName: 12C_1

" Configuration [* 12C | Built-n 4 b

) Uncorfigured SCB
@ I2C
") EZIZC

o’he 5Pl and UART modes are not available for the selected device.

Comme [ ]

h

Figure 6-5. ‘I°C’ Tab

Configure 'SCB_P4" |2 [t

MName: 12C_1
Configuration " I2C |~ Built-n 1k
Mode: lSIave "]
Data rate (kbps): 100 - Actual data rate (kbps): 93.75
Owersampling factor: |16 = 8 : 8

[ Clock from teminal
Median fitker

Bt 7 6 5 4 3 2 1 0
Slave address (7-bits): k08 o (0 (D (1 |0 |0 |D |X

Slave address mash: xFE 1 (1 |1 1 |1 |1 (1 (0

[7] Accept matching address in RX FIFO
[T Enable wakeup from Sleep Mods

e | [0 [

5. Select pin P1[2] for the I12C SCL and pin P1[3] for the I°C SDA in the Pins tab of <project.cydwr>,
as shown in Figure 6-6.
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Figure 6-6. Pin Selection

s *USB-I2C.cydwr
o
- o g
2 35 3 . Alias Name ’ Port Pin
oo m =
£ oo o g ]
E [} (] E WI2ZC 1l:scl) | P1[2] SCBO:I2C:SCL |14
© ‘D‘ ‘m‘ 4I2C l:sda\ | P1[3] SCBO:I2C:SDR
E 3 H H & |-

XRES
P3
F3
P
P2

0] P1lg] | 18 | Tcrwmon
) ﬁ P | 17
e ; P[4 | 16 |
13 CY8C4014LQI-422 P1[3] | 15 | W2C_T:sda}

041 24-QFN P12 | 14 | u2Cc_1:sch

ZCQ P1[1] | 13 | TcPwmo.P

VDDIO_HIF
VS50

9 | PO

[ 10 | PO[E)

E FO[7]
E PI[0]

3.aw g

6. Place the code available in USB_/2C-main.c, which is attached to this PDF document, in your

main.c project file. This code enables the PSoC 4 device to transmit and receive 1°C data to and
from the BCP application.

7. Build the project by choosing Build > Build Project or pressing [Shift] [F6]. After the project is
built without errors and warnings, program ([Ctrl] [F5]) this code onto the PSoC 4 through the
PSoC 5LP programmer or MiniProg3.

Note: A warning may be displayed on the I2C input clock. This is because to generate a 100-kbps
I2C clock, the block needs a 1.6-MHz signal, which cannot be derived from the default HFCLK
setting of 12 MHz. To remove the warning, go to <project_name>.cydwr > Clocks and double-
click HFCLK. Set the IMO to 32 MHz and HFCLK divider to '2' in the window that appears (see

Figure 6-7). This generates a 16-MHz HFCLK; using a divider of 10, the 1.6-MHz clock required
for I2C block will be generated.
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Figure 6-7. Clock Settings in cydwr File

Configure System Clocks

ILO (32.000 kHz)

_ LA
I HFCLK

[ 10 (32.000 MHz)

Dvider: (1 ]
Divider: (2 ~] 16.000 MHz £2%

16.000 MHz 22% |

A

=
8. Open BCP from Start > All Programs > Cypress > Bridge Control Panel <version number>.
9. Connect to KitProg/ under Connected I2C/SPI/RX8 Ports, as shown in Figure 6-8.
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Figure 6-8. Connect to KitProg/ in BCP

ﬁ Bridge Control Panel
File Editor Chart Execute Tools Help
FEE SRR OE EBE

Editor | Chart |Table|ﬁe

4

Opening Port
Successfully Connected to KitProg/191607A0032C2400
KitProg Version 2.07

Protocol
@ 12C

| @Reset | [
[el5ce | fPRepeat

[ 1:1 [syntox: 0K [ | Connected | Powered  voltage: s032mv

10.Open Protocol Configuration from the Tools menu and select the appropriate I1>C Speed. Make
sure the 12C speed is the same as the one configured in the 12C Component. Click OK to close

the window, as shown in Figure 6-9.
Figure 6-9. Open Protocol Configuration Window in BCP
'ﬁ‘. Bridge Control Panel

File Editor Chart Execute | Tools | Help :
FEE ESRE| & Protocol Configuration F7

Edtor |Chat | Table | File 12C Bootloader F3

-

P

Protocol Configuration =)
[sp [T Rxa (UART)|

12C Speed
ot © awowe[o o]0 e
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11.To transfer data, type the command shown in Figure 6-10 and press [Enter] or click the Send
button in the BCP. The log shows whether the transaction was successful. A "+" indication after
each byte indicates that the transaction was successful and a "-" indicates that the transaction
was a failure, as shown in Figure 6-10 and Figure 6-11.

Figure 6-10. Enter Commands in BCP

!ﬂ; Bridge Control Panel =NREfl X

File Editor Chartt Execute Tools Help
FEE SR E EERE
Editor | Chart ITabIe File

wllos{|oo 01 02 03 MIIEI)J E
Generates Stop condition
on 12C bus

Data Bytes
Slave Address

(Vrite Data” Command i I

4 »

Opening Port | |

Successfully Connected to KitProg/0ODOF13CC01322400
KitProg Version 2.07

w oﬁT 00+ 01+ 02+ 03+ 04+ p

‘+’ Indicates Acknowledgement (ACK)

Fl

Connected 2C/5PI/RX8 Ports:

= Sendallstings: [ ey ficxocn
DReset | st Fsend comz @
Scan period, ms: 1= (-
[1:22 [ syntax: 0K [okc DCERREE ESHEEI voltage: 5061 my
—
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Figure 6-11. NACK Indication in BCP

s} Bridge Control Panel L =HCT m
File Editor Chart Fxecute Tools Help

FEEH SRR CE BEERE

Edtor | Chart | Table | File

w 07 00 01 02 03 04 -
4 ¥
Opening Port -
Successfully Connected to KitProg/0DOF13CC01322400

KitProg Version 2.07

w 08+ 00+ 01+ 02+ 03+ 04+ p

w 0 00- 01- 02- 03- 04- p

“ Indicates No Acknowledgment (NACK)
L] 13
Connected I2C/SP1/RX8 Ports 3 -
[ : . e Preloc
@Reset Fg::List ﬁSeﬂd :endal\slnngs (il ; 'DDOF13CCD1322400 © Ic
epeat court H |comaa
eat ofile

o S e, me: T c
[1:22 [synta:OK [ak CERREEE I ESHEE voltage: 061 my

12.From the BCP, read five bytes of data from the 1°C slave device with slave address 0x08, as
shown in Figure 6-12. The log shows whether the transaction was successful.

Figure 6-12. Read Data Bytes from the BCP

T Bridge Control Panel

=)

File  Editor Chart Execute Tools Help
FEE SRR SE EERE
Editor | Chart I Table | File

I‘lexxxxlq_l

Generates Stop condition
on 12C bus

No. of data bytes to read.
x - Reserved symbol, which means
that 1 byte of data should be read

Slave Address

“Read Data” Command

]

Opening Port

Successfully Connected to KitProg/0DOF13CC01322400
KitProg Version 2.07

w 08+ 00+ 01+ 02+ 03+ 04+ p

w 07- 00_ _01_ 02— 03 04— p

r 08+ |00+ 01+ 02+ 03+ 04+|p

Data bytes read from the slave device

1

Connected |2C/SPI/RX8 Ports:

= [ oy
BReset | Lt Fiseng | Sendalsings |} p,umﬂac::mzmu
Repeat count: 0

Scan period, ms: 0 (-

Protocol
@ 12c

| 1:17 | Syntax: OK |er _— Voltage: 5061 mV

S

Note: See Help Contents under Help in the BCP or press [F1] for details of the I°C commands.
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Using FM24W256 F-RAM

The PSoC 4000 Pioneer Kit has an onboard Ferroelectric RAM chip that can hold up to 32 KB of
data. Cypress F-RAM products combine the nonvolatile data storage capability of ROM with the ben-
efits of RAM, which include a high number of read and write cycles, high-speed read and write
cycles, and low power consumption. F-RAM core memory and integrated products are ideal for
applications that require high data integrity and ultra-low power consumption. These products target
markets in automotive, industrial, enabling technologies, and networking. F-RAM inherently features
high endurance, fast single-cycle, and symmetrical read/write speeds, along with low energy con-
sumption, gamma radiation tolerance, and immunity to electromagnetic noise.

The F-RAM chip provides an I2C communication interface for data access. It is hardwired to the
PSoC 4000 I°C lines (P1_2 and P1_3); the same lines are routed to the PSoC 5LP I2C lines as well.
Because the F-RAM device is an I°C slave, it can be accessed or shared among various 12C masters
on the same line. For more details on the F-RAM device, refer to the device datasheet.

This section describes a simple example on how to set the address of the F-RAM device, use it with
an 1°C master (PSoC 4000) device, and share the same RAM with the BCP through the PSoC 5LP
USB-I2C bridge.

Address Selection

The slave address of the F-RAM device consists of two parts, as shown in Figure 6-13: slave ID and
device select. Slave ID is an F-RAM family-specific ID located in the particular F-RAM device data-
sheet. For the device used in CY8CKIT-040 (FM24W256-G), the slave ID is 1010b. The device
select bits are set using the three physical pins A2-A0 in the device. The setting of these three pins
in CY8CKIT-040 is controlled by resistors R19/R18 (A0), R17/R16 (A1), and R15/R14 (A2). See
Cypress Ferroelectric RAM (F-RAM) on page 42 for details.

Figure 6-13. F-RAM I°C Address Byte Structure

Slave ID Device Select
Al AN
s AV A
| | | u | |  _
1 0 1 0 A2 A1 A0 RW
| ] | | I | I
7 6 5 4 3 2 1 0

Write/Read Operation

The device's datasheet includes details on how to perform a write/read operation with the F-RAM.
Figure 6-14 and Figure 6-15 provide a snapshot of the write/read packet structure as a quick refer-
ence.
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Figure 6-14. F-RAM Single/Multiple-Byte Write Packet Structure
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B "\ Start Address & Data Stop
v Master l ¢ ¢
' FT T TTT T T T TTT T T T TTT T T 1T TTT
5 Slave Address 0| A [ X  Address MSE A dress LSB A Data Byte AlP
I N I I N
By FM24\W/256 * * *
:: .-\" Acknowledge
Single Byte Write
Start st
By Master l Address & Data ¢ IP
FrTrrTTT T T T TTT [ [ i L T 1T TTT T TT * I TT
‘ 5 Slave Address 0| A | X Address MSE A Address LSB & Data Byte A Data Byte AP ‘
I T | I Y | | | [ I Y I Y I
i\
By FM24\w/256 ) f *
E— Acknowledge
Multiple Byvte Write
Figure 6-15. F-RAM Single/Multiple-Byte Read Packet Structure
No
By Master \ Start Address Acknowledge
FTT T T TT T T 7T : o
5 Slave Address 1| A Data Byte 1P
I I I |
N
By FM%WEES} Acknowledge Data
¥
Current Address Read
No
::By Master :: Start Address Acknowledge Acknowledge
l ¢ — Stop
T T 1T T T T TTTTTT T T T T T
S Slave Address 1| A Data Byte A Data Byte 1P
I O Y T I T I I
N
By FM24\W256 )
¥ Acknowledge Data
Sequential Read
l\ Stant No
By Master l Address ) Start Address Acknowledge
Stop
l T T 1T TTT T T T TTT IIII'III III'III IIIIII"_
5 Slave Address 0| & [X  Address M5B A Address LSB AlS Slave Address 1| A& Datz Byte 1|P
I I I N [ ||
5 f
By FM24W256 ) Data
— Acknowledge

Selective (Random) Read

In the previous figures, "Slave Address" denotes the address of the F-RAM slave device. [Address
MSB: Address LSB] forms the 16-bit address of the memory location in the F-RAM to be accessed
for read/write operation. The first two bytes following the slave address byte during a write operation
constitute the initial memory address to be accessed. From there on, each byte accessed (read/
write) will increment this address by one and the count wraps around at the boundary (Ox7FFF to
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0x0000 for a 32 KB device). The value can be reset at any time by doing a write operation with the

desired memory address.

Example Firmware

The following steps describe how to create a project with the PSoC 4000 family that uses the
onboard F-RAM and shares it with another 12C master (BCP through PSoC 5LP USB-I2C bridge).

1. Open PSoC Creator 3.0 SP1 and create a new PSoC 4000 project, as shown in Figure 6-16.

Figure 6-16. Create a New PSoC 4000 Project in PSoC Creator

[ N
MNew Project m
I. " Design I Other 4 b
[=] Empty Templates >

] Empty PSoC 3 Design Creates a PSoC 3. 8 bit. design project. ‘

| Empty PSoC 4 Desig : oC 4, , design project
:| Empty PSoC 5LP Design Creates a PSoC 5LP, 32 bit, design project. i
(=] PSoC 3 Starter Designs

Pa] ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with no CPU intervention.

E DelSic 16Ch | Shows a 16-channel, 12-bit Delta Sigma ADC in PSoC 3 sequenced in hardware; samples are
o i transferred from ADC to SRAM using DMA - without processor intervention.

E DelSig_I2CM gghs the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
Pa] DelSig_I2CS ggws the 16-bit differential ADC. hardware multiplexed into 8 channels and transported over i
Name: FRAM_Example
Location: C:\Users\msur\Documents\PSoC Creator E]
(=) Advanced
Workspace: [Cmae New Workspace ']
Workspace Name: FRAM_BExample
[ Device: [crecaniaLal422 -l
Sheet Template: | Empty (11" x 85") 7]
Application Type (Nomal

o J o ]

. From the Components Catalog, place an I1>C (SCB mode) Component in the TopDesign from

Communication > I2C > I2C (SCB mode) [<version>] and configure it as |1°C in the Configura-
tion tab with the parameters shown in Figure 6-17.
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Figure 6-17. 12C Master Configuration

o N
Configure 'SCB_P4 B
Name: 12C_M
Configuration ** I2C | Built-in 4k
Mode: [ Multi-Master A
Data rate (kbps): 0 - Actual data rate fbps): 53.75

Owersampling factor: |16 = Low: |8 = High: |8 =
[ Clock from terminal
Median fiter

e | o] o

3. Select Pins 1[2] and 1[3] as the I2C pins in the Pins tab of the .cydwr file, as shown in
Figure 6-18.

Figure 6-18. Pin Selection

Alias Name Port Fin L
WIZC M:iselh | P1[2] SCEO:IZC:SCL * |14 - |
WIZC M:sda\ | P1[3] SCEOQ:IZC:SDA * | 15 b |

4. Place the code available in Example FRAM-main.c, which is attached to this PDF document, in
the main.c file.

5. Build the project by choosing Build > Build Project or pressing [Shift] F6]. After the project
builds without any errors and warnings, program the device by pressing [Ctrl] F5] through the
MiniProg3 or PSoC 5LP programmer in the kit.

Note: A warning may appear on the I2C input clock. This is because to generate a 100-kbps 12C
clock, the block needs a 1.6-MHz signal, which cannot be derived from the default HFCLK setting
of 12 MHz. To remove the warning, go to <project_name>.cydwr > Clocks and then double-click
HFCLK. Set the IMO to 32 MHz and HFCLK divider to '2' in the window that appears (see
Figure 6-7). This generates a 16-MHz HFCLK; using a divider of 10, the 1.6-MHz clock required
for I2C block will be generated.

6. Open BCP and configure the I2C protocol as defined in Using PSoC 5LP as a USB-12C Bridge on
page 95.
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7. In the command window, copy and paste the code from the F-RAM_BCP_Commands.txt file
attached to this document.

8. By default the F-RAM device is configured with a 0x50 slave address. If the value has been
changed as explained in Address Selection on page 103, then change the slave address in the
command window (replace "50" with the slave address in hex format).

9. Do a write to the F-RAM device by sending the 'W 50 00 00 01 02' line, which writes to memory
location 0x0000 with the value 0x01 and memory location 0x0001 with 0x02. The command sent
should be ACKed properly by the slave to make sure the transfer occurred properly, as shown
Figure 6-19.

Figure 6-19. Send/Write Data to F-RAM

% Bridge Control Panel (=)

File Editor Chart Execute Tools Help
g SR E EEER
Edeor | Chan | Table [ Fie |

9 TR DATA BYTE N

e e F-RAM Data Read format---———————————————-
w SLAVE ADDR MEMORY ADDR MSE MEMORY ADDR LSB r SLAVE ADDR DATA BYTE 0
; DATA BYTE 1 .....

w 50 00 00 r 50 x x

Opening Port
Successfully Connected to KitProg/191607A0032C2400

|w 50+ 00+ 00+ 01+ 02+ pI

‘Connected 12C/SPI/RX8 Ports:

= Send sl tings: 7] Power Protocol
(@reset | fit | Fera | Repe::::s o1 |CoM3 l@ ® ic
Nro fil 3 ~1| |comM2
R 7o file
e Juepens|ohones] 0 ——2 a
| 6:17 |Synrax:0K |ok _— Voltage: 5034 mvV

10.1f the write transfer is successful, then check back the data using a read command to the same
address by sending the second command line, as shown in Figure 6-20. The read command on
the same locations will yield a '0" at 0x0000 (flag cleared) and OxFD at 0x0001 (inverse of 0x02
sent). This shows that the PSoC 4 onboard accessed the bytes and modified them. On writing
any byte to 0x0001, as explained in step 9, the inverse of the same will be calculated and stored
back at the same location by PSoC 4 if the 0x0000 byte is set to '1'.
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Figure 6-20. Read Data From F-RAM

W Bridge Control Panel nfulE)

File Editor Chart Execute Tools Help
FER AR QEEEE
Edtor [Chant_| Table | Fle |

ata write format—---—----—-—————-————-
; w SLAVE ADDR MEMORY ADDR MSB MEMORY ADDR LSB DATA_EYTE_O DATA_EYTE_i
7 DATA BYTE N

w SLAVE ADDR MEMORY ADDR M.
; DATA BYTE 1 .....

MEMORY ADDR LSB r SLAVE ADDR DATA BYTE 0

Opening Port

Successfully Connected to KitProg/191607A0032C2400
KitProg Version 2.07

w_50+ 00+ 00+ 01+ 02+ p

w 50+ 00+ 00+ r 50+ 00+ FD+ p |

Connected 12C/SPI/RX8 Ports:

I Power Protocol
= Send all strings: [
(@Reset | ftst | Psend e CoM3 ‘ -dbs

- 3 0}
B (B | o | oot [ 0% s
Scan period. ms: 0[5 L

15:20 | Syntax: OK ok Voltage: 5032 mV
[ E [ | Connected  Powered

S

6.3 Using PSoC 5LP as a USB-UART Bridge

The PSoC 5LP serves as a USB-UART bridge, which can communicate with the COM terminal soft-
ware. This section explains how to use the PSoC 5LP's USB-UART bridge with an external device/
board (PSoC 4200 with CY8CKIT-001) with an example.

Note: This project explains how to use the USB-UART bridge of PSoC 5 LP for external UART lines.
Project: CapSense Proximity and UART on page 52 can be used as reference for using the USB-
UART bridge with the PSoC 4000 family featured on the board. The PSoC 4000 family supports only
a software UART transmit line, which is explained in Project: CapSense Proximity and UART on
page 52.

Users who have a Windows operating system that does not have HyperTerminal can use an alterna-
tive terminal software such as PuTTY.

1. Create a new PSoC 4 project in PSoC Creator, as shown in Figure 6-21. Select an appropriate
location for your project and rename it as required.
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Figure 6-21. Create a New Project From PSoC Creator

.
New Project | 9 o
/ Design [  Other ] 4P
=] Empty Templates o

[] Empty PSoC 3 Design Creates a PSoC 3, 8 bit, design project.
D Empty PSoC 5LP Design Creates a PSoC 5LP, 32 bit, design project.
] PSoC 3 Starter Designs B
E ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with no CPU intervention.
f . Shows a 16-channel, 12-bit Delta Sigma ADC in PSoC 3 sequenced in hardware; samples are
EI DelSig_16Channel transferred from ADC to SRAM using DMA - without processor intervention.
EI DelSig_{2CM ISZhé:ws the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
E DelSig_12CS i?;hcows the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
E DelSig_SFIM g::lf‘WS the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
[« '™ ta Bl 1 H S all io kb s - sl M ibo DIRA ook dode £ =
Name: USB-UART
Location: C:\Users\msur\Documents\PSoC Creator E]
=) Advanced
Workspace: Create New Workspace z)
Workspace Name: USB-UART
Device: (CYBC4245AXI-483 - (Defaul PSoC 4 Device) v
Sheet Template: (Empty (11"x 8.5") =)
Application Type [ Nomnal v
[ ok || Concd |

2. Drag and drop a UART (SCB) component from the Component Catalog shown in Figure 6-22 to
the top design.
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Figure 6-22. UART Component Under Component Catalog

Component Catalog (142 components) @
Search for... % LHJ )

Cypress ] Off-Chip qd b
@ Cypress Component Catalog
B8 Analog

8§ CapSense

Ehﬁ Communications

g 12C

S [¢] Serial Communication Block (SCE) [v1.20]
8 SMBus/PMBus Slave
[¢] Software Transmit UART [w1.20]

@] LIART (SCB = lv12(l -

ap UART V23U

g Digital

B Display

[#-%§ Ports and Fins

GH@g System

g Thermal Management

Open datashest
Universal Asynchronous Receiver Transmitter (SCB
mode)

UART 1
UART

Tiandard

3. To configure the UART, double-click or right-click the UART Component and select Configure, as
shown in Figure 6-23.

Figure 6-23. Open UART Configuration Tab

Ctrl+X
Copy Ctrl+C
Delete Del
Select All Chrl+A
Zoom 3
Shape 3
Configure...

5" Open Datasheet ..

4. Configure the UART as shown in Figure 6-24, Figure 6-25, and Figure 6-26 and then click OK.
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Figure 6-24. ‘Configuration’ Tab
[ Configure 'scB_Pa (B S |

Name: UART

Configuration | UART Basic | UART Advanced | Builtin | 4b
) Uncorfigured SCB
o 12c
@ Ezc
@ SPI
@ UART

Datashest | OK || sy || Cancel

Figure 6-25. ‘UART Basic’ Tab
[ configure 'scB_pa [EPR)

Name: UART

Conﬁgurah’on)/ UART Basic I/UART Advanced }/Euilt-in ] 1B
-

Mode:
Direction:
Baud rate (bps): EEN - Actualbaud rate bps): 117647 i
Data bits:
Faty -

Stop bits: 1 bit hd N

m

Cversampling: 12 =
[] Clock from terminal
] Median fiter il

Ce=Jlm L=
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Figure 6-26. ‘UART Advanced’ Tab

Advanced Topics

-
Configure 'SCB_P4'

Name: UART

Configuration | UART Basic,”~ UART Advanced | Builtin | q b
Buffer sizes Intemupt
RX buffersize: B = Mone
TAbuffer size: |8 EI © intemal
) Exdemal M
Intemupt sources :
[] UART done [ BX FIFC not empty |
[] TX FIFO et full [ RX FIFO ful :
[ T FIFO empty [ R¥ FIFQ overflow :
[] T* FIFO overflow [ RX FIFC underflow |
[] T* FIFO undedflow [] RXframe emor |
[ T lost arbitration [ R¥ parity emor
[] T% NACK [] RX FIFO trigger:
[ TX FIFO trigger-
[] Muttiprocessor mode RX FIFO drop
Address (hex): ] On parity emor
1 Mask (hex): [ On frame emor I
I [] Accept matching address in RX FIFO I

5. Select P4[0] for UART RX and P4[1] for UART TX in the Pins tab of <Project Name>.cydwr, as

shown in Figure 6-27.

Figure 6-27. Pin Selection

RT.cydwr 4Pk x
I I B Nizs  Name Port Pin  Lock
all =
E ) D4[0] SCBO-IZC:5CL, SCBO:SPI-MOSI =
= B | \UM‘T'D‘\| SCBO:UART:RX i) 20 T
——————— o
““““ g . P4[1] SCBO:IZC:SDA, SCBO:SPI:MISO =
VBRT -0\ | oopn yaRT-TX ! | 2% M

SCRILATTL

SCRALRTRI

CYBC4245AX1-483
44-TQFP

6. Place the code available in USB_UART-main.c, which is attached to this PDF document, in your
main.c project file. The code will echo any UART data received.

7. Build the project by choosing Build > Build

{Project Name} or pressing [Shift] [F6]. After the

project is built without errors and warnings, program (by choosing Debug > Program) the project

to PSoC 4 through MiniProg3.

Figure 6-28 and Figure 6-29.
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Notes:

m Before connecting the RX line, remove R57 connecting P3[0] of the PSoC 4000 device to the
PSoC 5LP RX line. This makes sure the PSoC 4000 device can be programmed/debugged while
using the RX line for external bridge.

m The setup with CY8CKIT-001, CT8CKIT-038, and CY8CKIT-040 is provided for reference only on
how to use the USB-UART bridge for connecting to an external UART interface.

Figure 6-28. UART Connection Between PSoC 4 and PSoC 5LP

CY8CKIT-040 CY8CKIT-038 CY8CKIT-001

V94 X949, 204V )d . 004
EFECTE)

Connections Between
PSoC 4200 & PSoC 5LP
UART bridge

Figure 6-29. Block Diagram of UART Connection Between PSoC 4 and PSoC 5LP

CY8CKIT-040 External PSoC
4200 Board
foom )
[ GND i |
| |
| |
|
| J8_9 (RX) P4[1] (TX)
D+ PSoC (Pi2LRx | B PSoC
usB D- SLP P12[7), TX 18 :18 10 (TX) l: P4[0] (RX] 4200
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Note: UART RX and UART TX can be routed to any digital pin on PSoC 4 based on the configura-
tion of the UART Component. An SCB implementation of the UART will route the RX and TX pins to
either one of the following subsets: (PO[4], PO[5]) or (P3[0],P3[1]) or (P4[0],P4[1]).

To communicate with the PSoC 4 from the terminal software, follow this procedure:

1. Connect USB Mini-B to J10. The kit enumerates as a KitProg USB-UART and is available in the
Device Manager, under Ports (COM & LPT). A communication port is assigned to the KitProg
USB-UART, as shown in Figure 6-30.

Figure 6-30. KitProg USB-UART in Device Manager

- ™
i Device Manager EM

File Action View Help
as M E HE & B RS

4 = LAPWIN7-MSUR -
al Batteries
> -€) Bluetooth Radios
. M Computer
> g Disk drives
. B, Display adapters
> &) DVD/CD-ROM drives
. «'3;3 Human Interface Devices
> € IDE ATA/ATAPI controllers
- 55 Imaging devices
> £ Keyboards
.- Mice and other pointing devices
» & Monitors
4 -&¥ Network adapters
- g l.:" Bluetooth Device (Personal Area Network) 23
-..&¥ Bluetooth Device (RFCOMM Protocol TDI) #3
.3, Cisco Systems VPN Adapter for 64-bit Windows
... Intel(R) 82579LM Gigabit Network Connection
&¥ Intel(R) Centrino(R) Advanced-N 6205
.8 Microsoft Virtual WiFi Miniport Adapter
' Nokia USB Device
. I Portable Devices
477 Ports (COM & LPT)
'? Intel(R) Active Management Technology - SOL (COM3)
|7 KitProg USB-UART (COM12) |
5 "7 MediaTek PreLoader USB VCOM (Android) (COM29)
. 2} Processors
- [P Security Devices
. 48& SM Driver -

m

2. Open HyperTerminal, choose File > New Connection, enter a name for the new connection, and
click OK, as shown in Figure 6-31.
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Figure 6-31. Open New Connection HyperTerminal

Connection Description

=)

New Connection

Enter a name and choose an icon for the connection:

MName:

USB-UART communication|

lcon:

4 I

Lok ]

Advanced Topics

3. For PuTTY, double-click the PuTTY icon and select Serial under Connection, as shown in

Figure 6-32.

Figure 6-32. Open New Connection in PuTTY

-
PuTTY Configuration

Category:

(=)~ Session
| Logging
= Teminal
Keyboard
Bell
i Features
= Window
i Appearance
Behaviour
Translation
Selection
i Colours
=)- Connection
- Data
- Proxy
- Telnet
- Rlogin
#-SSH

Options controlling local serial lines

Select a serial line
Sedal line to connect to
Configure the senal line
Speed (baud)

Data bits

Stop bits

Parity

How control

8
1

4. A new window opens, where you can select the communication port, as shown in Figure 6-33.

a. In HyperTerminal, select COMx (or the specific communication port that is assigned to the Kit-
Prog USB-UART) in Connect using and click OK. This code example uses COM12.
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b. In PuTTY, enter COMx in Serial line to connect to. This code example uses COM12.

Figure 6-33. Select Communication Port - HyperTerminal and PuTTY

Connect To [ & ﬁ]

USB-UART communication

Enter details for the phone number that you want to dial:

Country/region: India (31) -

Area code: 080

Phone number:

Connectusing: ’COM]Z v]

| ok || cancel |

S

@ PuTTY Configuration &J

Category:

[fJ--S_ession Options controlling local serial lines
L‘ij--'l'.;rl;r?iig:ng Select a serial line
- Keyboard Serial line to connectto COoM12
- Bell
- Features Configure the serial line
=-Window

- Appearance
-~ Behawviour Data bits 8
-- Translation
- Selection Stop bits 1
--Colours
[=]-Connection
--Data

- Proxy

-- Telnet
- Rlogin
fH-35H

- Serial

Speed (baud) 9600

Parity lNone v]

Elow control | XON/XOFF v

ro— e

h

5. In HyperTerminal, select Bits per second, Data bits, Parity, Stop bits, and Flow control under
Port Settings and click OK, as shown in Figure 6-34. Make sure that the settings are identical to
the UART settings configured for PSoC 4.

In PUTTY, select Speed (baud), Data bits, Stop bits, Parity, and Flow control under Configure
the serial line shown in Figure 6-33 (second image). Click Session and select Serial under
Connection type, as shown in Figure 6-35. Serial line shows the communication port (COM12),
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and Speed shows the baud rate selected. Click Open to start the communication.

Figure 6-34. Configure Communication Port in HyperTerminal

COM12 Properties @
Port Settings ||
Bits per second: l 9600 v
Data bits: |8 v/
Parity: "None v/
Stop bits: \ 1 v
Flow control: {Xon # Xoff v
Restore Defaults
1 0K | [ Cancel J [ Apply ]

Figure 6-35. Select Communication Type in PuTTY
r PuTTY Configuration ﬂ

Category:

|

|H Session |
| Logging
[=1- Terminal
Keyboard
Bell
| Features
=- Window
. Appearance
Behaviour
- Translation
- Selection
. t-Colours
- Connection
- Data
- Proxy
- Telnet
- Rlogin
- SSH

Basic options for your PuTTY session

Specify the destination you want to connect to

Serial line
COM12
Connection type:

|

©Raw () Ielnet ©) Riogin ©) SSH | @ Segal

Load, save or delete a stored session
Saved Sessions

Default Settings

10

Close window on exit:
() Mways () Never (@ Only on clean exit

[ open [ Cancel

)

6. Enable Echo typed characters locally under File > Properties > Settings > ASCII Setup to
display the typed characters in HyperTerminal, as shown in Figure 6-36. In PuTTY, enable Force
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on under Terminal > Line discipline options to display the typed characters in PuTTY, as

shown in Figure 6-37.

Figure 6-36. Enable Echo of Typed Characters in HyperTerminal

ASCII Setup

]

ASCIl Sending

D Send line ends with line feeds

;

Line delay: 0

Character delay: 0

ASCIl Receiving

milliseconds.

milliseconds.

["] Append line feeds to incoming line ends
[] Foree incoming data to 7-bit ASCII
Wrap lines that exceed terminal width

oK

| | cancel

Figure 6-37. Enable Echo of Typed Characters in PuTTY

ﬂ PuTTY Configuration

Category:
@--Session Options controlling the terminal emulation
- Logging : z :
= Teminal Setvarious terminal options
- Keyboard [] Auto wrap mode initially on
- Bell [ DEC Origin Mode initially on
- Features [ ]Implicit CR in every LF
=-Window ) .
[ JImplicit LE in every CR
- Appearance
 Hehavielr |Z| Use background colour to erase screen
-- Translation ["|Enable blinking text
-~ Selection Answerbackto “E:
CoIOL_Jrs PUTTY
=-Connection
i Line discipline options
- Proxy
. Telnet |=_0cal echo: )
- Rlogin ) Auto (") Force off
F-SSH Localline editing: .
- Serial @) Auto " )Force on ") Force oft
Remote-controlled printing
Erinter to send ANSI printer output to:
MNone (printing disabled)
Qo] [ Gore

ke

¥

7. The COM terminal software displays both the typed data and the echoed data from the PSoC 4
UART, as shown in Figure 6-38 and Figure 6-39.
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Figure 6-38. Data Displayed on HyperTerminal

B USB-UART communication - HyperTerminal ] _ﬁ:ﬂ_

File Edit Yiew Call Transfer Help
D & 2 D

CYBCKIT-040 USB-UART  PPSSeoCC_

Connected (D036 Auta detect 9600 B-MN-1 ML

Figure 6-39. Data Displayed on PuTTY
[ comiz - putty ET)

=

6.4 Developing Applications for PSoC 5LP

The PSoC 4000 Pioneer Kit has an onboard PSoC 5LP whose primary function is that of a program-
mer and a bridge. You can build either a normal project or a bootloadable project using the

PSoC 5LP.

The PSoC 5LP connections on the board are summarized in Figure 6-40. J8 is the 1/O connector
(see A.2.2 PSoC 5LP GPIO Header (J8)). The USB (J10) is connected and used as the PC inter-
face. However, you can still use this USB connection to create customized USB designs.
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The programming header (J7) is meant for standalone programming. This header needs to be popu-
lated. See the "No Load Components" section in A.6 Bill of Materials.

Figure 6-40. PSoC 5LP Block Diagram

D+ P15 6
Mini USB (J10) |,
P15 7
10-pin SWD SWDIO oo PSoC 5LP

programming SWBCLK [y,

and debugging —*° P13

header ;ﬁ'Es P14

(JT) XRES

P12 POO PO_1 P34 P35 P36 P37 P12.6 P12.7 P3O

Js 2
J8 3
Js 4
PSOC5LP ==
I/O Header j:—j
(J8) J8:8
J8 9
J8_10
Js 12

6.4.1 Building a Bootloadable Project for PSoC 5LP

All bootloadable applications developed for the PSoC 5LP should be based on the bootloader hex
file, which is programmed onto the kit. The bootloader hex file is available in the kit files or can be
downloaded from the kit web page.

The hex files are included in the following kit installer directory, as illustrated in Figure 6-41:

<Install Directory>\CY8CKIT-040 PSoC 4000 Pioneer Kit\<version>\Firm-
ware\Programmer\KitProg Bootloader

Figure 6-41. KitProg Bootloader Hex File Location

P

==
@le <« 10 » Firmware » Programmer » KitProg_Bootloader v|¢'-,|| Search KitP... O
Organize ¥ Include in library Share with Burn New folder =+ [0 @
e
 Favories = Name Date modified Type
Bl Desktop 2 || KitProg_Bootloader.elf 2/21/20 M ELF File
4@ Downloads 7] KitProg_Bootloader.hex PM HEX File I
= Recent Places
& SkyDrive
4 Libraries
¢| Documents
@' Music e m -
2 items
f
LS
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To build a bootloadable application for the PSoC 5LP, follow this procedure:

1. In PSoC Creator, choose New > Project > PSoC 5LP; click the expand button adjacent to
Advanced and select the Device as CY8C5868LTI-LP039, as shown in Figure 6-42. Select the
Application Type as Bootloadable from the drop-down list.

Figure 6-42. Create a New Project in PSoC Creator

-
New Project =)
" Design | Other | 4b
= Empty Templates -
: Empty PSoC 3 Design Creates a PSoC 3, 8 bit, design project.

j Empty PSoC 4 Design

Creates a PSoC 4, 32 bit, design project.

m

[=) PSoC 3 Starter Designs

El ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with no CPU intervention.

. Shows a 16-channel, 12-bit Delta Sigma ADC in PSoC 3 sequenced in hardware; samples are —
EI DelSig_16Channel transferred from ADC to SRAM using DMA - without processor intervention.

. Shows the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
Pal DelSig_l2cM e

A Shows the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
Pa] Delsig_l2cs e
El DelSig_SPIM Shows the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over

= SPI.
s Shows how to filter an analog input all in hardware, and provides all the DMA setup to transfer the

Ba Filter_ADC_VDAC data from the ADC directly to the Digital Filter Block. bypassing the processor.
EI Hw_Fan_Control_with_Alert Shows how performing fan control in hardware completely frees up the CPU.

= PSoC 4 Starter Designs

Name: Design19
Location: C:\Users\msur\Documents\PSoC Creator E‘
(=) Advanced
Workspace: [Create New Workspace )
Workspace Name: Design13
| Device: cyecseseLTILP039 -
Sheet Template: (Empty (11"x 857) -
IAppﬁcaion Type [Bootioadable - }I

o J[ oo |

2. Navigate to the schematic view and drag and drop a Bootloadable Component on the
TopDesign.
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Figure 6-43. Bootloadable Component in Component Catalog

Component Catalog (201 components)

Search for iy @M B

E “Cypress | Off-Chip

&84 Analog

44 CapSense

#-88 Communications
@9 Digital

& &g Display

#1169 Filters

@4 Ports and Pins
#1468 Power Supervision
(é} @9 System

i-[¢] Bootloader [v1.20)
¢] Clock [v2.20]

¢] DMA1.70]
--[¢] EEPROM [+2.10]

+--|¢| Boost Converter [v5.0
°

Cypress Component Catalog

.- ©] Die Temperature [v2.0]

¢| Emulated EEPROM [v1.101

1]

Open datasheet

Provides bootloadable application functionality.

Inst_N

Bootloadable

Figure 6-44. Configuration Window of Bootloadable Component

Advanced Topics

Set the dependency of the Bootloadable Component by selecting the Dependencies tab in the

configuration window and clicking the Browse button, as shown in Figure 6-44. Select the
KitProg Bootloader.hex and KitProg Bootloader.elf files; click Open, as shown in Figure 6-45

and Figure 6-46 and then click OK on the Configuration window.

-

Configure 'Bootloadable’

=)

MName: Bootloadable_1

~elf, “out, .24, or other.

Bootloader HEX file:

Bootloader ELF file:

General)/DependencB ]/Built—in ]

Bootloadable projects require a reference to the associated Bootloader project’s HEX and ELF
files. The HEX files extension is * hex. The ELFfiles extension depends on IDE and can be

Browse...

Browse...

Apply

Cancel
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Figure 6-45. Select KitProg Bootloader Hex File

Advanced Topics

Select a Bootloader Hex File

et

@'Ovh « Firmware » Programmer » KitProg_Bootloader

- | +y | | Search KitProg_Bootloa.. B |

Organize ~ New folder = ~ Q-
BB Desktop “  Name Date modified  Type
4 Downloads = - =
s KitProg_Bootloader.hex 3/18/2013 6:38... HEXFile
+¢ Dropbox

«» Recent Places

- Libraries

1

. Documents
4. Music

. Pictures
%. Videos

‘& Computer
& Windows7_OS (C

@ Lenovo_Recovery ~ « |

1 | »

File name: KitProg_Bootloader.hex

~ | HexFiles (*hex)

)

o [ o

[ Open

Figure 6-46. Select KitProg Bootloader EIf File

Select a Bootloader Hex File

S5

m

= Recent Places

|| - Libraries

@ Documents
] J’ Music

| [ Pictures

1% Computer
| &, Local Disk (C:)

@uv| .« Firmware » Pregrammer » KitProg_Bootloader - | ‘7” Search KitProg_Bootloader }Jl
Organize = MNew folder = » [ @
X F : Bt Marme Date modified Type
w Favorites =
[ 4} Desktop | KitProg_Bootloader.elf 4/18/2013 1:07 AM ELF File
4 Downloads

1 CY8C5S8 Family Processo = 4

L

File name:

F
- [EIf Files (“elf, axf, .out) -

J |

e

Cancel' Lﬂ
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4. Develop your custom project.

5. The NVL setting of the Bootloadable project and the KitProg_Bootloader project must be the

same. Figure 6-47 shows the KitProg Bootloader.cydwr system settings.

Figure 6-47. KitProg Bootloader System Settings

Option

Device Configuration Mode

Advanced Topics

Value

Compressed

Enable Error Correcting Code (ECC)

Store Configuration Data in ECC Memory

Instruction Cache Enabled

Enable Fast MO During Startup

EEODE

Unused Bonded IO

Allow with info

Heap Size (bytes)

01000

Stack Size (bytes)

04000

Include CMSIS Core Peripheral Library Files

E}- Pregramming\Debuaging

Debug Select

GPIO

Enable Device Protection

Embedded Trace (ETH)

Use Optional XRES

O@E

£}~ Operating Conditions

Viddd (V)

50

Vidda (V)

50

Variable Vidda

ViddioD (V)

50

Vddiol (V)

50

Viddio? (V)

50

Vidio3 (V)

50

Temperature Range

-40C - 85/125C

. Pins |\ Analog | (&) Clodks | # Interrupts | 15 DMA . [B% System [ K| Directives | (4] Flash Security | |2 EEPROM |

q4b

6. Build the project in PSoC Creator by choosing Build > Build Project or pressing [Shift] [F6].

7. To download the project onto the PSoC 5LP device, open the Bootloader Host tool, which is
available from PSoC Creator. Choose Tools > Bootloader Host, as shown in Figure 6-48.

Figure 6-48. Open Bootloader Host Tool from PSoC Creator

[ Bootloadable - PSoC Creator 3.0 [Ci\.\Bootloadable\Bootloadable.cydsn\TopDesign\TopDesign.cy

File Edit View Project Build Debug

Tools | Window Help

SfNassHdads ] ¥ E @ Install drivers for pVision »
a2 __‘3_ o 5 [\ ar Datapath Config Tool... u l[= _E"
Z > W U [=|=
wOrkspace Em]mf DMA Wizard... Dess I
& 3 |%] Bootloader Host...
& Workspace Bootloadable’ (1 Projects) ey

= 3] Project ‘Bootloadable’ [CYBC5868L

TS

8. In the Bootloader Host tool, click Filters and add a filter to identify the USB device. Set VID as

0x04B4, PID as 0xF13B, and click OK, as shown in Figure 6-49.
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Figure 6-49. Port ‘Filters’ Tab in Bootloader Host Tool

&) Bootloader Host [SlE]ss ]

File Actions Help

File:  C:\Users\msur\Documents\PSoC Creator\Booticadable\Bootioadable.cydsn\CortexM3\ARM_GCC_473\Debug\Bk [ - |

Ports: || Filters... I Port Configuration 12C ~ | Port Information
S Intel(R) Active Management_ I2C address: D Rifrog Maeton 2117
I2C Speed
Port Filters o]

[ Show I2C Devices

[ Show SPI Devices

|| Show UART Devices

[¥] Show USB Devices
VID: OxD4B4

PID: OxF138

Log: [ Concet |[ oK ]
08:13:25 PM - Selected device: Intel(R) Act
08:13:25 PM - Selected device: Intel(R) Active Management Technology
08:13:48 PM - Selected device: KitProg/191607A0032C2400

Ready

[

9. In the Bootloader Host tool, click the Open File button to browse to the location of the bootload-
able file (*.cyacd), as shown in Figure 6-50.

Figure 6-50. Open Bootloadable File from Bootloader Host Tool

%] Bootloader Host E‘@g

File  Actions Help

~ AR AESE AL
Flle: C:\Users\ancy\Desktop\Bootloadable projectiBootioadable cydsn\ConexM3IARM_GCC_441\Debug\Bootloadable.cyacd E

orts: Port Configuration UsB * | Port Information

g o No configuration necessary for this VID: 04B4
% USB F uman Interface Device (04B4_F13B) e PID- F13B

Program Button

Open File Button

Log:

12:35:02 PM - Selected device: USB Human Interface Device (04B4_F13B)
12:35:02 PM - Selected device: USB Human Interface Device (04B4_F13B)
12:35:.08 PM - Selected device: USB Human Interface Device (04B4_F13B)
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10.Keep the reset switch (SW1) pressed and plug in the USB Mini-B connector. If the switch is
pressed for more than 100 ms, the PSoC 5LP enters into bootloader. click the Program button in
the Bootloader Host tool to program the device.

Figure 6-51. Select Bootloadable .cyacd File from Bootloader Host

-
=—— e
S® [}, <« Bootloadable.cydsn » CortexM3 » ARM_GCC_473 » Debug » v|+,ll Search Debug o
Organize ¥ New folder =~ 0 @

¢ Favorites Documents library y o
Arrange by: Folder ~
B Desktop Debug
& Downloads Name Date:ﬂ.cd‘if.ed Type
', Recent Places o _
@ SkyDrive = .deps 4/15/2014 8:13 PM File folder
I __| Bootloadable.cyacd I 4/15/2014 8:13 PM  CYACD File
~a Libraries
¢| Documents
J Music
= Pictures
Podcasts
B videos
/S Computer v i n b
File name: Bootloadable.cyacd - [Bootluader Files (*.cyacd) v]
I Open {v] [ Cancel
LS )

11.If bootload is successful, the log of the tool displays "Programming Finished Successfully"; other-
wise, it displays "Failed" and a statement for the failure.
Notes:

m The PSoC 5LP pins are brought to the PSoC 5LP GPIO header (J8). These pins are selected to
support high-performance analog and digital projects. See A.2.2 PSoC 5LP GPIO Header (J8) for
pin information.

m Take care when allocating the PSoC 5LP pins for custom applications. For example, P2[0]-P2[4]
are dedicated for programming the PSoC 4. Refer to A.1 CY8CKIT-040 Schematics before allo-
cating the pins.

m When a custom bootloadable project is programmed onto the PSoC 5LP, the initial capability of
the PSoC 5LP to act as a programmer, USB-UART bridge, or USB-I2C bridge is not available.

m The status LED does not function unless used by the custom project.

For additional information on bootloaders, refer to the Cypress application note AN73503 — USB HID
Bootloader for PSoC 3 and PSoC SLP.

6.4.2 Building a Normal Project for PSoC 5LP

A normal project is a completely new project created for the PSoC 5LP device on the CY8CKIT-040.
Here, the entire flash of the PSoC 5LP is programmed, overwriting all bootloader and programming
code. To recover the programmer, reprogram the PSoC 5LP device with the factory-set KitProg.hex
file, which is shipped with the kit installer.

The KitProg.hex file is available at the following location:

CYB8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. ** 126


http://www.cypress.com/?rID=57561

YPRESS

PERFORM Advanced TOpICS

<Install Directory>\CY8CKIT-040 PSoC 4000 Pioneer Kit\<version>\Firm-
ware\Programmer\KitProg

This advanced functionality requires a MiniProg3 programmer, which is not included with this kit. The
MiniProg3 can be purchased from www.cypress.com/go/CY8CKIT-002. To build a normal project for
the PSoC 5LP, follow these steps:

1. In PSoC Creator, choose New > Project > PSoC 5LP; click the expand button adjacent to
Advanced and select Device as CY8C5868LTI-LP039; select Application Type as Normal from
the drop-down list, as shown in Figure 6-52.

Figure 6-52. Create a New Project in PSoC Creator

-
New Project M
" Design [ Other 4 b
=] Empty Templates -
j Empty PSoC 3 Design Creates a PSoC 3, 8 bit. design project.
j Empty PSoC 4 Design Creates a PSoC 4, 32 bit, design project
__| Empty P Design fesign project £
[=] PSoC 3 Starter Designs
E' ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with no CPU intervention.
. Shows a 16-channel, 12-bit Delta Sigma ADC in PSoC 3 sequenced in hardware; samples are -3
EI DelSig_16Channel transferred from ADC to SRAM using DMA - without processor intervention.
EI DelSig_I2CM ;E‘éhews the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
E DelSig_I2CS ghgwﬁ the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
EI DelSig_SPIM gg'ivws the 16-bit differential ADC, hardware multiplexed into 8 channels and transported over
; Shows how to filter an analog input all in hardware, and provides all the DMA setup to transfer the
EI Filter_ADC_VDAC data from the ADC directly to the Digital Filter Block, bypassing the processor.
E Hw_Fan_Control_with_Alert Shows how performing fan control in hardware completely frees up the CPU.
[=] PSoC 4 Starter Designs =
Name: Design20
Location: C:\Users'msur\Documents'\P SoC Creator ‘IJ
B Advanced
Workspace: ’Cmaie New Workspace ']
Workspace Name: Design20
| Device: [CYBC5868LTILP039 - (Last Used PSoC 5LP Device) -|
Sheet Template: (Empty (11"x 85" )
Ikwnwaﬂhm | Nomal -|
[ ok || conesl |
| S A

2. Develop your custom project.
3. Build the project in PSoC Creator by choosing Build > Build Project or pressing [Shift] [F6].

4. Connect the 10-pin connector of MiniProg3 to the onboard 10-pin SWD debug and programming
header J7 (which needs to be populated).

5. To program the PSoC 5LP with PSoC Creator, choose Debug > Program or press [Ctrl] [F5].
The Programming window shows MiniProg3 and the selected device in the project under it
(CY8C5868LTI-LP039).
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6. Click on the device and click Connect to program.

Notes:

m The 10-pin SWD debug and programming header (J7) is not populated. See the "No Load Com-
ponents" section of Bill of Materials on page 146 for details.

m The PSoC 5LP pins are brought to the PSoC 5LP GPIO header (J8). These pins are selected to
support high-performance analog and digital projects. See PSoC 5LP GPIO Header (J8) on
page 143 for pin information.

m Take care when allocating the PSoC 5LP pins for custom applications. For example, P2[0]-P2[4]
are dedicated for programming the PSoC 4. Refer to CY8CKIT-040 Schematics on page 136
before allocating the pins.

m  When a normal project is programmed onto the PSoC 5LP, the initial capability of the PSoC 5LP
to act as a programmer, USB-UART bridge, or USB-I?C bridge is not available.

m The status LED does not function unless used by the custom project.

PSoC 5LP Factory Program Restore Instructions

The CY8CKIT-040 PSoC 4000 Pioneer Kit features a PSoC 5LP device that comes factory-pro-
grammed as the onboard programmer and debugger for the PSoC 4 device.

In addition to creating applications for the PSoC 4 device, you can also create custom applications
for the PSoC 5LP device on this kit as explained in Developing Applications for PSoC 5LP on
page 119. Reprogramming or bootloading the PSoC 5LP device with a new flash image will over-
write the factory program and forfeit the ability to use the PSoC 5LP device as a programmer/debug-
ger for the PSoC 4 device. Follow these instructions to restore the factory program on the PSoC 5LP
and enable the programmer/debugger functionality.

PSoC 5LP Programmed with a Bootloadable Application

If the PSoC 5LP is programmed with a bootloadable application, restore the factory program by
using one of the following two methods.

Restore PSoC 5LP Factory Program Using PSoC Programmer

1. Launch PSoC Programmer 3.18 or later from Start > Cypress > PSoC Programmer.

2. Configure the kit in Service mode. To do this, while holding down the reset button (SW1 Reset),
plug the PSoC 4000 Pioneer Kit into the computer using the included USB cable (USB A to Mini-
B). This puts the PSoC 5LP into service mode, which is indicated by the blinking green status
LED.

3. The following message shown in Figure 6-53 appears in the PSoC Programmer results window:
"KitProg Bootloader device is detected.”
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Figure 6-53. PSoC Programmer Results Window

% PSoC Programmer

E . @] oo

[crecseseLTILPO29

7]

File  View Options Help
Port Selection bl | Programmer | usilities | JTAG |
Programming Parameters
File Path: C:\Program Files (x26)\Cypress\CYBCKIT-040 PSoC 4 Pioneer Kit\1.0\Firmware\ProgrammeriKitPr
| 1 | b
Programmer:
Programming Mode: @ Reset Power Cycle Power Detect
Verification: On ) Off Connector: 5p @ 10p
Device Famiy AutoDetection: @ On Off Clock Speed: | 1.6 MHz
[CY&:&xxxLP ,] Programmer Characteristics Status
Protocol:  JTAG @ SWD ' ISSP 7 12¢ Execution Time:
Device . Power Status:
Voltage: T EEE—
50V 33V 25V 1.8V Voltage: NA

Actions

Results

»

Dewvice set to

6:38:29 FPM

Active HEX file
6:38:28 FM

Connected at 6:40:11

CYBCS5868LTI-LFO39 at

Device Family set to
CYBC5xxxLF at 6:38:29 FM

set at

PM EitProg bootloader device is detected

Please close all ports, then navigate to the Utilities tab and click the
Upgrade Firmware button to recover Bridge
Select Port in the PortList, then try to connect

262144 FLASH bytes

C:\Program Files (x86)\Cypress\CYSBCKIT-042 P5oC 4 Pioneer
Kit\l.0\Firmware\Programmer\KitProg\KitProg.hex

Users must be aware that the following P5oC dewvice should not be powered or
programmed at 5V. Doing so will cause damage to the device: CYBCBO9xxx

For Help, press F1

m

4. Switch to the Utilities tab in PSoC Programmer and click the Upgrade Firmware button, as
shown in Figure 6-54. Unplug all other PSoC programmers (such as MiniProg3 and DVKProg)
from the PC before clicking the Upgrade Firmware button.

Figure 6-54. Upgrade Firmware

¥ PSoC Programmer

- s C

File View Options Help

(@] o O ]

Port Selection

b4 | Programmer | Utilities i JTAG |

Click to upgrade connected device's fimware

Erase Block Click to erase user specific flash block
Device Famiby
[cvecmodr -
Device
[crecseeeLTiPOzd v
Actions Results £

Connected at 6:40:11 PM KitProg bootloader device is detected

Please close all ports, then navigate to the Utilities tab and click the
Upgrade Firmware button to recover Bridge
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5. After programming is completed, the following message appears: "Firmware Update Finished at
<time>," as shown in Figure 6-55.

Figure 6-55. Firmware Update Complete
r% P5oC Programmer LEJ Elﬂlg

File View Options Help

303D BDODB

| Port Selection 4p |F'rc|grammer| Utilities | JTAG |

@ KitProg/110E192D00232401
Click to upgrade connected device's fimware
Click to erase user specific flash block

4

Device Family
CYBCHoxLP

Device
CYBC5868LTI-LPO3S

»

Actions Results ol

Successfully Connected to
KitProg/110E192D00232400 at 6:42:32 BM
Cpening Port at 6:42:29 PM

FKitProg Version 2.02

Connected at 6:42:29 PM KitProg/110E132D00232400
Disconnected at 6:42:28 FM Bootloader dewvice £
Firmware Update Finished at 6:42:27 PM

Succeeded

Verifying...

Upgrading. ..

Initializing... [
Firmware Upgrade Started at 6:42:21 PM
Firmware Upgrade Regquested at 6:42:21 FM
Connected at 6:40:11 FM FKitProg bootloader device is detected

Please close all ports, then navigate to
and click the Upgrade Firmware button to
Select Port in the PortList, then try to connect B

For Help, pressF1 s PASS | Powersd | Connected |

L

6. The factory program is now successfully restored on the PSoC 5LP. It can be used as the pro-
grammer/debugger for the PSoC 4 device.

6.5.1.2 Restore PSoC 5LP Factory Program Using USB Host Tool
1. Launch the Bootloader Host tool from Start > Cypress > PSoC Creator, as shown in
Figure 6-56.
Using the File > Open menu, load the Kit Prog.cyacd file, which is installed with the kit software.

The default location for this file is <Install Directory>\CY8CKIT-040 PSoC 4000 Pio-
neer Kit\<version>\Firmware\Programmer\KitProg\KitProg.cyacd.
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Figure 6-56. Load KitProg.cyacd File
[ L Bootloader Host @J Elﬂlg

File  Actions Help

2 f o _(Fi g Prog D
Ports: Port Configuration UART Port Information
Generic Serial Port
Baud
e

Log:

06:15:14 PM - Selected device: Communications Port {COM1)
06:15:14 PM - Selected device: Communications Port {COM1)

Ready | |
r B
L Open lDE_J M
Cl\../l . < Firmware » Programmer » KitProg b4 |{u, || Search KitProg })l
———
Organize « Mew folder = » 0 '®
b Favioistes MName Date modified Type Size
M
Ml Desktop i L | KitProg.cyacd 4/18/20131:07 AM  CYACD File 121 KBi
4. Downloads 3
[ ] Recent Places |
i Google Drive
| %# Dropbox —
) No-Zoolz Zone
& SkyDrive
4 Libraries
& Apps
8 nacuments %
File name: KitProg.cyacd - ’Bootloader Files v]
[ Open iv] ’ Cancel ]

2. Configure the Pioneer Kit in Service mode. To do so, while holding down the reset button (SW1
Reset), plug the PSoC 4000 Pioneer Kit into the computer using the included USB cable (USB A

to Mini-B). This puts the PSoC 5LP into service mode, which is indicated by the blinking green
status LED.

3. In the Bootloader Host tool, set the filters for the USB devices with VID: 04B4 and PID: F13B.
The USB Human Interface Device port appears in the Ports list. Click that port to select it.
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Figure 6-57. Select USB Human Interface Device

-

%) Bootloader Host [DEJ E@g

File  Actions Help

3B

File:  C:\Program Files (x86)Cypress\CYBCKIT-040 PSoC 4 Pioneer Kit'1.0'Fimware"Programmer'\Kit Prog.Kit Prog cyacd E]
Ports: Port Configuration UsSB Port Information

3 i i i VID: D4B4
53 Communications Port (COM1) rr’d:fonflgumhon pecE o PID: F13E

% USB Human Interface Device.

Log:

(06:15:14 PM - Selected device: Communications Port {COM1)

06:15:14 PM - Selected device: Communications Port {COM1)

06:21:45 PM - Selected device: USE Human Inteface Device (04B4_F13B)
(06:25:53 PM - Selected device: Communications Port {COM1)

06:25:53 PM - Selected device: USBE Human Intefface Device (04B4_F13B)
(06:25:58 PM - Selected device: Communications Port {COM1

06:26:09 PM - Selected device: USE Human Intefface Device (04B4_F13B)

Ready |

4. Click the Program button (or menu item Actions > Program) to restore the factory program by
bootloading it onto the PSoC 5LP.

5. After programming is completed, the following message appears "Programming Finished Suc-
cessfully," as shown in Figure 6-58.
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= Baud
5% USE Human Interface Device..
Data Bits

Stop Bits | One

iIIi
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06:25:53 PM
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Selected device: Communications Port {COM1)
Selected device: USB Human Intefface Device (04B4_F13B)

- Selected device: Communications Port {COM1)
06:25:53 PM -
06:25:58 PM -
06:26:09 PM -
06:2%:34 PM -
06:25:40 PM -
Programming completed in 5191ms.
06:25:41 PM -

Selected device: USE Human Intefface Device (04B4_F13B)
Selected device: Communications Port {COM1)

Selected device: USB Human Interface Device (04B4_F13B)
Programming Started

Programming Finished Successfully

Selected device: Communications Port {COM1)

Ready

6. The factory program is now successfully restored on the PSoC 5LP. You can now use it as the
programmer/debugger for the PSoC 4 device.

6.5.2 PSoC 5LP Programmed with a Standard Application

If PSoC 5LP is programmed with a standard application, restore the factory program by using the fol-
lowing method.

1. Launch PSoC Programmer 3.18 or later from Start > Cypress > PSoC Programmer.

2. Use the File > Open menu to load the KitProg.hex factory program hex file, which is shipped with
the kit. The default location for this file is <Install Directory>\CY8CKIT-040 PSoC 4000
Pioneer Kit\<version>\Firmware\Programmer\KitProg.

3. Connect a CY8CKIT-002 MiniProg3 (sold separately) to the computer. The 10-pin connector
cable on the MiniProg3 plugs into the header [J7]. Note that the J7 header is unpopulated. For
more details, see Bill of Materials on page 146.

4. Ensure that MiniProg3 is the selected port in PSoC Programmer and the 10-pin connector (10p
option) is selected, as shown in Figure 6-59. If the board is not powered over USB, select the
Power Cycle programming mode.
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Figure 6-59. Select MiniProg3

. T
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F- 3oL BEE

[ Pot seiction Alp | Programmer | utlties | JTAG |
[ @ MiniFrog3/320988000002 || - Programming Parameters |
File Path C:\Program Files (xB6)\Cypress\CYBCKIT-040 PSoC 4 Pioneer Kitt1 QiFimmware\ProgrammerKitProgiKitProg hex
Prorammer MiniProg3/3209AA000002
Programming Mode: () Resst @ Powsr Cycle ~ Power Detect
Verification @ on © Of Connector. ) 5p @ 10p

o Off Clock Speed: (16MHz ~

AutoDetection @ On ©

Device Family
CYBCRoLP Programmer Characteristics Status
Execution Time: 0.5 seconds

Protocol: @) JTAG @ SWD () ISSP 12c
D & . =
e || Voltage: @ s50v @ 33V @ 25V © 18V
CYEC586ELTH PO39

Power Status: OFF
Voltage: 40mV

Actions Results

- fully Ce ted t
S e i MiniProg3 version 2.05 [3.08/2.05]

MiniProg3/3209AR000002 at 6:58:42 PM
Opening Port at 6:58:41 EM

N R coveced

For Help, press F1

5. When ready, select the Program button (or File > Program) to program the PSoC 5LP device,

as shown in Figure 6-60.
6. After programming is completed, the following message appears: "Program Finished at <time>."
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Figure 6-60. Program Finished
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Program Requested at 6:59:44 BM
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ey A5 [ Coreced

7. The factory program is now successfully restored on the PSoC 5LP. You can use it as the pro-
grammer/debugger for the PSoC 4 device.
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A1 CYS8CKIT-040 Schematics
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A.2 Pin Assignment Table

This section provides the pin map of the headers and their usage.

A.21 Arduino Compatible Headers (J1, J2, J3, J4, and J12)
Power Connector (J1)

Pin Baseboard Signal Trackpad Shield Signal
J1_01 VIN NC
J1_02 GND GND
J1._03 GND GND
J1_04 V5.0 NC
J1_05 V3.3 NC
J1_06 RESET NC
J1_07 IOREF/P4_VDD NC
J1_08 NC NC

J2 Connector

Pin Baseboard Signal Trackpad Shield Signal
J2_01 (A0) PO[0] TRACK_COLUMN1
J2_02 (A1) PO[1] TRACK_COLUMNO
J2_03 (A2) PO[2] (TCPWM_LINE/Blue LED, CTANK) |NC
J2_04 (A3) PO[4] (CMOD) NC
J2_05 (A4) P1[3] (SDA) NC
J2_06 (A5) P1[2] (SCL) NC

J3 Connector

Pin Baseboard Signal Trackpad Shield Signal
J3_01 (D8) P1[4] TRACK_ROWO
J3_02 (D9) P1[5] TRACK_ROW1
J3_03 (D10) P1[6] TRACK_ROW2
J3_04 (D11) P1[1] (TCPWM_LINE/Green LED) NC
J3_05 (D12) P3[1] (SWDCK) NC
J3_06 (D13) P1[7] TRACK_ROW4
J3_07 GND GND
J3_08 NC NC
J3_09 P1[3] (SDA) NC
J3_10 P1[2] (SCL) NC
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J4 Connector

Pin Baseboard Signal Trackpad Shield Signal
J4_01 (DO) PO[5] TRACK_COLUMN2
J4_02 (D1) PO[6] TRACK_COLUMN3
J4_03 (D2) PO[7] TRACK_COLUMN4
J4_04 (D3) P3[2] (TCPWM_LINE, Red LED) | NC
J4_05 (D4) PO[3] TRACK_COLUMNS5
J4_06 (D5) P3[0] (SWDIO) NC
J4_07 (D6) P1[0] TRACK_ROW3
J4_08 (D7) P2[0] (PROX) NC

J12

Pin Kit Signal PSoC 4 Description
J12_01 P3[1] GPIO
J12_02 NC NC
J12_03 P1[7] GPIO
J12_04 P1[1] GPIO
J12_05 /IXRES PSoC 4 RESET
J12_06 GND GND
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PSoC 5LP GPIO Header (J8)
J8is a 2x6 header that connects PSoC 5LP pins to support GPIO controls for custom PSoC 5LP proj-

ects.
J8
Pin Pg?;::‘ P PSoC 5LP Description Pin Pg?;::‘ P PSoC 5LP Description
J8_ 01 |PSoC5LP_VDD |VDD J8 02 |P1[2] Digital 1/0
J8 03 PO[0] Delta Sigma ADC + input |J8_04 |PO[1] Delta Sigma ADC — input
J8 05 |P3[4] SAR - input J8 06 |[P3[5] SAR + input
J8 07 |P3[6] Buffered VDAC J8_08 |P3[7] Buffered VDAC
J8 09 |P12[6] UART RX J8 10 |P12[7] UART TX
J8 11 |GND GND J8_ 12 [P3[0] IDAC output
A3 Program and Debug Headers
A.3.1 PSoC 4 Direct Program/Debug Header (J6)
J6
Pin PSo_)C SLP P_SoC 4 Description Pin PS'.DC SLP P_SoC 4 Description
Signal Signal Signal Signal
J6_01 VDD VDD VCC J6_02 P12[2] P3[0] TMS/SWDIO
J6 03 GND GND GND J6 04 [P12[3] P3[1] TCLK/SWCLK
J6_05 GND GND GND J6_06 |NC NC NC
J6_07 GND GND GND J6_08 |NC NC NC
J6_09 GND GND GND J6_10 P12[4] XRES RESET
A.3.2 PSoC 5LP Direct Program/Debug Header (J7)
J7
Pin PZ?;‘::'P Description Pin Pss?;ng:'P Description
J7_01 VDD VCC J7.02  |P1[0] TMS/SWDIO
J7_03 GND GND J7_04 P1[1] TCLK/SWCLK
J7_05 GND GND J7_06 | P1[3] TDO/SWO
J7. 07 GND GND J7.08 |P1[4] TDI
J7_09 GND GND J7_10 XRES RESET
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Use of Zero-ohm Resistors and No Load

Unit Resistor Usage
Power supply R2 Solder zero-ohm resistors to access voltage from VBUS (USB).
2c tion bet PSoC 5LP Unsolder the resistors to communicate with an external PSoC
connection between Fs0 R24 and R25 | using the PSoC 5LP. Removing these will disable the PSoC 4 12C
and PSoC 4 communication with the PSoC 5LP device.
Unsolder the resistors to disconnect SWD lines from the PSoC 4.
PSoC 4/external PSoC program/ R32, R33, and |Use J6 to connect and program an external PSoC. Removing these
debug header R34 will disable PSoC 4 programming by the PSoC 5LP device and
through the J6 header.
Protection circuit R46 Solder zero-ohm resistors to bypass the entire protection circuitry.
CapSense tuning circuitry R1 Convert IDAC output to a voltage, or used as a bleed resistor to
CMOD.
CapSense tuning circuitry/user inter- R30 Unsolder R30, which connects PO[2] to the blue LED to enable
face shield tank capacitor C5 on P0[2].
Unsolder R4 to remove supply to VTARG and solder zero-ohm
PSoC 4 R4, R6 resistors R6 to supply P4_VDD with VDD instead of J13.
PSoC 5LP programmer/debugger R11, R12, R14,
R15, R16 For future use.
R5 Unsolder the zero-ohm resistor to cut the VDD supply to PSoC 5LP.
R7 For future use.
Select the lower three bits of the F-RAM I2C slave address. R14-
R14, R15, R16, |R15 selects bit 2 (A2), R16-R17 selects bit 1(A1), and R18-R19
R17,R18, and |selects bit 0 (A0). The selected bits are OR'ed with the F-RAM fam-
R19 ily's 12C address (0x50) to decide the slave address for the one on
F-RAM the board.
Solder a zero-ohm resistor for R56 to write-protect the entire
R56 and R55 F-RAM memory. R55 is not required to be populated as the WP pin
is internally pulled down. When the WP pin is left floating or R55 is
populated, write access to F-RAM is restored.
Unsolder the zero-ohm resistor to disconnect P3[0] from the
PSoC 5LP GPIO header R57 PSoC 5LP RX line and use P3[0] for PSoC 4 debug or PSoC 5LP

as a USB-UART bridge for another device.
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A.5 Error in Firmware/Status Indication in Status LED

User Indication

Scenario

Action Required by user

LED blinks at a fast rate
(ON Time = 0.25 s, OFF Time = 0.25 s)

Bootloadable file is
corrupt

Bootload the *.cyacd file over the USB interface, which
is shipped with PSoC Programmer using the Boot-
loader Host GUI shipped with PSoC Creator. The files
are located in the PSoC Programmer root installation
directory.

LED blinks at a slow rate
(ON Time = 1.5s, OFF Time = 1.5s)

Entered Bootloader
by pressing the
PSoC 4 Reset
switch

Unplug power and plug it in again if you entered this
mode by mistake; the LED gives the indication.

If the mode entry was intentional, bootload the new
*.cyacd file using the Bootloader Host tool shipped with
PSoC Creator.

3 |LED glows steadily

Programmer appli-
cation is running
successfully

USB is enumerated successfully and the programmer
is up and running.The PSoC 4 device can now be pro-
grammed any time using the onboard PSoC 5LP pro-

grammer.

Note: LED status is not applicable when a custom project is running in PSoC 5LP.
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A.6 Bill of Materials
A.6.1 CY8CKIT-040 Baseboard
No. | Qty Reference Value Description Manufacturer Mfr Part Number
PCB, 68.58 mm x 53.34 mm, High Tg,
1 ENIG finish, 4 layer, Color = RED, Silk |Cypress
= WHITE.
2 1 C1 2200 pFd CAP CER 2200PF 50V 5% NP0 0805 |Murata GRM2165C1H222JA01D
C2,C9,C10,C12,
C14,C15,C17,C2 .
3 13 0.C21,C22,C24, 0.1 uFd CAP .1UF 16V CERAMIC Y5V 0402 |Panasonic - ECG ECJ-0EF1C104Z
C25,C27
C3,C11,C13,C18
4 9 ,C19,C23,C26,C |1.0 uFd CAP CERAMIC 1.0UF 25V X5R 0603 Taiyo Yuden TMK107BJ105KA-T
10%
28,C29
1 C4 10 uF 25V CAP TANT 10UF 25V 10% 1210 AVX Corporation TPSB106K025R1800
1 C6 22 uF 16V CAP TANT 22UF 16V 10% 1210 AVX Corporation TPSB226K016R0600
7 1 C16 0.01 uFd g'\AAPDmOOOPF 16V CERAMIC 0402 Panasonic - ECG ECJ-0EB1C103K
Samsung Electro-
8 1 c8 10uFd CAP CER 10UF 6.3V 20% X5R 0603 |Mechanics America, |CL10A106MQ8NNNC
Inc
9 7 D1,D2,D3,D4,D9 MBRO5 DIODE SCHOTTKY 0.5A 20V SOD-  |Fairchild Semiconduc- MBRO520L
,D10,D11 123 tor
10 |1 LED1 :?nvl\;zrrLED LED 595NM AMB DIFF 0805 SMD Avago Technologies |HSMA-C170
11 1 D5 2V Zener DIODE ZENER 2V 500MW SOD123 |Diodes Inc BZT52C2V0-7-F
12 |3 D6, D7, D8 ESD diode SUPPRESSOR ESD 5VDC 0603 SMD |Bourns Inc. CG0603MLC-05LE
CLV1A-FKB-
13 |1 LED3 RGB LED LED RED/GREEN/BLUE PLCC4 SMD |Cree, Inc. CJIMAF1BB7R4S3
Status LED . .
14 |1 LED2 Green LED GREEN CLEAR 0805 SMD Chicago Miniature CMD17-21VGC/TR8
15 [1  |F1 FUSE PTC Resettable Fuses 15Volts Bourns MF-MSMF050-2
100Amps
16 |2 1, 44 8x1 RECP CONN HEADER FEMALE 8POS .1 Sulllqs Connector PPPCO81LEBN-RC
GOLD Solutions
17 1 52 6x1 RECP CONN HEADER FMAL 6POS.1 Sulllqs Connector PPPCO61LEBN-RC
GOLD Solutions
18 1 53 10x1 RECP CONN HEADER FMALE 10POS .1 Sulllqs Connector PPPC101LEBN-RC
GOLD Solutions
19 |1 |5 1x1recp  |CONNRCPT 1POS 100" SNGL Samtec Inc BCS-101-L-S-HE
HORZ
20 |1 56 50MIL KEYED |CONN HEADER 10 PIN 50MIL KEYED Samtec FTSH-105-01-L-DV-K
SMD SMD
21 1 8 6x2 RECP CONN HEADER FMAL 12PS.1" DL Sulllqs Connector PPPCO62LEBN-RC
GOLD Solutions
22 |1 o 3p_jumper | CONNHEADER VERT SGL3POS 14 961103-6404-AR
GOLD
23 |1 |J10 USB MINI B gﬁg'\' USB RECEPTACLE SPOSRT | 1o1ex Inc 0548190519
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No. | Qty Reference Value Description Manufacturer Mfr Part Number
24 |2 J13,J14 2p_jumper CONN HEADER VERT SGL 2POS 3M 961102-6404-AR
GOLD
25 |3 Q1,Q2,Q3 PMOS MOSFET P-CH 30V 3.8A SOT23-3 Diodes Inc DMP3098L-7
26 |1 R3 560 ohm RES 560 OHM 1/8W 5% 0805 SMD  |Panasonic - ECG ERJ-6GEYJ561V
R4,R7,R11,R12,
R14,R16,R18,R2
4,R25,R32,R33,
27 |24 |R34,R44,R45,R4|ZERO RES 0.0 OHM 1/10W 0603 SMD Panasonic-ECG ERJ-3GEYOROOV
7,R48,R49,R50,
R51,R52,R53,R5
4,R55,R57
28 |1 R5 ZERO RES 0.0 OHM 1/8W 0805 SMD Panasonic-ECG ERJ-6GEYORO0OV
29 |4 R8,R9 2.2K RES 2.2K OHM 1/10W 5% 0603 SMD |Panasonic - ECG ERJ-3GEYJ222V
30 |1 R13 100K RES 100K OHM 1/10W 5% 0402 SMD |Panasonic - ECG ERJ-2GEJ104X
31 |2 R26, R27 22E RES 22 OHM 1/10W 1% 0603 SMD  |Panasonic - ECG ERJ-3EKF22R0V
32 1 R28 2.2K RES 2.2K OHM 1/8W 5% 0805 SMD |Panasonic - ECG ERJ-6GEYJ222V
33 |2 R29,R30 1.5K RES 1.5K OHM 1/8W 5% 0805 SMD |Panasonic - ECG ERJ-6GEYJ152V
34 1 R31 330 ohm RES 330 OHM 1/8W 5% 0805 SMD  |Panasonic - ECG ERJ-6GEYJ331V
35 |1 R35 232 ohm RES 232 OHM 1/10W 1% 0603 SMD |Panasonic - ECG ERJ-3EKF2320V
36 |1 R36 120 ohm RES 120 OHM 1/10W 1% 0603 SMD |Panasonic - ECG ERJ-3EKF1200V
37 |2 R37,R39 15K RES 15K OHM 1/10W 5% 0603 SMD |Panasonic - ECG ERJ-3GEYJ153V
38 |2 R38,R40 30K RES 30K OHM 1/10W 5% 0603 SMD |Panasonic - ECG ERJ-3GEYJ303V
39 1 R42 1K RES 1K OHM 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ102V
40 |1 R43 442 ohm RES 442 OHM 1/10W 1% 0603 SMD |Panasonic - ECG ERJ-3EKF4420V
a1 |1 SW1 SW PUSHBUT- |SWITCH TACTILE SPST-NO 0.05A Panasonic - ECG EVQ-PE105K
TON 12v
42 1 TP5 BLACK TEST POINT PC MINI .040"D Black  |Keystone Electronics |5001
43 |2 TVS1,TVS2 5V 350W TVS UNIDIR 350W 5V SOD-323 Dioded Inc. SD05-7
44 (1 U1 EgPﬂ”DTAR NCP1117DTARKG ON Semiconductor NCP1117DTARKG
PSoC 4 SO . Cypress Semiconduc-
45 (1 U2 (CY8C400) 24 QFN PSoC4 S0 target chip tor CY8C4014LQl-422
PSoC 5LP . .
46 |1 U3 (CYBC5868LTI- 68QFN PSoC 5LP ChIP fqr USB debug |Cypress Semiconduc- CY8C5868LTI-LPO39
channel and USB-Serial interface tor
LP039)
a7 |1 |us F-RAM F-RAM with I2C interface t%{press Semiconduc- |y aw256-G
No Load Components
48 |1 BT Coin Cell Bat- |0 pER CR2032 GOLD LEADS SMD [MPD BU2032SM-BT-GTR
tery Holder
49 1 C5 10000 pFd CAP CER 10000PF 50V 5% NP0 0805 |Murata GRM2195C1H103JA01D
50 |2 C7,C30 0.1 uFd CAP .1UF 16V CERAMIC Y5V 0402 |Panasonic - ECG ECJ-0EF1C104Z
51 |1 47 50MIL KEYED |CONN HEADER 10 PIN 50MIL KEYED Samtec FTSH-105-01-L-DV-K
SMD SMD
520 |1 11 2 PIN HDR CONN HEADER FEMALE 2POS 1 Sulllqs Connector PPPCO21LEBN-RC
GOLD Solutions
53 |1 12 3X2 RECP CONN HEADER .100 DUAL STR Sullins Connector PBCOSDFAN

12P0OS

Solutions

CYB8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. **

147




-2
T PHESH

PERFORM

No. | Qty Reference Value Description Manufacturer Mfr Part Number
R1,R2,R15,R17, .
54 |7 R19.R46,R56 ZERO RES 0.0 OHM 1/10W 0603 SMD Panasonic-ECG ERJ-3GEYOROOV
55 |1 R6 ZERO RES 0.0 OHM 1/8W 0805 SMD Panasonic-ECG ERJ-6GEYORO0OV
56 |2 R10,R41 47K RES 4.7K OHM 1/10W 5% 0603 SMD |Panasonic-ECG ERJ-3GEYJ472V
57 |2 R20,R21 10K RES 10K OHM 1/10W 5% 0603 SMD |Panasonic - ECG ERJ-3GEYJ103V
58 |2 R22,R23 2.2K RES 2.2K OHM 1/10W 5% 0603 SMD |Panasonic - ECG ERJ-3GEYJ222V
59 |3 TP1,TP2,TP6 RED TEST POINT PC MINI .040"D RED Keystone Electronics |5000
60 |2 TP3,TP4 BLACK TEST POINT PC MINI .040"D Black  |Keystone Electronics |5001
Install on Bottom of PCB As per the Silk Screen in the Corners
BUMPON CYLINDRICAL .312X.215
61 |4 N/A N/A BLACK 3M SJ61A6
Special Jumper Installation Instructions
Install jumper Rectangular Connectors MINI
62 |1 J9 across pins 1 JUMPER GF 6.0MM CLOSE TYPE Kobiconn 151-8010-E
and 2 BLACK
Install jumper Rectangular Connectors MINI
63 |1 J13 across pins 1 JUMPER GF 6.0MM CLOSE TYPE Kobiconn 151-8010-E
and 2 BLACK
Install jumper Rectangular Connectors MINI
64 |1 J14 across pins 1 JUMPER GF 6.0MM CLOSE TYPE Kobiconn 151-8010-E
and 2 BLACK
A.6.2 CYB8CKIT-040 Trackpad Shield Board
No. | Qty. Reference Value Description Manufacturer Mfr Part Number
PCB, 53.34 mm x 53.34 mm, High Tg,
1 ENIG finish, 2 layer, Color = RED, Silk | Cypress
= WHITE.
2 |2 |u1ua CON8 CONNHEADER 8POS 100 STR | ¢ 68001-108HLF
30AU
3 (1 | CONG CONNHEADER 6POS 100 STR | ¢ 68001-106HLF
30AU
4 |1 | CON10 CONNHEADER T0POS 00 STR | £ 68001-110HLF

CYB8CKIT-040 PSoC 4000 Pioneer Kit Guide, Doc. # 001-91316 Rev. **

148



A.7 Trackpad/Touchpad Sticker Details

46.96 mm

6.43 mm

CapSense trackpad

Trackpad/ Touchpad .

10.63 mm

Area
6.43 mm -
PJC
6.93 7.1(;
mm mm
A.8 Regulatory Compliance Information

The CY8CKIT-040 PSoC 4000 Pioneer Kit has been tested and verified to comply with the following

electromagnetic compatibility (EMC) regulations:
m EN 55022:2010 Class A - Emissions
m EN 55024:2010 Class A - Immunity
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/*******************************************************************************

* File Name: main.c

*

* Version: 1.10

*

* Description:

*  This is an example of how to access/share a F-RAM device through a PSoC 4 device

*	

*	The project demonstrates a simple scenario of shared F-RAM between PSoC 4 and 

*	Bridge Control Panel (BCP). In the example, based on a status variable 

*	present in the F-RAM (0x0000), PSoC 4 performs a simple invert operation of a BYTE

*	present in another location (0x0001). With the example, the user will also get

*	acquainted with 'how to use' F-RAM with SCB I2C block. The same can be 

*	expanded to implement an extended non-volatile RAM area through I2C.

*  

*

********************************************************************************

* Copyright 2014, Cypress Semiconductor Corporation. All rights reserved.

* This software is owned by Cypress Semiconductor Corporation and is protected

* by and subject to worldwide patent and copyright laws and treaties.

* Therefore, you may use this software only as provided in the license agreement

* accompanying the software package from which you obtained this software.

* CYPRESS AND ITS SUPPLIERS MAKE NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

* WITH REGARD TO THIS SOFTWARE, INCLUDING, BUT NOT LIMITED TO, NONINFRINGEMENT,

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

*******************************************************************************/



#include <project.h>



/* Slave address of the I2C slave */

#define I2C_SLAVE_ADDR  	(0x50)

/* Data bytes to be accessed */

#define DATA_SIZE     		(0x02u)

/* Size of RAM address in bytes */

#define RAM_ADDRESS_SIZE	2



/* Buffer size for read or write */

#define BUFFER_SIZE     (RAM_ADDRESS_SIZE + DATA_SIZE)



#define RAM_ADDRESS_MSB		0

#define RAM_ADDRESS_LSB		1



#define START_ADDRESS	0



/* I2C master read and write buffers */

uint8 i2cMasterReadBuf[DATA_SIZE];

uint8 i2cMasterWriteBuf[BUFFER_SIZE] = {0x00u, 0x00u, 0x03u, 0x04u};



uint16 framWriteDataAddress = START_ADDRESS;

uint16 framReadDataAddress = START_ADDRESS;



int main()

{	

    /* Start I2C master (SCB mode) */

    I2C_M_Start();

    CyGlobalIntEnable;



    for(;;)

    {		

		/* Check if the bus is free */

		if(I2C_M_I2CMasterStatus() != I2C_M_I2C_MSTAT_ERR_ARB_LOST)

		{

			/* In order to do a read from a specific RAM address - do a write operation with the memory address bytes alone */

			/* Initialize the Memory/RAM address bytes in the write buffer from framReadDataAddress having the memory from which data should be read */

			i2cMasterWriteBuf[RAM_ADDRESS_MSB] = (uint8)(framReadDataAddress >> 8);

			i2cMasterWriteBuf[RAM_ADDRESS_LSB] = (uint8)(framReadDataAddress);

			

			/* Write memory address bytes alone to initialize the pointer */

	   		I2C_M_I2CMasterWriteBuf(I2C_SLAVE_ADDR, (uint8 *) i2cMasterWriteBuf,

	                                 RAM_ADDRESS_SIZE, I2C_M_I2C_MODE_COMPLETE_XFER);



	        while(0u == (I2C_M_I2CMasterStatus() & I2C_M_I2C_MSTAT_WR_CMPLT))

	        {

	            /* Wait until master complete write */

	        }

	        

	        /* Clear I2C master status */

	        (void) I2C_M_I2CMasterClearStatus();



	        /* Read the data from the F-RAM into ReadBuf */

	        I2C_M_I2CMasterReadBuf(I2C_SLAVE_ADDR, (uint8 *) i2cMasterReadBuf,

	                               DATA_SIZE, I2C_M_I2C_MODE_COMPLETE_XFER);



	        while(0u == (I2C_M_I2CMasterStatus() & I2C_M_I2C_MSTAT_RD_CMPLT))

	        {

	            /* Wait until master complete reading */

	        }

	        

	        /* Clear I2C master status */

	        (void) I2C_M_I2CMasterClearStatus();

			

			/* If the status flag byte is set, get the data written by BCP and invert it in the same location */

			if(i2cMasterReadBuf[0] == 1)

			{

				i2cMasterReadBuf[0] = 0;

				/* Write data to the slave

				Note: the first two bytes written to the F-RAM slave device (after the slave address byte)

					is the Memory's address to/from which data has to be written/read */

				

				/* Initialize the Memory/RAM address bytes in the write buffer from the Write data address variable */

				i2cMasterWriteBuf[RAM_ADDRESS_MSB] = (uint8)(framWriteDataAddress >> 8);

				i2cMasterWriteBuf[RAM_ADDRESS_LSB] = (uint8)(framWriteDataAddress);

				

				/* Clear the status Byte set by another master */

				i2cMasterWriteBuf[2] = 0;

				

				/* Processing the data given by BCP/other master - Invert operation */

				i2cMasterWriteBuf[3] = i2cMasterReadBuf[1] ^ 0xFF;

				

				/* Write the data to the F-RAM device in the memory pointed by framWriteDataAddress */

		        I2C_M_I2CMasterWriteBuf(I2C_SLAVE_ADDR, (uint8 *) i2cMasterWriteBuf,

		                                 RAM_ADDRESS_SIZE + DATA_SIZE, I2C_M_I2C_MODE_COMPLETE_XFER);



		        while(0u == (I2C_M_I2CMasterStatus() & I2C_M_I2C_MSTAT_WR_CMPLT))

		        {

		            /* Wait until master complete write */

		        }

		        

		        /* Clear I2C master status */

		        (void) I2C_M_I2CMasterClearStatus();            	       

			}

		}		

		/* A delay to lose arbitration */

		CyDelay(250);



    }

}



/* [] END OF FILE */




;------------------------------F-RAM Data write format------------------

; w SLAVE_ADDR MEMORY_ADDR_MSB MEMORY_ADDR_LSB DATA_BYTE_0 DATA_BYTE_1

; ........ DATA_BYTE_N

;----------------------------------------------------------------------

w 50 00 00 01 02

;----------------------------------------------------------------------

; Set MEMORY_ADDR for read operation first (F-RAM memory from which read

; must be performed

;

;------------------------------F-RAM Data Read format-------------------

; w SLAVE_ADDR MEMORY_ADDR_MSB MEMORY_ADDR_LSB r SLAVE_ADDR

; DATA_BYTE_0 DATA_BYTE_1 .....

;----------------------------------------------------------------------

w 50 00 00 r 50 x x


/*******************************************************************************

* File Name: main.c

*

* Version: 1.00

*

* Description:

*  This example demonstrates how to communicate using PSoC 4 I2C with 

*	Bridge Control Panel (BCP)

*	

********************************************************************************

* Copyright 2014, Cypress Semiconductor Corporation. All rights reserved.

* This software is owned by Cypress Semiconductor Corporation and is protected

* by and subject to worldwide patent and copyright laws and treaties.

* Therefore, you may use this software only as provided in the license agreement

* accompanying the software package from which you obtained this software.

* CYPRESS AND ITS SUPPLIERS MAKE NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

* WITH REGARD TO THIS SOFTWARE, INCLUDING, BUT NOT LIMITED TO, NONINFRINGEMENT,

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

*******************************************************************************/



#include <project.h>



int main()

{

	uint8 wrBuf[10];/* I2C write buffer */

	uint8 rdBuf[10];/* I2C read buffer */

	uint8 indexCntr;

	uint32 byteCnt;

	

	/* Enable the Global Interrupt */

	CyGlobalIntEnable;

	/* Start I2C Slave operation */

	I2C_1_Start();

	/* Initialize write buffer */

	I2C_1_I2CSlaveInitWriteBuf((uint8 *) wrBuf, 10);

	/* Initialize read buffer */

	I2C_1_I2CSlaveInitReadBuf((uint8 *) rdBuf, 10);

	

	for(;;) /* Loop forever */

	{

		/* Wait for I2C master to complete a write */

		if(0u != (I2C_1_I2CSlaveStatus() & I2C_1_I2C_SSTAT_WR_CMPLT))

		{

			/* Read the number of bytes transferred */

			byteCnt = I2C_1_I2CSlaveGetWriteBufSize();



			/* Clear the write status bits*/

			I2C_1_I2CSlaveClearWriteStatus();

			

			/* Move the data written by the master to the read buffer so that the master

			can read back the data */

			for(indexCntr = 0; indexCntr < byteCnt; indexCntr++)

			{

				/* Loop back the data to the read buffer */

				rdBuf [indexCntr] = wrBuf[indexCntr];

			}

			/* Clear the write buffer pointer so that the next write operation will

			start from index 0 */

			I2C_1_I2CSlaveClearWriteBuf();

			

			/* Clear the read buffer pointer so that the next read operations starts

			from index 0 */

			I2C_1_I2CSlaveClearReadBuf();

		}

		

		/* If the master has read the data, reset the read buffer pointer to 0 and

		clear the read status */

		if(0u != (I2C_1_I2CSlaveStatus() & I2C_1_I2C_SSTAT_RD_CMPLT))

		{

			/* Clear the read buffer pointer so that the next read operations starts

			from index 0 */

			I2C_1_I2CSlaveClearReadBuf();

			/* Clear the read status bits */

			I2C_1_I2CSlaveClearReadStatus();

		}

	}

}





/* [] END OF FILE */




/*******************************************************************************

* File Name: main.c

*

* Version: 1.00

*

* Description:

*  This example demonstrates how to use USB-UART bridge on CY8CKIT-040 with an

*	external PSoC 4200 board.

*	

********************************************************************************

* Copyright 2014, Cypress Semiconductor Corporation. All rights reserved.

* This software is owned by Cypress Semiconductor Corporation and is protected

* by and subject to worldwide patent and copyright laws and treaties.

* Therefore, you may use this software only as provided in the license agreement

* accompanying the software package from which you obtained this software.

* CYPRESS AND ITS SUPPLIERS MAKE NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,

* WITH REGARD TO THIS SOFTWARE, INCLUDING, BUT NOT LIMITED TO, NONINFRINGEMENT,

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

*******************************************************************************/



#include <project.h>

int main()

{

	uint8 ch;



	/* Start SCB UART TX+RX operation */ 

	UART_Start();



	/* Transmit String through UART TX Line */ 

	UART_UartPutString("CY8CKIT-040 USB-UART");

	

	for(;;)

	{

		/* Get received character or zero if nothing has been received yet */

		ch = UART_UartGetChar();

		

		if(0u != ch)

		{

			/* Send the data through UART. This functions is blocking and waits until

			there is an entry into the TX FIFO. */

			UART_UartPutChar(ch);

		}

	}

}



/* [] END OF FILE */



